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License Agreement 

Carefully read all the terms and conditions of this license agreement prior to using this 
package. Use of all or any portion of this package indicates your agreement to the 
following terms and conditions. 

Digidesign Inc. grants you, the purchaser, a non-exclusive license to use the software in 
this package (the "Software"), under the terms and conditions stated in this agreement. 

You may: 
1. use the Software on a single machine. 

You may not: 
1. make copies of the user manual or the Software in whole or in part except as ex­

pressly provided for in this agreement. 
2. make alterations or modifications to the Software (or any copy) or disassemble or 

decompile the Software (or any copy), or otherwise attempt to discover the source 
code of the Software. 

3. sublicense, lease, lend, rent or grant other rights in all or any portion of the Software 
(or any copy) to others. 

4. make verbal or media translations of the User's Guide. 
5. make telecommunication data transmissions of the Software. 

TERM: This agreement is effective until terminated. You may terminate it at any time 
by destroying the Software together with all copies in any form. It will also terminate if 
you fail to comply with any term or condition in this agreement. 



Radio and Television Interference 

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with 
the instruction, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

If necessary, consult an experienced radio/television technician for additional suggestions. 
The following booklet prepared by the Federal Communications Commission may also be 
helpful: "How to Identify and Resolve Radio-1V Interference Problems" 
The booklet is available from the U.S. Government Printing Office, Washington, DC 20402 
Stock No. 004-000-00345-4 

Important Note: This equipment includes a shielded data cable for connection between the 
Audio Interface and Sound Accelerator II. This shielded cable or an equivalent must be used to 
insure compliance with FCC limits on RF emissions. Digidesign also advises the use of 
shielded cables for any analog or digital connections to this equipment. 

Changes or modifications not expressly approved by Digidesign could void the user's author­
ity to operate the Audio Interface and Sound Accelerator II. 
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Important Safety Instructions! 

Warning: When using electric products, basic precautions should always be followed, 
including the following: 

• 

• 
• 

• 

• 

• 

Read all instructions before using this product . 

Do not use this product near water (for example, a bathtub, sink, etc.) or if the unit is wet . 

The product should be located away from all sources of heat, such as radiators, 
heat registers or other devices that produce heat. 

The ,Product should be connected only to the correct power supply as 
indicated on the bottom of the product. 

The power cord should be unplugged when the Audio Interface and Sound Accelera 
tor II are not in use for an extended period of time. 

Do not attempt to service the product. Refer all servicing to a gualified technician . Ant attempt to service the product will expose you to a risk of electric shock, and 
wil void tile manufacturers warranty. 

Digidesign's Update and Support Policy 

As a new Sound Tools II owner, the first action you should take is to send in your registration 
card. You must be a registered owner if you want to receive telephone support, program 
updates, or new product information. Once you are a registered owner, program updates will 
be made available to you for a minimal charge. 

Digidesign is serious about customer support, and is strongly committed to a continuing 
relationship with you after your purchase. As a registered Sound Tools II owner, you can 
contact Digidesign directly with any questions or problems. A Sound Tools II Technical 
Support person will be standing by to help you during business hours (Monday to Friday, 9:30 
to 5:30 PST). For Sound Tools II customer service, call 
(415) 688-0600. Remember to have your Sound Designer II master disks handy when you call. 

Digidesign is made up of people who are very interested in audio and the recording process as 
a whole. Become one of our registered owners and participate in the creative process. 
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Introduction 

Preface 

Welcome to Sound Tools TT. Sound Tools II is a 16-bit stereo direct to 
disk recording and editing system based on the Macintosh II com­
puter. With it audio can be recorded, edited and mastered entirely in 
the digital domain with exceptional fidelity and precision. 

Sound Tools IT is the second generation of Digidesign's original version 
of the Sound Tools system which pioneered professional digital 
recording and editing on the desktop. As such, it refines these capabili­
ties and brings power previously only found in professional studios to 
anyone with a Macintosh TT. This manual will help you unlock the 
power of Sound Designer IT, and set you on the road to achieving 
results that were previously unavailable to the individual. 

About The Sound Tools II System 

Sound Tools IT consists of three basic components: 

1. Sound Designer 11 software. Sound Designer II provides 
powerful hard disk recording and sample editing capabilities 
to the Sound Tools IT system, including cutting, pasting, 
fading, scaling, inverting, reversing, crossfading, mixing, 
looping, and FFT analysis. Sound Designer II also offers 
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powerful digital signal processing functions like sample rate 
conversion, time compression/ expansion, compression/ 
limiting, expanding, and equalization. Coupled with a MIDI 
interface (or a SCSI or RS-422 cable), Sound Designer II also 
lets you retrieve sounds from any supported sampling device, 
edit them, save them on your Mac, and exchange them with 
other samplers. 

2. The Sound Accelerator II. The Sound Accelerator II is a digital 
signal processing card (DSP) card that installs in one of the 
Macintosh Il's NuBus slots. It provides the audio processing 
power of your Sound Tools II system. 

3. The Audio Interface. The Audio Interface is a rack-mount 
input/ output device that that provides both analog and digital 
inputs and outputs for passing audio into and out of your 
Sound Tools II system. 

Hardware Requirements 

In order to run Sound Tools II, you will need: 

• A Macintosh II series computer with at least 1 megabyte of 
RAM, running System 6.0.7 or higher. 

• A hard disk. 

Optionally, Sound Designer II can also take advantage of the following 
equipment: 

•A MIDI interface, RS-422, and/or standard SCSI cable. An RS-
422 high-speed communication cable for E-mu' s Emax, Emax 
II, or Ell may be ordered directly from Digidesign. 
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• Any of the following samplers: 
Digidesign SampleCell™ 
Akai 51000, 51000PB, 5950, 5900, 5700, and X7000 
Roland S-10, S-50, S-550, S-220, MKS-100 and S-330 
E-mu 5P-1200, Emax, Emax II, Ell, and EIII 
Sequentia1Prophet2000/2002 
Dynacord ADS 
Ensoniq Mirage, OSK, and EPS 
Korg DSS-1, and DSM-1 
Yamaha TX-16W 
Any 12-or 16-bit sample dump machine 

• Apple's MIDI Driver and MIDI Manager (optional - all MIDI 
functions will operate without the MIDI Manager) 

Hard Disk Requirements 
Sound Designer II requires a hard disk with an average access time of 
28 ms or less that is formatted for optimum performance. The drive's 
interleave ratio should be 1:1. 

To be sure you are getting a capable hard drive, consult your dealer or 
consider Digidesign's Pro Store series of hard drives which are guaran­
teed to meet the above requirements. 

How to Use This Manual 

Please read Chapter B first. It will help you install your hardware and 
software, connect it to your system and test it. 

Chapter C gives you a tour of Sound Designer Il's main interface and 
describes the nature of the system's digital audio files. 

Chapter D delves into the actual steps involved in direct-to-disk 
recording with your system. It also describes the non-destructive 
editing process. 

Introduction 
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Chapter E covers the techniques of non-destructive editing, as well and 
· digital signal processing (DSP). 

Chapter F will be of interest to those interested in editing samples for 
use with a variety of digital samplers. 

Chapter G takes you through the steps of putting Sound Designer II 
online in synchronization with SMPTE time code. 

Chapter H serves as a reference section documenting all of Sound 
Designer II' s menu commands. 

The Appendix covers provides an overview of the digital recording 
process, along with additional details about using Sound Designer II 
with other products. 
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Installing the Sound Tools II 
Hardware and Software 

About the Sound Accelerator II 

In this chapter you will learn how to install your Sound Tools II 
hardware and software. Though the installation procedure is fairly 
simple, it is important that you follow the instructions in this chapter 
carefully. 

The installation covers these three procedures: 

1. Installing the Sound Accelerator II digital signal processing 
(DSP) card in your computer. The Sound Accelerator II gives 
your system its audio processing power. 

2. Connecting the Audio Interface to the Sound Accelerator II. The 
Audio Interface is a high fidelity input/ output device for 
passing audio into and out of the Sound Tools II system. 

3. Installing the Sound Designer II digital recording and editing 
software. 

Read on to learn how to set up your Sound Tools II system, and get 
started recording and editing digital audio. 

Installing the Sound Tools II Hardware & Software 
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About the Sound Accelerator II 

Digidesign's Sound Accelerator II is a high-speed "audio computer'' 
on a card for use with the Sound Tools II Digital Recording and 
Editing System. The Sound Accelerator II provides the digital signal 
processing (DSP) power that enables your Sound Tools II system to 
record and play back 16-bit, phase-synchronous audio and provide 
real-time signal processing functions. 

Carefully unpack your Sound Accelerator II card. Next, complete the 
enclosed registration card and return it to Digidesign immediately. It is 
necessary that you do this to be eligible for technical support and 
product updates. 

The Sound Accelerator II is easy to install in your Macintosh II com­
puter. However, to ensure that you do not damage the Sound Accel­
erator II or the computer, please read the following instructions 
completely before performing the installation. 

The Sound Accelerator II card is packaged inside a special anti-static 
bag that prevents static electricity from damaging its sensitive elec­
tronic components. Before handling your Sound Accelerator II, always 
discharge any static electricity that may be on your clothes or body by 
touching a grounded metal surface (such as the Mac II' s power supply 
case). To avoid soiling or damaging the Sound Accelerator II's sensi­
tive components, always hold it by its edges (as you would hold a CD). 
And never touch the connector pins, circuit traces or components! 

Keep the anti-static bag that your Sound Accelerator II came in-you 
should always store your Sound Accelerator II in this when it is not 
installed in your Macintosh. Keep the box that your Sound Accelerator 
II came in, too, should you need to return the card for technical assis­
tance. 
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Installing the Sound Accelerator II 

To install the Sound Accelerator II in your Macintosh II, follow 
these steps: 

• Remove the Mac H's top cover. 

• Plug the Sound Accelerator II into any available slot, making 
sure that the NuBus connector and metal bracket are properly 
seated. NEVER force the card into the connector. Try to put as 
little pressure as possible on the Mac II' s circuit board-avoid 
flexing it at all. 

Cover release buttons 

~Slot cover 

Preparing to install the Sound Accelerator II 
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Installing the Sound Accelerator II in the Macintosh 

Connecting the 50 pin interface cable to the Sound Accelerator II 

• Connect one end of the interface cable (located in the Audio 
Interface box) to the interface port on the back of the Sound 
Accelerator II. Pinch the metal tabs on either side of the metal 
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IMPORTANT 

IMPORTANT 

connector and push it into the 50-pin interface port. Release 
pressure on the metal tabs to lock the connector into place. 

WARNING: Never connect or disconnect the interface cable to the 
interface port of the Sound Accelerator II while the power is on. Doing 
so can cause permanent damage to your system! 

Always tum down the volume on your amplifier before you power on 
or shut down your Macintosh II. When power to the Sound Accelera­
tor II or Audio Interface is turned on or off, it may emit a 11thump" that 
could damage your speakers at high volume. 

About the Audio Interface 

The Digidesign Audio Interface is a 4-channel audio input and output 
device for use with a variety of digital audio products, including our 
Pro Tools multitrack recording system. When connected to the Sound 
Accelerator II, the Audio Interface provides: 

• Two channels of analog or digital input when used with the 
Sound Designer II audio editing software (included with 
Sound Tools II). 

• Two channels of analog or digital output when used with 
Sound Designer II software. Digital output is in both S/PDIF 
and AES/EBU formats. Channels 1 and 2 of the digital and 
analog outputs are always active. 

• Four channels of analog input and output when used in 
conjunction with DECK multitrack software, or Studio Vision, 
Digital Performer or Cubase sequencers with digital recording 
capability. 
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The Audio Interface features 16-bit analog-to-digital convertors with 
64x oversampling, and 18-bit digital-to-analog convertors with 8x 
oversampling for outstanding audio fidelity. Analog audio input and 
output connections are made via balanced XLR connectors with 
nominal input and output levels of +4 dBu. Digital audio input and 
output connections are made with standard XLR and RCA connectors 
for AES/EBU and S/PDIF digital formats, respectively. 

For convenience, all parameters of the Audio Interface are set and 
controlled through software. Sample rate, audio input format, and 
other such parameters are set and controlled from the Hardware Setup 
dialog in Sound Designer Il's Setup menu. 

Installing the Audio Interface 

Carefully unpack the Audio Interface. Complete the enclosed registra­
tion card and return it to Digidesign immediately. It is essential that 
you do this in order to be eligible for technical support and product 
updates. 

Depending on your particular setup, you may want to make audio and 
power connections before you mount the Audio Interface in your rack. 
It is a standard 19", one-rack space device. 

• After you have rack mounted the Audio Interface, connect it to 
the Sound Accelerator II with the 50-pin interface cable 
supplied with your system. 
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IMPORTANT 

Connecting the 50-pin interface cable to the Audio Interface 

• Pinch the metal tabs on either side of the metal connector and 
push it into the 50-pin interface port. Release pressure on the 
metal tabs to lock the connector into place. 

WARNING: NEVER connect or disconnect the interface cable to the 
Audio Interface while the power is on! Doing so can cause permanent 
damage to your system! 

• Next, connect the AC power cable to AC power input on the 
rear of the Audio Interface. 

The Audio Interface automatically selects the power setting for use 
with any standard voltage and frequency. Simply connect the AC 
power cable appropriate to your local power standard, plug in the 
Audio Interface, and it will function normally. 
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Audio Connections 

• Connect the audio input and output cables to the appropriate 
connectors on the Audio Interface's rear panel. 

The Audio Interface's analog audio connectors are balanced XLR' s 
with pin 2 wired "hot", pin 3 "neutral", and pin 1 ground. If you are 
connecting an unbalanced signal to the Audio Interface's inputs or 
outputs, connect only pin 2 to the ''hot" signal, and pins 1 and 3 to 
ground. 

In balanced systems, pin 1 and shield should be connected at the input 
only (not at the output). This will prevent ground loops between the 
shield and pin 1 conductor. See the illustration on the next page for the 
correct wiring diagrams. 

Balanced-to-Balanced Connection 

OUTPUT To Console 

~ 8 B + 

GND 

From Console INPUT 

+ 

8 e @l 
GND 

Balanced-to-Unbalanced Connection 

OUTPUT To Console 

~ ~ ~ 
+ 

GND N.C. J . 
From Console INPUT 

+ g ~ '§2] GND 

1 

Wiring diagram 
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The Audio Interface's digital audio connectors are 2-conductor phono 
(RCA) jacks for S/PDIF, and balanced, 3-conductor, XLR jacks for 
AES /EBU input and output. 

If you plan to use a DAT player, CD player, or other digital input and 
output device with your Sound Tools II system, be sure to connect the 
correct interface type on both the Audio Interface and the external 
device-the Audio Interface's S/PDIF inputs and outputs should only 
be connected to other S /PDIF devices, and its AES /EBU inputs and 
outputs should only be connected to other AES/EBU interfaces. 
Connect the Audio Interface's digital output to the DAT recorder's 
digital input, and the Audio Interface's digital input to the DAT 
recorder's digital output. 

For S /PDIF, we recommend using controlled impedance 750 cable 
("video cable"). These cables usually have BNC connectors that can be 
adapted to RCA plugs. Avoid using too many different adapters-they 
can affect the impedance of the connection. For AES /EBU connections, 
use high-quality microphone (3-conductor, balanced) cable. 

Back Panel Indicators 

The following are descriptions of each of the Audio Interface rear­
panel connectors, from left to right: 

@W.~8®~,~@ ~ 80@"®@@ Ila o oJJ ? AES/EBU 
CH4 CH3 CH2 CHJ CH2 CHI IN OUT 

r r r r r r r 
CD 0 0 0 ® ® 0 

The back panel of the Audio Interface 
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1. Analog Audio Outputs 
These are balanced +4 male XLR connectors for analog audio output 
connections. Only channels 1 and 2 operate in conjunction with Sound 
Designer II. Both output channels are continuously active. Channels 3 
and 4 are available when your Sound Tools II hardware is used with 
DECK, Studio Vision, Digital Performer or Cubase Audio. 

2. Analog Audio Inputs 
These are balanced +4 female XLR connectors for analog audio input 
connections. Only channels 1 and 2 can be used for input with Sound 
Designer II. These inputs are software selectable between analog or 
digital format. Input to these two analog channels is disabled when a 
digital input format is chosen in Sound Designer II's Hardware Setup 
dialog. 

3. 50-pin Interface Port. This port is used to connect the Audio Interface 
to the Sound Accelerator II. 

4. Slave Clock In/Out 
The Slave Clock In jack is a standard BNC type connector used to 
connect a Digidesign Video Slave Driver, or other synchrization 
device, to your Sound Tools II system for synchronization purposes. 
For more information on the Video Slave Driver and synchronization, 
refer to Chapter G. 

Connecting a Slave Clock Out signal from Digidesign's Video Slave 
Driver, or other synchronization device, to this port will cause the 
Audio Interface to automatically switch to Slave mode (if not already in 
Digital mode). 

5. S/PDIF Digital Input/Output 
S/PDIF stands for Sony /Philips Digital Interface Format. This digital 
format is used in many consumer CD players and DAT recorders. The 
Audio Interface's S/PDIF jacks are 2-conductor phono (RCA) jacks. 

Input to these two digital channels is disabled when analog input or 
AES/EBU digital format is chosen in Sound Designer II's Hardware 
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Setup command. Output is continuously active both on the AES/EBU 
and S/PDIF jacks. 

&. AES/EBU Digital Input/Output 
The AES/EBU digital format is used in many professional digital 
audio devices, and some DAT recorders. The Audio Interface's AES/ 
EBU jacks are balanced, 3-conductor XLR jacks. 

Input to these two digital channels is disabled when analog input 
format or S/PDIF digital format is chosen in Sound Designer H's 
Hardware Setup command. Output is continuously active on the AES/ 
EBU and S /PDIF jacks. 

7. AC Power Input 
This connector accepts a modular AC power cable. Because the Audio 
Interface is auto-selecting with regard to power (100V-240V), it will 
automatically work with a standard modular cable to connect to AC 
power receptacles in any country. 

Front Panel Indicators 

The following are descriptions of each of the Audio Interface front 
panel indicators, from left to right: 

C> 

I~ -- dglclmmlgn •. ..- -- - Clll - .. .. --- -0 0 0 0 0 0 0 0 000 000 000 000 0 0 0 0 0 0 0 0 -- ,... .................. ,,,. .... 4•• ......... ...... .......... 
C> LW 

~ ~ ~ ~ J J cb 
The front panel of the Audio Interface 
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1. Power 
This switch applies power to the Audio Interface. The "I" position is 
on; the "0" position is off. 

2.Sync Mode 
The Sync Mode LED indicates the source of the clock rate of the Audio 
Interface's analog-to-digital (ADC) and digital-to-analog (DAC) 
converters. Possible settings are as follows: 

Master. 
This is the "standard" setting. In this mode, the Audio Interface's 
sample rate is generated by one of its internal crystal oscillators (the 
internal clock frequency used is determined by the Sample Rate setting 
in Hardware Setup). Master mode is active whenever the Audio Inter­
face is NOT synchronized to an external clock source (such as the 
Video Slave Driver). 

Slave. 
This LED is lit when the Audio Interface's sample rate is synchronized 
to a Video Slave Driver, or other synchronization device. In this mode, 
the Audio Interface's sample rate is derived from the frequency of the 
incoming Slave Clock Out signal of the Video Slave Driver. The Audio 
Interface automatically switches to this mode when the Slave Clock Out 
signal from the Video Slave Driver, or other synchronization device, is 
connected to its Slave Clock In port. 

Digital 
(Both Master and Slave LEDs are lit) This is the normal setting for input 
from DAT machines. This setting indicates that the received AES/EBU 
or S/PDIF signal is the source for the Audio Interface's sample rate. 

If you are using digital 1/0 with the Sound Tools II hardware, always 
remember to reset the Sync Mode from Digital to Internal when finished 
inputting data from a digital source (such as a DAT player). This can 
be done by setting inputs 1 & 2 in Sound Designer II to Analog. Refer 
to the guide of Sound Designer's Sync settings later in this chapter. 
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The reason for doing this is that that some digital devices only output a 
proper clock signal during playback-not when stopped. Leaving the 
Audio Interface connected to certain digital devices while it is in 
Digital sync mode may adversely affect Sound Designer Il's playback 
speed or audio quality. 

1 CH 1,2 Input 
This LED indicates the format of the audio input signal to channels 1 
and 2. The choice of Analog or Digital input for these two channels is 
made in Sound Designer H's Hardware Setup. 

4. Sample Rate 
In Master, Slave and Digital modes, this LED shows the indicated 
sample rate in the outgoing AES /EBU or S /PDIF data. In Master sync 
mode, this switch indicates which of the Audio Interface's two sample 
rate clocks, 44.1 kHz or 48 kHz, is used. The sample rate of the Audio 
Interface is set in Sound Designer II's Hardware Setup. 

The Audio Interface provides the following sample rates: 

48 kHz. This is the standard sampling rate of many professional audio 
devices. It is recommended for use with DAT recorders that cannot 
receive digital transfers at 44.1 kHz. 

44.1 kHz. This is the compact disc standard sampling rate and the 
Sound Tools II default sample rate. In order to avoid sample rate 
conversion (which can degrade sound quality) you should use this rate 
whenever you are recording material that will ultimately be published 
on a compact disc. 

5. Digital Format 
This LED indicates the Audio Interface's digital data input format, 
AES /EBU or S /PDIF, as chosen in Sound Designer II. 

&. Level Meter 
The Audio Interface's audio level meters are analog meters with three 
segments corresponding to 0 dB, -2 dB, and -20 dB relative to the 
DAC's full scale output (which is calibrated at +18 dBu, adjustable 
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over a± 6 dBm range). Please note that these meters monitor the output 
levels of the Sound Tools II system. Input levels are monitored within 
the Sound Designer II software. 

Channels 3 and 4 are only active when used with software such as 
DECK, Studio Vision, Cubase Audio and Digital Performer, which 
support four channel playback with the Sound Tools II hardware. 

7. Level Trim 
The Audio Interface's level trim pots allow adjustment of the Audio 
Interface's input and output levels over a± 6 dBm range. If necessary, 
adjustments can be made by the user with an 1 /8-inch screwdriver. 
The calibration procedure is outlined in the Appendix. 

Installing the Sound Designer II Software 

Before you can begin using the Sound Tools II system, you will need to 
install the Sound Designer II software on your hard disk. Before 
installing, please be sure to fill out the enclosed registration card and 
send it immediately to Digidesign. 

To install Sound Designer Il on your hard disk: 

• Put the Sound Designer II master disk into any drive. 

• Double click on the Sound Designer II.sit file. This compressed 
file holds the Sound Designer II application, as well as some 
necessary pieces of software. 

• Select the hard disk where you want put the application. 

• Once all the files have "decompressed" onto your hard drive, 
drag the ''DigiSystem INIT" file into the System folder of your 
startup hard drive. 
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• Insert the "Additional Files" disk in the Macintosh and drag its 
contents on your hard disk. 

• Restart the Macintosh. 

NOTE: It is very important that the "SD II Sample Rates" folder reside 
in the same folder as the Sound Designer II application. Without these 
files, Sound Designer II will not open. 

Once you have copied the application and other files to your hard disk, 
you'll be ready to set up and test all of your hardware. 

Configuring Sound Designer II 

When you start Sound Designer II for the first time you will need to 
configure it for your particular hardware setup. Parameters that you 
need to set include interface device (the Audio Interface), sample rates 
(44.1 or 48 kHz). Once you have configured your copy of Sound 
Designer II, all of your settings will be saved. You won't need to reset 
them again unless you re-install the program or change your working 
environment. 

To launch Sound Designer II: 

• Double-click on the Sound Designer II icon. 

Configuring Harware Setup: 

• Select Hardware Setup ... from the Setup menu. The Hardware 
Setup dialog appears. 
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Hardware Setup 
r- Select care Type: - ~ Track Mapping: 

®Sound Accelerator 
DSPI Slot 13 (DSP I) I 

0 Pn Tools fludioc•nl plays I Stereo MIH I (L) 

end I Stereo MIH I (R) 
r- C•nl1 Te Use: 

Card 1: I Slot 13 I Peripheral: Audio Interface I 
Sample Rate: 44100 I 
Sync Mode: Internal! 

Dlglt•I Fonnat: RES/EBU I 
Ch 1,2 Input: Rnalog ~ 

~ 

The Hardware Setup dialog 

This dialog is where you configure Sound Tools II's input and output 
parameters. Sound Accelerator should already be selected for you 
under Select Card Type. You should configure the other settings as 
follows: 

• The Peripheral pop-up menu should be set to Audio Interface. 

• The Sample Rate pop-up should be set to the rate which you are 
working in. 44100 (44.1 kHz) is the compact disc standard, and 
48000 (48 kHz) is the sample rate featured on many DAT 
recorders. 

• Sync Mode should be set to Digital if your master clock source 
is a digital audio tape recorder or a from an AES/EBU-based 
master clock source. Otherwise, leave this setting on Internal. 
Refer to the following guide when setting the type of sync. 
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If you are using .... 

Audio Interface 

Audio Interface 

Video Slave Driver 

DAT recorder 

AES/EB U-ba sed 
master clock source 

A Guide to Sync Type 

Choose 

Internal Sync 

Internal Sync 

Digital Sync 

Digital Sync 

Be sure to set the Sync Mode pop-up back to Internal after you have 
finished receiving audio from a digital audio tape recorder (or CD 
player with digital outputs). Sync Mode should ONLY be set to Digital 
while receiving digital audio from a DAT recorder, or at at all times 
when an AES/EBU-based master clock source is used in your studio. 

•Digital Format should be set to either AES/EBU or S/PDIF, 
depending on the format you 're using. 

• Ch 1, 2 Input: should be set to the type of inputs you will be 
using for a specific recording. 
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Testing Sound Tools II 

At this point, the Sound Accelerator II, Audio Interface and Sound 
Designer II have all been installed (and the Audio Interface should be 
connected to your sound system). Now it's time to test the system. 

To test the system: 

• Copy the file called "Drums" from the "Additional Files" disk 
onto your hard drive if you have not already done so. 

• If necessary, double-click on the Sound Designer II icon to 
launch the application. 

• Select Open ... from the File menu. Find the ''Stereo Demo" file 
and click on Select. A window will open displaying the 
soundfile. 
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The soundfile window 

• Position the pointer at the left edge of the uppermost of the 
three waveforms and hold down the mouse button. You 
should hear the demo file ("drums"). 

Installing the Sound Tools II Hardware & Software 27 



IMPORTANT 

28 

Troubleshooting 

If Sound Tools II does not seem to be functioning properly, check the 
following conditions: 

• Is the Sound Accelerator II card fully seated in the Macintosh 
NuBus connector? Remember, NEVER force this connection­
doing so could seriously damage the Macintosh logic board or 
the Sound Accelerator II. 

• Is the 50-pin connector properly connected between the Sound 
Accelerator II and the Audio Interface? 

• Is the Audio Interface turned on? 

• Are your audio cables connected properly? 

•Is your audio system providing proper amplification? 

• Do the meters on the Audio Interface show any activity? (If the 
do, the problem lies in your audio chain.) 

• Have you selected the proper parameters in the Sound De­
signer II Hardware Setup menu item? 

• Does your hard disk offer a 28 ms or faster access time? (Sound 
Designer II requires 28 ms or faster in most cases.) 

In no case should you try to fix the Sound Accelerator II yourself­
doing so will void the warranty! 

For further technical assistance, please call the Digidesign Customer 
Support Department at (415) 688-0600 between 9:30am and 5:30pm PST. 
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Getting Started With Sound Designer II 

Introduction 

This chapter explains the tools, buttons and selectors you'll be working 
with in your recording and editing sessions with Sound Designer II. 
Also given here is a brief introduction to the concepts of destructive 
and non-destructive editing. 

Destructive and Non-destructive Editing 

Sound Designer II software is capable of both destructive and non­
destructive random access editing of digital audio. Random access editing 
means that the Sound Tools II system allows you to access any point in 
a soundfile without having to rewind or fast-forward to find it as you 
would with tape. Aided by Sound Designer H's graphical display of 
your audio data, you can navigate through sound with unprecedented 
ease and speed. 

Destructive editing refers to operations such as cutting, pasting, nor­
malizing, and other functions which permanently alter a soundfile. 

Non-destructive editing refers to editing (such as that done in Sound 
Designer H's Playlist) which will not permanently alter the original 
audio data on hard disk. With this type of editing, no matter how 
many changes you make, your original recordings remain intact. 
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Non-destructive editing works like this: When you edit an audio file 
within Sound Designer H's Playlist, you are not really cutting and 
moving chunks of sound as you would if you were editing analog 
tape. Instead, Sound Designer II is creating a "map" of your audio or 
MIDI file. This map merely describes the order in which you want 
portions of the audio to be played. If you'd like to hear the middle first, 
the end next and the beginning last, then so be it. Sound Designer II 
will tell the hard disk (where the information is stored) to go to the 
middle of the file and play that portion first, followed by the others. 

With non-destructive editing, you are free to experiment with music 
and sound in ways never before possible. You can move and rearrange 
"pieces" of sound data with total freedom. Edits can be heard immedi­
ately upon completion. Sound Tools II offers a fast, flexible, and 
powerful approach to digital recording and editing of audio. 

About Soundfiles 

The audio you record and edit in Sound Designer II takes the form of a 
soundfile. A soundfile can be stored on disk in a variety of formats. 
The Sound Designer II format is the basic stereo file format for hard 
disk recording. Other formats are also supported, as documented in 
ChapterH. 

Sound Designer II' s Soundfile Window is where you'll look into a 
soundfile. It is the only way to view the actual sample data that makes 
up a sound. As such, it is the workshop for all destructive editing and 
for Playlist region definition for non-destructive editing. 
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Mac-to-Sampler 

Zoomer Selector Tape Deck 
Markers Scrubber Data Indicators 

-~-----

The Soundfile Window 

The following are short explanations of the different parts of the 
Soundfile Window. Please bear in mind while reading through this 
chapter that a number of functions can be accomplished in more than 
one way. Though these shortcuts appear through this manual in 
relevant sections, you will find that the Quick Reference Card included 
with your Sound Tools II system will serve as a handy reference for the 
majority of these. 
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Liuing Room Blues - No Backup 

Title Bar 
The Title Bar always contains the name of the soundfile you're viewing 
in the Soundfile Window. Like all windows, you can move the active 
window by dragging its Title Bar. 

If you are editing a file with the Setup menu's Use Backup Files com­
mand turned off, then the words "No Backup" appear after the file 
name in the Title Bar. This means you are making all wave data edits 
directly to the disk file instead of working on a temporary copy, so 
proceed with caution. Read-only files, such as locked soundfiles or 
those opened from a CD-ROM, show a read-only indicator in the Title 
Bar. 

=o= 
Close Box 
Click on the Close Box in the upper-left comer to close the active 
window. If you have made changes that have not been saved, you will 
be warned and given another chance to save them. The File menu's 
Close command performs the same function. 

Overview Display 
The Overview Display shows the entire soundfile, either as a wave­
form or a time line . 
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To choose between the Waveform Display and the time line display: 

• Hold down the Option key while the mouse cursor is over the 
overview area. The cursor will change into a pop-up menu 
symbol. Press the mouse button, and a pop-up menu will 
appear. 

Time Line 

Channel 1 
Channel2 

• Drag the mouse to select the display type you want. 

Notice that stereo files also let you view a sum of the left and right 
channels at once. The Option key pop-up is the only way to select what 
will be displayed in the overview. 

NITTE: If you are performing destructive edits on long files, you may 
wish to view the time line instead of the actual wave data. This will 
make it possible for you to avoid the wait period required to recom­
pute and redraw the Overview Display after each edit. 

To start playback from any point in the file: 

• Oick and hold the mouse down at any point in the Overview 
Display. Playback will continue until the end of the file or you 
release the mouse. 

View Indicator 
The View Indicator is a dotted rectangular box that is always present 
in the Overview Display. It shows you exactly what area of the 
soundfile is presented in the Waveform Display, and where that 
waveform range is located in the overall soundfile. It is particularly 
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useful for keeping track of your specific location in large soundfiles. 

Wavefonn Display 
The Waveform Display shows the editable waveform of the soundfile. 
In stereo files, both the left and right channels are displayed. In a mono 
soundfile, only the single channel is displayed. When you are zoomed 
out all the way, these window areas are a direct view into memory. In 
other words, the Waveform Display will show you no more than the 
contents of memory at any time. This does not mean that edits may be 
performed only on the wave data in memory. Sound Designer Il's 
Waveform Display automatically scrolls to the left or right when you 
reach the edge of the window during the selection process. 

00:00:00.040 

I 
Amplitude and Time Axes 
In Sound Designer II, both the time (X) and amplitude (Y) axes are 
displayed at all times. By using the Scale Marks ... command in the 
Setup menu, you can select different units for both axes. Amplitude 
may be viewed in percent of maximum or sample value; duration may 
be viewed in seconds, hours:minutes:seconds:milliseconds, various 
SMPTE formats, decimal or hex sample number, feet and frames, or 
bars and beats. See the Scale Marks ... command for more information. 

SHORTCUT: Time and amplitude axis units can also be set using the 
pop-up menus which are displayed by holding down the Option key 
while the mouse is over either axis. 
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¥"Time 

Sample Numbers 
HeH Sample Numbers 
SMPTE Time Code 
Feet+Fn1mes 
Bars I Beats 

The -pop-up time axis Scale Marks menu 

NITTE: The Preferences ... command in the Setup menu provides a way 
to set defaults for scale units. See Chapter H for details. 

Mac-to-Sampler 
The Mac-to-Sampler button is used to transfer the current soundfile 
directly to the currently selected sampler. For more information on 
sample editing and configuring the system for specific samplers, see 
Chapter F, Working With Samplers and Sample Editing. 

The Speaker 
The Speaker button plays back the selected waveform range. If no 
range is selected, it plays the soundfile beginning with the data at the 
beginning of the Waveform Display. 

In order for the Speaker icon to play directly from disk, the Direct from 
disk box must be checked in the Setup menu's Sound Playback ... dialog 
box. If this box is not checked, the Speaker icon will only be able to 
play back the contents of memory. When playing back directly from 
disk, you may experience a slight hesitation before playback begins 
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while the playback buffer is filling. One way to avoid this slight 
hesitation is to select Pre-allocate HD buffers with the Preferences ... 
command in the Setup menu. Loop playback capabilities are disabled 
when Direct from disk is checked in the Sound Playback dialog. 

SHORTCUT: Pressing the Spacebar on the Mac's keyboard will start 
and stop playback of a soundfile from the current cursor position in 
the Overview Display. This technique also works in the Playlist 
window and Tape Deck dialog. 

SHORTCUT: Pressing the Return key will place the Overview cursor at 
the beginning of the file and scroll the Waveform Display so that the 
left edge is positioned at the beginning of the file. 

D I 
J 

TheZoomer 
The Zoomer toggles to Zoom mode. When you use the Zoomer to drag 
a box over a waveform range in either Overview or Waveform Dis­
play, Sound Designer II zooms in to fill the Waveform Display with 
the selected area. Use the Zoomer to navigate quickly to any spot in 
your soundfile and view it at greater resolution. 

NOTE: To zoom the current Waveform Display area to the default 
(medium) magnification, double-click on the Zoomer. 

The Pencil 
The Pencil tool switches the Waveform Display into Draw mode, 
where single-sample waveform adjustments can be drawn into an 
existing soundfile. The Pencil tool is particularly useful for correcting 
transient dicks and pops anywhere in a sampled waveform. Draw 
mode is only active when you are zoomed in at least close enough for 
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one screen pixel to represent one sample. You will know you have 
zoomed in far enough when the waveform in the channel view is made 
up of discrete curves instead of blackened waves. 

The Selector 
The Selector switches Sound Designer II into Selection mode. Many of 
the editing functions you'll perform in Sound Designer II, such as cut, 
copy and paste, involve selecting specific areas of the soundfile. The 
Selector is the tool for this process. 

When Selection mode is active, the cursor changes to an I-beam when 
it is positioned in the Waveform Display. Clicking and dragging the 
cursor across any waveform range in the channel view will select that 
range for editing. Selected ranges are displayed in inverted color: a 
white waveform on a black background. The I-beam's position relative 
to a selected range's start (or insertion point) is always shown in a Data 
Indicator box. 

Clicking the cursor once anywhere in the Waveform Display positions 
a flashing Insertion cursor. The current position of the Insertion cursor 
is displayed in both the Overview and Waveform Displays. (If a range 
is selected, the start point will flash in the Overview Display.) Ex­
tended ranges can be selected quickly by clicking once to define the 
range start point, scrolling to the intended range end point, and Shift­
clicking (holding down the Shift key while dicking). 

Selection of a stereo range is accomplished in the much same manner. 
To do so, begin your selection in the left (top) channel and drag 
downward into the right channel as you drag across. 

SHORTCUT: If a range is selected in one channel of a stereo soundfile, 
you can automatically select the same range in the other channel by 
holding down the shift key and clicking on the other channel's ampli­
tude axis. The same holds true for de-selecting a whole channel. 
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SHORTCUT: When you are making a selection, you will often want to 
switch to the Scrubber (described later) to help you pinpoint the 
proper edit point. Holding down the Option key while in Selection 
mode will temporarily change the cursor to the Scrubber. This way 
you don't have to click on the Scrubber to access that tool. 

The Display Scale Arrows 
The Display Scale arrows make it possible to adjust the Waveform 
Display in a very accurate way. Only the scaling of the display is 
changed, not the sample data. All of the Display Scale arrows adjust 
the display around its center point, thereby keeping the display 
centered as it changes. 

The up arrow vertically expands the Waveform Display. This adjust­
ment is useful for viewing amplitude differences at higher resolutions 
where they are more distinguishable. 

The down arrow vertically compresses the Waveform Display. This is 
helpful for squeezing the height of the waveform view so you can see 
its entire amplitude range. 

The right arrow acts as a worn-in tool. It magnifies the waveform view 
horiwntally, performing the same function for duration as the up 
arrow performs for amplitude, now making it possible to view single 
cycles or sample values, or edit them with the Pencil tool. 

The left arrow acts as a worn-out tool. It compresses the waveform 
view to show you more of a soundfile. The left arrow will only zoom 
out to show the amount of a soundfile that fits into its RAM buffer. 
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The Numbered Marker Tool 
The Numbered Marker icon is one of the four marker tools. It allows 
you to place an unlimited number of markers in any soundfile so that 
you can easily identify sections of songs, dialog, etc. by number and 
quickly navigate to those sections later. Each marker appears with its 
own discrete number, which makes it easy to keep track of the differ­
ent soundfile positions. Numbered Markers also make it easy to define 
start and end points for a selection range. 

The cursor changes to a Numbered Marker cursor when this icon is 
selected. A Marker is placed in the soundfile by clicking this cursor at 
the desired position. (Markers appear at the bottom of the Soundfile 
Window). The cursor always switched back to selection mode after a 
marker is placed. 

SHORTCUT: Numbered markers can be "dropped on the fly'' by 
pressing the Enter key on the Mac's keyboard during hard disk 
playback. This is a very fast and convenient way to define regions of a 
file as you record or playback that file. This greatly accelerates later 
editing. 

You can quickly jump to numbered markers by typing the numbers of 
a marker on the Mac's keyboard. Markers can be moved at any time by 
dragging them with the mouse when not in Markers mode. 

Double-clicking on a numbered marker allows you to name it and 
specify a relative position. Relative position tells you the marker's 
location in the soundfile relative to the file's start (or marker 0). If you 
change the relative position of any marker, all other markers' positions 
will be indicated relative to that marker. 

Numbered markers are saved with the soundfile, and will always 
appear until they are dragged to the Sound Designer II Trash Can. 
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NOTE: Sound Designer mono (not Sound Designer II) format 
soundfiles are limited to a maximum of 10 numbered markers. Addi­
tional markers (and text markers) will not be saved with the file! 

The Text Marker Tool 
The Text Marker lets you place bulleted text notes anywhere within a 
soundfile. Text notes can be very useful for marking specific regions or 
naming soundfile landmarks. 

The cursor changes to a Text cursor (I-beam with a baseline mark) 
when the Text Marker icon is selected. Oick anywhere to position a 
Text marker and enter the description. Text markers can be reposi­
tioned by dragging in Selection mode. Double-clicking on a text 
marker with the Selector brings up its text dialog for editing. 

Text markers are saved with Sound Designer II and AIFF soundfiles 
(not original Sound Designer mono files). They can be removed by 
dragging them into Sound Designer 11' s Trash Can. 

To locate a text marker, simply select Find Marker ... in the Display 
menu and indicate the name of the marker you wish to locate. 

The Loop Start Marker Tool 
Loops are used when editing soundfiles for use in digital samplers. 
The Loop Start Marker tool is used to mark the point in a soundfile 
where you would like a loop to begin. 

The cursor changes to a Loop Start cursor when this tool is selected. 
Loop Start Markers are placed and manipulated like Numbered 
Markers and Text Markers. For more details on looping, please refer to 
ChapterF. 

Sound Designer II 



The Loop End Marker Tool 
The Loop End Marker tool lets you mark the point in your soundfile 
where you would like a loop to end and jump back to the correspond­
ing loop start. 

The cursor changes to a Loop End cursor when this tool is selected. 
Loop End Markers are placed and manipulated like numbered mark­
ers and text markers. For more details on looping, please refer to 
ChapterF. 

The Tape Deck Button 
The Tape Deck button brings up Sound Designer 11' shard disk record­
ing control panel. This panel provides transport controls and lets you 
set recording parameters and initiate hard disk recording. For specific 
information about using Sound Designer II's Tape Deck module, see 
ChapterD. 

The Playlist Button 
The Playlist button opens Sound Designer II's Playlist window, which 
is used to create and edit non-destructive playlists for hard disk 
recordings. Within the Play list you will be able to rearrange audio 
regions, create crossfades between them, adjust their relative volumes, 
and even trigger playback of them to SMPTE. For more information 
about Playlists, see Chapter D, Hard Disk Recording and Non-Destructive 
Editing. 
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The Scrubber 
The Scrubber allows you to "scrub" playback of audio to find an 
appropriate edit location. ("Scrubbing'' gets its name from the tech­
nique of manually rocking the reels of analog tape deck to hear an 
exact audio location.) 

Selecting the Scrubber and holding down the mouse button anywhere 
in the Waveform Display will bring up the Scrub Bar. Drag the arrow 
cursor to the right to scrub forward, or left to scrub backward. As you 
do this, the cursor moves across the soundfile and plays back the 
corresponding audio. Release the button when you have located the 
desired point in the soundfile. 

The Scrub cursor (the double vertical dotted lines) remains in the 
Waveform Display and Overview at all times to indicate the last scrub 
point. This can be helpful in selecting range end points, as described in 
ChapterD. 

NOfE: There are two types of scrubbing. In the normal "jog" mode, 
your mouse movement dictates a direction and speed for playback. A 
second type of scrubbing called "shuttle " scrubbing is available by 
holding down the command key before scrubbing. With shuttle 
scrubbing, playback corresponds directly to your mouse movements. 

117.40 

The Data Indicator Boxes 

secs I 
%Scale 

The Data Indicator boxes give you pertinent information about the 
current insertion point, selected range start, and mouse position. They 
also contain relative position and amplitude information when you are 
moving cursors and markers. 
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The upper left-hand box displays the distance from the insertion point 
or selector start to the mouse's current position. 

The upper right-hand box gives you the absolute position of your 
mouse pointer or associated cursor relative to the beginning of the file. 

The lower left-hand box displays SMPTE time when your system is 
slaved to SMPTE. 

The lower right-hand box gives you the waveform's amplitude value 
at the current position of the mouse pointer or associated cursor. 

With the exception of the SMPTE time box, all values are displayed in 
the units (seconds, SMPTE frames, etc.) selected with the Setup menu's 
Scale Marks ... command. The SMPTE time box changes to Feet and 
Frames if Feet + Frames is selected for the time axis scale marks. 

I 
The Trash Can 
Sound Designer II has its own miniature Trash Can icon that is used to 
throw away markers. While it functions much like the Finder's Trash 
there is a major difference: Once you throw a marker away, it can not 
be recovered. For this reason you should use Sound Designer II' s Trash 
Can icon with care. 

Key Commands 
Several keys on the Macintosh keyboard provide shortcuts in the 
Soundfile Window. 

Define Region Start. The Up arrow key selects the beginning of a 
region for editing. 

Define Region End. The Down arrow key selects the end of a region 
for editing. 
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Locate Region Start. The Left arrow key scrolls the Waveform Display 
so that the beginning of the selected region, or insertion point, is 
centered on the screen. 

Locate Region End. The Right arrow key scrolls the Waveform Display 
so that the end of the selected region, or insertion point, is centered on 
the screen. 

Locate to Numbered Marker. Pressing numbers on the Mac keyboard 
will allow you to quickly locate previously defined numbered markers. 

Play/Stop. The Spacebar toggles between play and stop. Playback 
begins at the current play position cursor. Clicking the Speaker icon 
performs the same function as long as the mouse button is depressed. 
Alternately, holding down the mouse button anywhere in the Over­
view Display will trigger playback from the that point. 

Rewind To Beginning. Pressing the Return key stops any playback 
and then moves the display and playback cursor to the beginning of 
the soundfile. 

Summary 

You should now be familiar with Sound Designer H's basic working 
environment. The next chapter explores hard disk recording and the 
non-destructive editing capabilities of your system. 
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Hard Disk Recording and 
Non-Destructive Editing 

Introduction 

This chapter is devoted to hard disk recording and playback with your 
Sound Tools II system. Here you will learn to record digital audio 
direct to disk and edit that audio with Sound Designer H's non­
destructive editing tools. 

To perform direct to disk recording and non-destructive editing, the 
Sound Designer II software has two specialized modules which are 
accessible from the Tape Deck and Playlist buttons in the Soundfile 
Window. 

The Tape Deck module is your digital recording deck. You will use it 
to record directly to the hard disk, and play back what you've re­
corded. 

The Playlist module offers non-destructive editing tools that let you 
assemble and arrange portions of your digital audio for playback in 
any order without actually changing the original data. Regions can be 
crossfaded with other regions on the fly, and even locked to and 
triggered by SMPTE time code for synchronization to video or analog 
tape. 

This chapter explains how to use these two modules to get the most 
out of your disk-based recording and editing system. 
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Essential Concepts: Regions and Playlists 

So before we proceed any further, we are going to define some essen­
tial terms-region and playlist-as they apply to non-destructive editing 
with Sound Tools II. 

Regions 
A region is a "piece" of audio data of arbitrary length. An audio region 
could be a guitar riff, a verse of a song, a sound effect, a piece of dialog, 
or even an entire soundfile. In Sound Designer II, regions are "cap­
tured" (defined with the Selector tool and named), from an audio file 
and strung together to create an audio "playlist" within Sound De­
signer Il's Playlist Window. 

Playlist 
A Playlist is a list of regions strung together in a specific order. Be­
cause audio is recorded to hard disk with your Sound Tools II system 
it can be freely manipulated. Therefore, the Playlist is merely a set of 
instructions which tell the hard disk which audio regions to "read" in 
what order. 

Now, let's get started recording some audio so you can learn how to 
put the Playlist and non-destructive editing to work for you. 

Getting Ready to Record 

Sound Designer H's Tape Deck module has been designed to function 
much like a stereo tape deck. Anyone who has operated a tape re­
corder should find the module controls familiar. 
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Before you can record a mono or stereo signal directly to your hard 
disk, you must create a new file and set up your recording parameters. 

To prepare for hard disk recording: 

• Choose the New ... command on the File menu to create a new 
empty soundfile for your recording. 

I a Rudio Files ... , 

r.~ [ O Mas1<ff ~ 
D i=r<mH< lh~bbH 
l'.) .. nn~Jl(~ ~<~~ h~r Mht 
D Mt~St(H' Scon~ 
D Htu1io lh~miH 
tJ Uoic<~ OV<ff 

Create New Soundfile as: 

Untitled 

Sound Designer 11 11 16 bit 

The New ... dialog 

c:::> Pro Store 

( Ej•~c1 ) 

(Desktop ) 

I New 3 
fJ(~~OUfC(~ 

( Cancel ) 

II Stereo 

• Enter an appropriate name for your file. The default name is 
"Untitled." 

• Oick on the pop-up menus, and select the type of file format 
you wish to create. Sound Designer II 16 bit stereo format is 
the default file type and is recommended for CD-quality stereo 
hard disk recording with Sound Designer II. See Chapter H, 
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Reference, section for descriptions of the other file format 
options. 

• Oick on New. An empty Soundfile Window appears. 

• Oick on the Tape Deck icon. The Tape Deck dialog appears on 
your screen. 

Fiie Name: Radio RemlH 

Sample Rate:I 44100 I Q "1Dfl0 

®Stereo 
Rec. Source: Rudio I nterfoce Rnolog Input 

Record Start: I 00:00:00.00 I 
Record stop: I 00:00:00.00 I D On Line 

Length: 

Current: 

Ruallable: 

Time 

00:00:00.00 

OD:DD:DD.OO D Pre-Rllocate 

Buff er Size: lj8I 00:42:14.12 ~ 

••••••• RTZ REW PLAY STOP FF GTE REC 

The Tape CJeck dialog 

L R 

C8l Monitor 

Done 

• Oick on the Sample "Rate pop-up menu to set the sample rate at 
which you wish to record. 

Higher sample rates yield truer high end. Higher sample rates also use 
more disk space to record the same amount of source material, so 
you'll need to make a judgement here based on the audio fidelity that 
you require. 
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The Audio Interface defaults to 44.1 kHz for recording-the standard 
for compact discs. 48 kHz also provides compatibility with DAT and 
other systems that record at 48 kHz. 

Lower sample rates can also be set in this pop-up menu. While you can 
always convert a file's sample rate after it has been recorded with the 
SR Convert command in the DSP menu, greater fidelity will be main­
tained by recording the file at the rate that will ultimately be needed. 

• Click on the Pre-Allocate box if you want to create a contiguous 
file. 

A contiguous file is one in which all of the sample data is recorded in a 
giant block, and is not broken up and placed at different spots on your 
hard disk. A contiguous file is far less susceptible to problems sur­
rounding disk access and general playback. Remember, however, that 
even a hard disk with 30 free megabytes may not have any contiguous 
disk areas that are larger than three or four megabytes. When Pre­
Allocate is checked, Sound Designer II will allocate all the space avail­
able on the hard disk (contiguous or not) for recording. The important 
point is that Pre-Allocate is checked before recording, so that allocation 
doesn't occur during the recording process. 

NITTE: Optimizing your hard disk will generally free up larger con­
tiguous disk areas, but it may also damage copy-protected applica­
tions. Remove those applications with their proprietary installation 
software before optimizing. 

NITTE: When writing files to erasable optical drives, the Pre-Allocate 
box must be checked prior to recording. 

• Set the Disk Buffer size, to establish how much memory is 
allocated as a record buffer. Generally a setting of 4 to 8 will 
produce the best results, but you may need to decrease this 
number if you are running with limited memory, or increase it 
if you have a fragmented or slow disk. 
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NOTE: When using erasable optical drives, the Disk Buffer value must 
be set to 32 since these devices are quite a bit slower than conventional 
hard disks. 

To set the input level: 

• Select input type (analog or digital) in the Hardware Setup 
command in the Setup Menu. 

•Feed a signal into the Audio Interface's input(s). The level 
meters in the Tape Deck dialog will display the input levels. 

• Click on the Monitor box. The input signal will be fed to the 
outputs of the Audio Interface, allowing you to audition the 
input material. 

• Adjust the input level of your signal until the level meters in 
the Tape Deck dialog register input levels that peak around 0 
dB without clipping. 

Input levels must be adjusted with the output controls of your signal 
source. Make sure that the Audio Interface's input levels do not clip! 
Unlike analog distortion, digital distortion sounds truly awful and 
should be avoided at all costs. 

NITTE: The Tape Deck module's clip indicators are really "clip-hold" 
indicators, meaning that they remain highlighted even after clipping 
has ceased. This allows you to leave your Mac while recording, and 
detect any clipping after you return. If the clip indicators are high­
lighted, you know that at least some signal has been clipped. To reset 
the dip-hold indicators, click the mouse anywhere on the level meter 
display. 

NITTE: The clip indicators still work even when in "hold." The border 
of the clip LED will be steadily lit to indicate clip hold, but the center 
of the LED will flash on each clipped sample. 
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Recording to Your Hard Disk 

After completing the previous steps, you're ready to record. 

To record to your hard disk: 

• Oick on Record to begin recording (On-line box should not be 
checked). 

You are now recording directly to your hard disk. The input signal will 
be routed out through the Audio Interface's output jacks so you can 
monitor the recording. The Tape Deck dialog shows you a real-time 
display of the length of the file being recorded, the current time into 
the file, and the available recording time that disk space will allow. 

NITTE: If the disk is not fast enough, your Macintosh will issue a beep 
warning during recording. If this happens, increase the Buffer Size 
setting (from 8 to 12, for example). 

To stop recording and audition the take: 

• Oick on the Stop button. 

• Oick on the RTZ (Return To Zero) button to move to the 
beginning of the file, then press the Play button. (Make sure 
that the On Line indicator is not checked, or playback will not 
begin. See Chapter G for more infonnation about putting 
Sound Designer II online with SMPTE.) 

• When you are satisfied with the recording pass, click on the 
Done button. The Tape Deck dialog will disappear, and your 
newly recorded track(s) will appear in the Soundfile Window. 
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Remember that the window will require some extra time to appear if 
your Overview Display is set to show you wave data rather than a 
time line. To access the pop-up governing the Overview Display 
fonnat, simply hold down the Option key while clicking on the 
Overview Display. 

You are now ready to begin editing the soundfile with Sound Designer 
II's digital editing tools. But before we jump into digital editing, let's 
take a look at a typical waveform in order to understand what you will 
be looking at on screen when you return to the soundfile window. 

Understanding Waveforms On Screen 

When you record audio to your hard disk, Sound Designer II displays 
a visual representation of the sound in its Soundfile Window. Using 
this graphic representation of your audio, you can edit sound very 
precisely in destructive or non-destructive ways. 

If you've never seen an audio waveform, this graphic display of the 
data may seem strange to you. The following section is designed to 
help you understand what you're looking at so you can create and edit 
your own audio regions. 

Because this chapter deals with non-destructive editing-which falls 
under the domain of Sound Designer Il's Playlist-we will be referring 
to this repeatedly in our examples. 

When you look at a waveform, you are basically seeing a diagram of 
your recorded sound. This diagram tells you many things about the 
sound. For example, take a look at the following illustration. It is an 
example of a typical waveform. 
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A typical waveform 

This is a mono recording of some pop music with a standard 4/ 4 beat. 
As you can see, there are some very noticeable landmarks in this audio 
landscape. The distinctive peaks are places in the recording where the 
volume goes up momentarily. These are followed by 'valleys' where 
the volume goes down. 

From this representation, you can make a couple of guesses about 
what this means. First, that each of the peaks probably represents a 
beat in the music. Second, since most popular music has four beats to 
a measure, you might also guess that four of these 'peaks' constitute a 
measure of the recorded music. To test this you could select this 
waveform range: 

A one 'bar se"lection 

For our example, we'll name this waveform range "One Bar." Notice 
that the selected range begins immediately before a peak and ends 
immediately before a peak. Looking at it you can see one of the 
fundamental rules for defining music regions: 

• When defining a region, make sure it starts and ends on 
exactly the same part of a beat. 
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Probably the most important step in constructing a music track from 
regions is making sure that the beat is maintained. If the beat or 
rhythm is not maintained, the playlist will seem to 'skip' like a broken 
record. If you always define regions so that they contain a whole 
number of beats (2 beats rather than 2.3 beats, for example), you will 
be able to string all of those regions together and still maintain the 
rhythm. Here's a tip for making sure your region contains a whole 
number of beats: 

• Whenever possible, start a region precisely before a volume 
peak (downbeat) and end it precisely before a volume peak 
(downbeat). 

Think of downbeats as rhythm markers. Most musical phrases begin 
with a downbeat and end just before another downbeat. By making 
your playlist regions begin just before a downbeat and end just before 
the next downbeat, you are creating the most flexible type of region. 
These regions basically start on a "one," and end before another "one" 
(or other whole number). They fit together with no interruption in the 
rhythm, and they can also be used to begin and end arrangements. 
Here is an example of a single selected beat. For our purposes we will 
call this region "One Beat." 

.................................................................................................................................................. : 
I 

I 
i 

: 
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A one 'beat selection 

Notice that this waveform range also begins just before a volume peak 
and ends just before a volume peak. Its length is equal to 1I4 of our 
"One Bar" region, so you know that it constitutes a quarter note. 

These hints should provide you with some insight into selecting 
waveform regions with Sound Designer II. Sound Designer H's Playlist 
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allows you to arrange the regions of a soundfile in any order, but it is 
up to you to make the end product "musical". 

Playing Back and ·shuttling the Tape· 

Once you have recorded a soundfile, you can play it back by returning 
to the Tape Deck dialog and using the transport controls. 

SHORTCUT: In the Tape Deck dialog, the left arrow key on the Mac's 
keyboard functions as a Rewind button, the right arrow as a Fast 
Forward button, and the Spacebar as a Play /Stop button. Pressing 
Return is the same as clicking on Done. 

There are also several ways to play the file from the Soundfile Win­
dow. 

To play the soundfile from any point: 

•Click and hold the cursor at the desired position in the Over­
view Display. (This will not work if the Zoom icon is en­
gaged.) 

To play the soundfile from the current cursor position: 

• Press the Spacebar. Press the Spacebar again to stop playback. 

To play a soundfile from the beginning: 

• Press the Return key to move to the beginning of the file, then 
press the Spacebar. 

To play a file from the position displayed at the left edge of the 
Soundfile Window: 

• Click and hold on the Speaker icon. 
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NOTE: The Speaker icon playback will not function unless the Setup 
menu's Sound Playback ... command has the Sound Accelerator and Direct 
from disk options selected. 

NOTE: The Preferences ... menu provides a way to pre-allocate memory 
buffers for hard disk playback in order to eliminate delays on play­
back. See Chapter H for details. 

Creating and Editing Playlists 

Once you have recorded a soundfile, an unlimited number of rear­
rangements can be created for it with the Playlist. A Playlist is really a 
map of the soundfile that can be used to define the way it will be 
played back. You can think of each Playlist as a non-destructive 
"remix" of the original soundfile, allowing you to create a new struc­
ture without changing the actual source material. 

The Playlist creation process consists of defining (capturing) regions of 
a soundfile, creating a blank Playlist, choosing region playback order, 
and setting up transitions between the different regions. Since a region 
can be played back any number of times in a Playlist, it is possible to 
create Playlists that are much longer than the original source file. 

Before a Playlist can be built for a soundfile, you need to define at least 
one playback region (in a song, the verse or chorus, for example). By 
selecting a waveform range and choosing the Playlist menu's Capture 
Region command, you will be able to define a Playlist region. 
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Selecting a Region 

Playlist regions can be selected in a variety of ways. The Selector 
provides the most straight-forward method. 

To select a short region: 

•Click on the Selector to activate the Selector. 

• Drag through one or both channels of the Waveform Display 
to select the desired range. The selected area will be displayed 
in inverted video (white on black). 

NOTE: While capturing a region, it doesn't matter if only one channel 
of a file is selected. 

A selection range can be extended using the standard Macintosh Shift­
click technique. 

To select an extended region: 

• Click on the point within the Waveform Display to place the 
flashing cursor at one end of the desired range. 

• Scroll or locate to the other end point for the range. Hold down 
the Shift key and click on the exact position in the Waveform 
Display to define the extended range. 

To audition a selected region: 

• Click and hold the Speaker button. 
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To define the selected region for use with a Playlist 

• Choose Capture Region ... from the Playlist menu. 

• Enter a name for your new region. 

• OickOK 

Your region has been captured and will be appear in the Regions List 
when you open the Playlist window. 

NOTE: The Preferences ... command in the Setup menu provides an 
option for automatically naming captured regions in sequential 
fashion, such as "Region 1 ", "Region 2", and so forth. Regions can later 
be renamed with the Rename Region command in the Playlist menu. 

Selection Shortcuts 

The arrow keys on the Mac keyboard, Scrubber, and Number Markers 
provide various shortcuts that can significantly speed up the task of 
locating and defining regions. 

Selecting a Region with the Arrow keys 
The arrow keys on the Macintosh keyboard provide a great shortcut 
when selecting soundfile regions. Pressing the Down arrow during 
playback in the Soundfile Window sets the start point of the selection 
and pressing the Up arrow sets the end point of the selection. 

To select a region as the soundfile plays back: 

• Press the Spacebar to start playback of the active soundfile 
from the current cursor position. 

• As the soundfile plays, press the Down arrow at the appropri­
ate time to define the start point of the selection. 
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• As playback continues, press the Up arrow at the appropriate 
time to define the stop point of the selection. 

• Press the Spacebar to stop hard disk playback. 

When playback stops, you will see that you have selected a section of 
the soundfile. If the highlighted section is not immediately visible, 
press the Left arrow key and the Waveform Display will jump to the 
selection's start point. Likewise, pressing the Right arrow will cause 
the display to jump to the selection's end point. 

• Oick and hold on the Speaker button to audition the selected 
range. 

• Use the Capture Region command in the Playlist menu to 
capture this region for use with the Playlist. 

Selecting Regions Using the Scrubber 
The Scrubber provides a way of selecting end points for a range with 
pinpoint accuracy. 

To select a region with the Scrubber: 

•Make sure that Scroll After Play is checked on the Setup menu. 

• Click on the Scrubber icon to switch to Scrub mode. 

• Click and hold the mouse in the Overview Display to play 
back the file until you reach a potential region start position, 
then let go of the mouse button. The Waveform Display will 
automatically scroll to show your current soundfile position. 

• Oick and hold the mouse in the Waveform Display to show 
the Scrub bar, then drag the mouse to the left or right to scrub 
across the waveform. 
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• When you have pinpointed a good region start, switch to 
Selection mode (with the Selection icon), and click the cursor 
once at the point you've just located. A flashing insertion point 
will appear. 

• Return to Scrub mode and repeat the same procedure to 
pinpoint the exact region end point. 

• When you have found a good region end point, switch back to 
Selection mode. 

• Hold down the Shift key and click on the region end point 
you've located. The entire region will now be selected. 

• Click and hold on the Speaker button to audition the selected 
range. 

• Use the Capture Region command in the Playlist menu to 
capture this region for use with the Playlist. 

NOTE: Recall that holding down the Command key before you start 
scrubbing activates "shuttle" type scrubbing. Also recall that you can 
toggle back and forth between Selection and Scrub modes by holding 
down the Option key. 

This procedure is an easy way to find and capture regions in a long 
soundfile. Once a region has been captured, it appears in the Regions 
list of the Playlist window until it is cleared. 

Selecting a Region Using Markers 
Another convenient way to locate regions for later capture in a long 
soundfile is to place Numbered Markers "on the fly" during playback. 

To place Numbered Markers during playback: 

• Start playback before the points you wish to mark. 
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• Press Enter on the Mac keyboard at each point you wish to 
mark. 

• Stop playback. 

• Press the number key corresponding to beginning of the range. 
The display will scroll to that position. 

• Fine-tune the marker's position with the Selector if desired, 
then press the Up arrow key or click the Selector at the marker 
position. 

• Press the number key corresponding to end of the range. The 
display will scroll to that position. 

•Fine-tune the marker's position with the Selector if desired, 
then press the Down arrow key or click the Selector at the 
marker position. 

You can drop markers during playback from the tape deck and the 
Waveform Display .. 

Creating and Assembling a New Playlist 

Once you have captured your regions, you are ready to create a new 
Playlist. 

To create a Playlist: 

• Click on the Playlist icon. The Playlist window appears on 
your screen. The currently defined regions are displayed 
under Regions. 
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The Playlist window 

• Click on the name of the region that you wish to place first in 
the Playlist then drag it down to the Playlist area. A dialog box 
will appear prompting you to name the new Playlist. 

NOfE: The Preferences ... command in the Setup menu has a provision 
for Playlists to be named automatically ''Playlist 1 ", "Playlist 2", and so 
forth with sequential numbers. Playlists can later be renamed with the 
Rename Playlist ... command in the Playlist menu. 

• Type in a name and dick on the OK button. The name of the 
region will appear in the Playlist area. Notice that defaults for 
the start time, length, stop time, crossfade type, crossfade 
duration, and volume are entered automatically (you may 
change these defaults in the Preferences command). 
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• Drag the next region from the Regions area down to below the 
first region in the Playlist area. The new region will be placed 
after the first region. You can place any region before or after 
any other region by dragging it to a different position. 

• Continue dragging regions from the Regions area and placing 
them at the appropriate relative positions in the Playlist area. 
Notice that all start and stop information is automatically 
updated. 

You have now created a working Playlist. Playlists are saved with the 
soundfiles from which they were created. Options for saving your 
work are covered at the end of this chapter. 

Auditioning Playlists 

Now that you have created a playlist, you'll want to audition it to 
decide whether or not to make further changes. 

To audition a Playlist 

• Select the first region in the Playlist (or press Return) and click 
on the Play button (or press the Spacebar) to play back the 
Playlist. Press the spacebar or the stop button to stop playback. 

To audition a single Play list region or start playback from a specific 
region: 

• Select the region in the Playlist area. 
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• Oick on the Play button (or pressing the Spacebar). Click on 
the Stop button (or press the Spacebar again) to terminate 
playback. 

Setting Playlist Crossfades and Transitions 

Often, in the process of creating a Playlist, you will be able to organize 
a remix so that it works rhythmically, but the transitions between 
regions may seem abrupt or unnatural. To remedy these problems, 
Sound Designer H's Playlist module lets you set different crossfades to 
be executed automatically when playback moves from one Playlist 
region to another. 

Each region in the Playlist area has a user-selectable XFade (crossfade) 
as one of its parameters. The symbols in the XFade column are icons 
that show you what type of crossfade will be executed between the 
end of that region and the beginning of the next region. The transition 
time of these crossfades can be set with the XFade Duration box to the 
right of the XFade indicator. These crossfades are done in real time, and 
no sample data is changed. 

NOTE: The Preferences ... command in the Setup menu provides a way 
to set a default crossfade time. See the Preferences ... command in 
Chapter H for details. 

There are seven different transition/ crossfade types you can choose. 
Here are brief explanations of each: 

1... ... ± .... ...1 

Butt splice. Butt splice is the default transition type. It indicates that 
playback will jump from this region to the next with no crossfade. This 
will generally cause abrupt transitions, but will be acceptable most of 
the time. 
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Linear crossfade. The linear crossfade transition fades out the first 
region with a linear fade curve, as it fades in the next region with a 
linear fade curve. Linear crossfade curves generally produce good 
results, so try them as your first crossfade choice. 

' 
...... ~ ...... , 
...........•..... 

Equal power crossfade. The equal power crossfade transition type 
fades out this region with a 3d.B fade curve, as it fades in the next 
region with a 3 dB fade curve. If a linear crossfade produces a drop in 
overall volume across the transition, try an equal power crossfade. 

l····x····1 .............. 
Slow in, fast out crossfade. The slow in, fast out crossfade transition 
type quickly fades out this region as it slowly fades in the next region. 

r·x·· .. 1 
F~t·~·slow out crossfade. The fast in, slow out crossfade transition 
type slowly fades out this region as it quickly fades in the next region. 

l ..... rn ...... I 
................. 

Overlap transition. The overlap transition type performs no 
crossfading. Based on the crossfade duration setting, it simply overlaps 
data after the end of this region into the next region, while overlapping 
data before the beginning of the next region into this region. If an 
overlap transition causes signal overload, try the overlap with limit, 
explained below. 
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Overlap transition with limit. Like the overlap transition the overlap 
transition with limit performs no crossfading. Based on the crossfade 
duration setting, it overlaps data after the end of this region into the 
next region, while overlapping data before the beginning of the next 
region into this region. However, in doing so, it automatically limits 
the amplitude of the resulting overlap area, making sure that no 
clipping (and therefore no distortion) results. 

Pre/Post Crossfades 
All of the transition types may be set as normal transitions, pre­
crossfades, or post-crossfades. A pre-crossfade generates the entire 
crossfade before the transition instead of through the transition. This 
type of crossfade is very useful if you want to maintain the amplitude 
at the very beginning of the next region, instead of fading across it 
(when you don't want to fade across a percussive downbeat, for 
example). 

A post-crossfade generates the entire crossfade after the transition 
instead of through the transition. This type of crossfade is very useful 
if you want to maintain the amplitude at the end of this region instead 
of fading across it (when the region ends with an important audio 
feature, for example). 

To set and adjust the crossfade type that will be executed at the end 
of a region: 

• Gick and hold on the icon in the region's XFade box until the 
crossfade pop-up menu appears. The multi-function pop-up 
menu showing the crossfade type and "pre" or "post" charac­
teristics of the crossfade (the vertical lines on either side of the 
crossfade icon). 

• Dragging down the center of the pop-up menu to highlight the 
crossfade type. Drag to the right (pre-crossfade) or left (post-
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crossfade) to select the transition characteristic of that 
crossfade. 

•Release the mouse button. Your selected crossfade appears in 
the region's Xfade box. 

• Double-Oick on the XFade Duration box to set the duration of 
the crossfade. This dialog also tells you the maximum duration 
available, based on the region's boundary. Note: you may see a 
maximum available time for the crossfade, but not have 
enough RAM in your computer to execute it. 

•Type in the desired crossfade duration and dick on the OK 
button. 

NOTE: XFade Duration performs no function if the transition is a butt 
splice transition. The default butt splice duration is zero milliseconds. 
It is possible to create your own default settings with the Preferences 
command in the Setup menu. Sound Designer II will remember these 
new defaults and use them each time you open the application. 

All crossfades in an active Playlist are stored in RAM for playback. 
This means that a Playlist with many long crossfades may actually use 
up all remaining RAM in your CPU, and prevent playback. To avoid 
this, remember that short crossfades (10 ms to 100 ms) generally 
produce the best results. 

Utilizing More RAM for Crossfades 

To gain the maximum amount of RAM possible for long playlists and 
crossfades, you can try the following: 

• Install more RAM in your Macintosh. 
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• Allocate more RAM to the Sound Designer II application by 
selecting the application in the Finder, then choosing Get Info ... 
in the File Menu. 

• Reduce the RAM Buffer size in the Setup Menu size to its 
minimum (4). 

Adjusting the Volume of Playlist Regions 

In addition to being able to specify a crossfade between two regions in 
a Playlist, it is also possible to individually adjust the volume of each 
region in the Playlist . This feature is useful in minimizing the effects of 
transitions between regions of widely different volumes. 

To adjust the volume of a Playlist region: 

• Oick and hold the mouse over the Volume box. A slider will 
appear along with numeric readout. 

• Move the slider to the desired volume setting and release the 
mouse button. 

NOTE: Volume set at 127 is normal volume. All other values are gain 
reductions only. 

Previewing Transitions Between Regions 

You probably don't want to listen to your entire Playlist each time you 
change it. Therefore, Sound Designer II provides you with a handy 
command for previewing just the currently selected region in the 
playlist and a portion of the regions before and after it. 
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The pre/post-roll settings in the Preferences dialog (in the Setup menu) 
determine the how much of the neighboring regions you will hear. 

To preview the transitions between the currently selected region and 
the regions before and after it in the Playlist: 

• Choose Preview Edit ... from the Playlist menu. As the audio 
plays back you will be able to hear the transitions. 

To increase of decrease the amount of Pre/Post roll for the Preview 
Edit function: 

• Choose Preferences from the Setup menu. This dialog appears: 

user oereult OptlHs 

O Ruto-aeme regions 
0 Ruto-Hnte ,1ayllsts 

Uertleal scales: I 'I. Scale :===========---...... Hartz. Scales: !.__Tl_m_e ____ _. 

O Pre-elocete ID lluffers: Multiple • LI 
DefeUlt cross fade: CI]~ msec 

Preulew edit pre-nll: ~ sec 

Preulew edit post-roll: ~ sec 

The Preferences dialog 

• Enter the amount of pre and post roll that you wish to hear. 

• OickOK. 

These settings will remain active until you change them again. 

Hard Disk Recording and Non-destructive Editing 73 

Iii -



74 

Further Editing of Playlists 

Once a Playlist has been created and saved, it can always be reopened 
and edited. Remember, each soundfile can have multiple playlists. 

To edit an existing Playlist: 

• Open the soundfile that contains the Playlist. 

•Click on the Playlist module icon to open the Playlist window. 

• If the desired Playlist is not already open, choose the Open 
Playlist ... command in the Playlist menu. An open dialog will 
appear with a list of existing Playlists. 

• Select the Playlist you wish to edit, then click on the Open 
button. The selected Playlist will appear in the Playlist 
window's Playlist area. 

• Move any Playlist region by dragging it to a new position. All 
start and stop information is automatically adjusted. 

NITTE: Frame-locked regions for SMPTE synchronization will not slide 
in position to compensate for a moved region. If there is no room for a 
region between frame-locked regions, it will not be moved. See Chap­
ter G, Working with SMPTE, for more information on synchronization. 

To view or change the waveform range that makes up a region: 

• Double-click on the region's name in the Regions list. The 
Soundfile window will be brought to the front with the region 
selected. You can then examine it, or change it, and then 
recapture it under a new name. 
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To delete an entry from the Playlist: 

• Oick the entry to select it and press the Delete key on the 
Mac's keyboard, or select Oear from the Edit Menu. 

The Edit Regions dialog described later in this chapter will allow you to 
re-edit your regions while auditioning the rhythm of your Playlist. Try, 
however, to maintain the rhythm of the regions across transition points 
as much as possible when you are first creating a Playlist; being as 
exact as possible at this stage will speed up the creation of a good 
Playlist. 

To copy a region or group of regions from one Playlist to another: 

• Select the region(s) in the source Playlist and select Copy from 
the Edit menu (use the Shift key to select more than one 
region). 

• Use the Open Playlist ... or New Playlist ... command in the 
Playlist menu to switch to the destination Playlist. 

• Select the entry that you would like the copied entries to be 
placed above in the destination Playlist. 

• Select the Paste command from the Edit menu. 

To rename any region within a Playlist: 

• Select that region and choose Rename Region from the Playlist 
menu. 

To rename any Playlist: 

• Choose Rename Playlist from the Playlist menu. 
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To delete a region from all Playlists: 

• Select the region in the Regions display. 

• Choose the Clear command in the Edit menu or press the 
Delete Key on the Mac's keyboard. 

Fine Tuning Regions with the Edit Regions Dialog 

The Edit Regions dialog allows you to make fine adjustments to the 
start and end points of any defined region and then save the change to 
the original region, or as a new region. Its loop play mode is particu­
larly useful for fine tuning the rhythmic transitions between regions of 
a Playlist. 

To set up the Edit Regions dialog: 

• With the Playlist window open, select a region in the Playlist 
area and double-dick on its name, or choose Edit Regions from 
the Playlist menu. The Edit Regions dialog will appear. 
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The Edit Regions dialog 

SHORTCUT: If you double-dick on the left half of the name, the dialog 
will appear with the start of that region selected for editing. If you 
double-dick the right half of the name, it appears with the end of that 
region selected for editing. 

The name of the selected region, its length, and those of the regions 
before and after it appear here with "Nudge" buttons to adjust the 
start and end points in small or large increments. Crossfades and their 
durations can be set, as can volume for each region. 

Clicking the Speaker icon will play back the region located directly 
below it: the left icon plays across the first splice point, the middle icon 
plays the selected region, and the right speaker icon plays across the 
second splice point. Pre-' and post-roll times can be set to extend 
playback to include areas before and after the playback areas. (Pre- and 
post-roll values both set to zero will effectively disable the right and 
left Speaker icons.) 
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NOTE: Default pre- and post-roll times can be set using the Preferences 
command in the Setup menu. 

The black bar directly below the speaker icons functions in the same 
way as the Overview Display: Holding the mouse down at any point 
in this display will start playback from that point in the three dis­
played regions. 

To adjust the start or end points of a region: 

• Audition the selected region by clicking on the appropriate 
speaker icon. Adjust pre and post roll times as necessary. 

• Gick on the rectangles corresponding to the beginning and/ or 
end of the region you wish to edit. 

• Gick on one of the Nudge buttons to move the selected start 
and/or end points by the amount displayed in the associated 
boxes. Two sets of buttons are provided for making large or 
small incremental changes. 

• To change the Nudge increments, type a value into the boxes 
below the Nudge buttons and/or select a value in millisec­
onds, frames, or samples using the associated pop-ups. 

• Gick on the appropriate Speaker button to audition the 
change. 

• Use the two arrow buttons located on the right side of the 
Region Edit dialog to scroll through and fine tune an entire 
Playlist. 

• When you are completely satisfied with your Playlist, click OK. 
The Playlist will be automatically updated to include your 
changes. 

NOfE: Clicking the ''Trigger on Nudge" box will automatically 
audition your changes each time you nudge your start or end points. 
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Clicking on the icon a second time or pressing the Spacebar will stop 
playback. 

NOTE: It is possible to edit more than one region's start/ end points at 
the same time simply by selecting them and using the nudge buttons. 
Conversely, if no start/ end points are selected, the nudge buttons will 
have no effect. 

Creating a Fade In/Out in a Playlist 

Another useful feature of the Playlist is its ability to create a non­
destructive, real-time fade in and fade out with a user-editable enve­
lope. The Playlist's Fades editor makes the creation of smooth, natural 
fade ins/outs very simple. 

To create a fade in/out for a Playlist: 

• Choose Fades from the Playlist menu. The Fades dialog ap­
pears. 
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The Fades dialog 

• Choose Fade In or Fade Out from the pop-up menu at the top of 
the dialog, or type "i" or "o" on the keyboard. 

• With the Breakpoint tool selected, click and drag anywhere on 
the diagonal line to modify the fade in/ out envelope, then let 
go of the mouse. Repeat this process until you are satisfied 
with your envelope. 

To remove an envelope definition point: 

• Click on the Eraser icon and then click on the point that you 
wish to remove. 
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To use one of Sound Designer II's preset envelopes: 

• Oick on the one of the Preset Envelope icons below the Eraser 
tool and drag it into the envelope display area. 

• Type the desired length of your fade in/ out into the Length box 
at the bottom of the screen. 

• Oick and hold the Speaker icon to preview your fade in/ out. 

To create symmetrical fade in and fade out envelopes: 

• Create either the fade in or fade out envelope. 

•Use the pop-up at the top of the dialog to select the opposite 
function. 

• Oick the Copy Fade In or Copy Fade Out button (depending 
on which you have selected in the pop-up menu) . 

To implement a fade in/out: 

• When you are satisfied with your fade in/out, click OK. Sound 
Designer II will create the non-destructive fade in/ out for your 
Playlist and implement them in real time during playback of 
your Playlist. The fade parameters will be stored with your 
Playlist when you save the file. 

To disable a fade in/out: 

• Set the length of the fade in/ out to 0. 

Hard Disk Recording and Non-destructive Editing 81 

-



82 

Saving Your Work 

Though we're covering it here at the end of this chapter, saving is not 
just something you should do at the end of a session. In fact, you 
should get in the habit of saving frequently throughout your sessions in 
order to avoid the possibility of losing valuable work due to some 
unforeseen accident. 

Saving a Soundfile and its Playlists 
The Save Session ... command saves the changes you have made to your 
session and writes them over the old soundfile in the same file format. 
This command cannot be undone. 

To save the file under the same name: 

• Select Save from the File menu. The original file will be up­
dated. 

Saving a Under a Different Name 
The Save A Copy ... command is useful for saving a copy of the current 
soundfile under a different name or in a different hard disk location. 
Because the Save a Copy ... command closes the current session and lets 
you keep working on the renamed copy, it is particularly useful if you 
are experimenting and want to save successive stages of the editing 
session. By working this way, you'll always have the option of going 
back to an earlier version. 

To save the file under a different name: 

•Select Save A Copy ... from the File menu. A file dialog will 
appear: 
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The Save a Copy ... dialog 

• Select the desired format, enter a name for the file, then click 
on Save. 

Files can be saved in compressed format to conserve file size, or as 
Macintosh SND resources in either 16 bit or 8 bit resolution, mono or 
stereo format. For more information about these and other formats 
refer to the Save A Copy command in Chapter H, Reference. 

Saving a Playlist as a New Soundfile 
In some cases, after you have created a definitive Playlist "remix" of an 
audio file, you may wish to permanently transform the Playlist into a 
new audio file of its own. In other words, new soundfile will be the 
equivalent of digitally recording the output of a Playlist into a new file. 
The Save Playlist as Soundfile command lets you do just this. 

Be aware that by doing this, the new file will be just as long as the 
Playlist's play time, so you may require quite a bit of additional hard 
disk space. 
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To save a Playlist as a soundfile: 

• Open the desired Playlist. 

• Choose Save Playlist as Soundfile from the Playlist Menu. A 
dialog box will appear allowing you to name the new file. 

• Enter the desired file name and click on OK. This creates a new 
soundfile with all of the attributes of the current Playlist­
region playback order, fade ins/outs, crossfades, and so on. 

Summary 

This chapter has covered the essentials of hard disk recording and non­
destructive editing. The next chapter delves into destructive editing 
and digital signal processing. 
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Destructive Editing and 
Digital Signal Processing 

Introduction 

This chapter examines the various tools and techniques available for 
permanently modifying your soundfiles, including cutting, pasting, 
reversing, trimming, and normalizing audio. Covered here as well are 
Sound Designer II's DSP (digital signal processing) functions, some of 
which can be applied either destructively or non-destructively to 
digital soundfiles. 

Destructive editing is the process of permanently rearranging or 
changing actual sample values to change the way an audio file sounds. 

As you saw in the last chapter, non-destructive editing techniques are 
extremely powerful when it comes to remixes and alternate arrange­
ments, or for working with several ideas using the same source 
material. In this chapter you will find, however, that destructive 
editing, too, can play an important a role in creating your final mix, 
since there are certain destructive waveform editing functions that 
cannot be replicated in the non-destructive realm. Click and pop 
removal, time compression/ expansion, mixing, and reversing sounds 
are examples of such functions. 

Be aware however, that destructive editing has its disadvantages as 
well: not only does it force you to alter your soundfiles forever, but it is 
also very RAM-intensive, and requires quite a bit of time to perform 
large edits and redraw your screen. 

Destructive Editing and DSP 87 

Ill -



Therefore, in general, for creating digital "remixes" and alternate 
arrangements of audio files, you will probably want to stick with non­
destructive editing and use destructive editing for only those functions 
that non-destructive editing does not provide. 

Opening a Soundfile 

First, let's go through the procedure of opening an existing file in order 
to edit it. 

To open an existing file for editing: 

• Select Open ... from the File menu. A file dialog appears. 

la Rudio Files"' I 
c::J Pro store Slrll111l11 l·m11rll1rn,1 •••••lj_.,._~ 

Snare and Kick 
0 CD Master 
Cl Frantic R11bblt 
D Jingle Ma\ter Mm 
0 Master Score 
Cl R11dio RemlH 
0 Dolce Duer 

181 Sound Designer 181 Rudio IFF 
181 sound Designer 11 

Sound Designer 11 16-bit Stereo 
1.87 secs 44100.00 Hz 

( E }<H t ) Two Beet 
Groo11e/no 4 

( Desktop ) Snore on 2 

Select 

Play 

Cancel 

Snare, kick after 
Snare Flom 
Snare I /4 
Chuckle 
Slap 

0 File @Regions 0 Ploylists 

The Open ... dialog 
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• Select the file you desire and click on Open. 

Note that the Open dialog has two file windows. The window to the 
left allows you to locate files on hard disks. When you have selected 
an audio file, to the right will appear Regions or Playlists associated 
with it-if you have selected one of these viewing options with the 
radio buttons near the bottom of the dialog. 

A check in one of the file format boxes at the lower left of the dialog 
(Sound Designer, Audio IFF, or Sound Designer II) will tell Sound 
Designer II to display any files of that type present in the current hard 
disk folder being displayed. 

Here is a brief explanation of these file formats: 

Sound Designer. The Sound Designer file format is the standard 16-bit 
mono format used by the original Sound Designer program. It is useful 
for file exchange with programs that support only the Sound Designer 
files. 

Sound Designer II Mono. The Sound Designer II file format is a 16-bit 
mono format recommended for use with DECK digital multitrack 
recording software or mono files that require more than 10 markers. A 
mono soundfile not saved in this format will lose all markers above the 
10 supported in the original Sound Designer file format. 

Sound Designer II Stereo. The Sound Designer II file format is the 
default 16-bit stereo format employed by this program. It is the recom­
mended stereo recording file format. 

AIFF. The AIFF file format is Apple's Audio Interchange File Format, 
and is a variable-resolution, multi-channel soundfile format. Use it to 
exchange soundfiles between programs, but do not use it for hard disk 
recording. The AIFF format can be used to create and store mono files. 
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NOTE: Sound Designer II can create and/ or open both 8 and 16 bit 
audio files. 16 bit resolution is the recommended format for profes­
sional recording, as it provides CD quality fidelity. 8 bit resolution is 
much lower in fidelity and is therefore unsuitable for professional 
audio recording. 

NOTE: The Open Resource ... command in the File menu is used to open 
Macintosh SND Resource files. Resources are embedded within 
documents and applications, so the Open Resource ... dialog will show 
documents and applications, instead of showing only soundfiles. 

Using Backup Files 

Before you begin destructive editing of audio files you may wish to 
tum on the Use Backup Files option in the Setup menu. When this 
command is checked ( 4) in the Setup menu, Sound Designer II will 
create a backup copy of any file that is opened. In this mode, all edits 
are made to a copy of the original soundfile, and are NOT saved to the 
original until the File menu's Save command is chosen. This is the 
safest way to edit soundfiles, because it allows you to undo changes 
and close a file without saving any changes you have made. 

Without Use Backup Files enabled, the original disk data is directly 
altered whenever you perform an edit. For this reason it is wise to 
enable Use Backup Files whenever possible. 

NOTE: The Use Backup Files option will only function if there is enough 
disk space to create and edit a backup file. If the required space is not 
available, a warning dialog will appear and allow you to open the 
soundfile as a No Backup soundfile. 
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To edit a backup copy of your soundfile: 

• Choose Use Backup File from the Setup menu. 

• Open the desired soundfile. 

To disable this option, choose it once again from the menu. 

Recovering from Mistakes 

Before you actually get started making destructive edits to your 
soundfiles, it is perhaps a good time to remind you about a very useful 
command-the Undo command. Like virtually all Macintosh applica­
tions, Sound Designer II provides this command to let you "undo" the 
last operation in case you made a mistake. However, please be aware 
that since some operations are extremely memory and disk intensive, 
not all actions can be undone. Sound Designer II will always warn you 
before performing an operation that will be permanent. 

To Undo the last edit 

• Select Undo from the Edit menu. 
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Digital Editing and Splicing 

Audio data can be destructively cut, copied, and pasted in Sound 
Designer II much like text can be manipulated in a word processor. If 
you are accustomed to using the Macintosh you will find many of 
these editing functions familiar. 

NOTE: Most cut and paste edits can be performed faster in the Playlist. 
Large destructive edits entail a significant amount of time for hard disk 
access and screen updates. 

Editing Out a Passage 
A selected area can be cut out of the soundfile and the remaining 
pieces joined together in the digital equivalent of a tape splice. 

To permanently remove a portion of the soundfile: 

• Select the region of the waveform to be removed using the 
Selection tool. 

• Select Clear from the Edit menu. 

Moving a Passage 
A selected area can also be moved to another place in the soundfile, 
automatically making room for the passage and dosing the gap left by 
the old. 
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To remove a portion of the soundfile and place it elsewhere: 

• Select the region of the waveform to be moved using the 
Selection tool. 

• Select Cut from the Edit menu. This places the selected wave 
data on the Oipboard. 

• Position the cursor at the location you wish to place the wave 
data and click. 

• Select Paste from the Edit menu. The Clipboard wave data will 
be placed at the selected location and all soundfile data to the 
right will be shifted to accommodate the pasted data. These 
last two operations can be repeated as many times as needed. 

NOfE: Editing data with radically different amplitudes can result in 
clicks or pops at the edit points. These unwanted artifacts can usually 
be eliminated by performing edits with Smoothing engaged in the Edit 
menu. Smoothing performs fast crossfades at the edit points to elimi­
nate abrupt changes in amplitude. Smoothing is a simple toggle: a 
check next to the menu item indicates that smoothing is engaged. 

Duplicating a Passage 
A selected passage can be duplicated as many times as necessary. 

To copy a portion of the soundfile and place it elsewhere: 

• Select the region of the waveform to be copied. 

• Select Copy from the Edit menu. This places the selected wave 
data on the Oipboard. 

• Position the cursor at the location you wish to place the wave 
data and click. 
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• Select Paste from the Edit menu. The Clipboard wave data will 
be placed at the selected location and all soundfile data to the 
right will be shifted to accommodate the pasted data. These 
last two operations can be repeated as many times as needed. 

NOTE: Unlike duplication with the Playlist, pasting in this manner will 
add length to the soundfile. Pasting will only be permitted if there is 
enough disk space to accommodate the additional data. 

NOTE: If the data on the Clipboard is from a single channel and you 
select a destination that includes both channels, a dialog will appear 
allowing you to select the destination channel. 

To paste a region without altering the soundfile's length: 

• Cut or copy source data to the Oipboard as previously de­
scribed. 

• Position the cursor at the location you wish to place the wave 
data and click. 

• Select Replace from the Edit menu. The Clipboard data will 
replace as much existing data as is required to accommodate 
the pasted data. 

NOTE: If a destination range is selected instead of a simple insertion 
point, the Replace command will only fill that range with as much data 
as will fit from the Clipboard. 
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Trimming Excess Data 

Audio before and after a selected waveform range can be removed 
from a file with the Trim command. This command provides a handy 
means of quickly removing all data but the selected range. 

To trim excess data from a soundfile: 

• Select the area of the soundfile you wish to retain. 

• Select Trim from the Edit menu. All data but the selected area 
will be removed from the soundfile. 

Reversing a Passage 

Reversed sounds are a popular effect in sound design. Sound Designer 
II lets you perform this type of edit on a selection very easily. 

To reverse a passage: 

• Select the desired passage. 

• Select Reverse from the Edit menu. The selected data is written 
back to the disk in reverse order. 

Permanently Silencing A Passage 
It is sometimes desirable to permanently mute passages where un­
wanted ambient noise occurs or where it is desirable to maintain time 
continuity without actual audio output. The Silence command is 
particularly useful in these cases. 
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To replace a selected range in a soundfile with silence: 

• Select the passage to be silenced. 

• Select Silence from the Edit menu. All amplitudes will be set to 
zero while preserving the length of the soundfile. 

Fading a Passage In and Out 

While the Playlist provides a method of fading passages or entire 
Playlists in and out non-destructively, you can also permanently create 
a fade in/ out in the soundfile itself. 

To fade a passage of a soundfile in or out: 

• Select the passage you wish to fade. 

• Select Fade In from the Edit menu for a linear fade from zero 
amplitude to full amplitude over the selected range; select Fade 
Out from the Edit menu for a linear fade from full amplitude 
to zero amplitude over the selected range. 

All of the previously mentioned operations will permanently alter your 
soundfile data. Use the Playlist if you wish to make non-destructive 
changes. 
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Optimizing Playback Levels 

In cases where a soundfile has been recorded with too little amplitude, 
or where volume is inconsistent through out the range of a soundfile 
(as in a poorly recorded voice-over), the Normalize function will allow 
you to boost all levels in a selected passage uniformly so that the 
loudest peak is set to the maximum amplitude before clipping. 

To optimize your playback levels automatically: 

• Select the passage to be optimized. (If no selection is made, the 
Normalize command will affect the entire file). 

• Select Nonnalize from the Edit menu. 

Levels can also be uniformly altered by a user-defined amount using 
the Change Gain controls. 

To change the playback levels in a passage manually: 

•Select the passage to be altered (or no selection to affect the 
entire file). 

• Select Change Gain from the Edit menu. The Change Gain 
dialog appears. 
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The Change Gain dialog 

• Oick on the Peak Value button to see the percentage value of 
the highest amplitude in the selected range relative to clipping. 

• Select the amount of change desired, either by entering a dB 
value, entering a percentage value, or sliding the Gain control. 

•Click OK. 

• Watch the clipping information as the amplitudes are altered. 
(The display shows both the number of individual samples 
clipped, as well as the number of continuous samples dipped 
over time.) If clipping occurs, select Undo from the Edit menu 
and try the Change Gain command again with a lower value. 

Inverting Amplitudes 
The creation of certain loops and mixes are sometimes facilitated more 
easily by inverting the waveform's amplitude. 
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To invert the amplitude of a waveform: 

•Select the desired passage. 

• Select Invert from the Edit menu. The amplitudes will be 
inverted (positive values become negative and vice versa). 
Performing the operation a second time (or selecting Undo) 
returns the waveform to its original state. 

About Digital Signal Processing 

The concept of digital signal processing (DSP) is one of the central 
ideas behind Sound Designer II. Sound Designer II is a sound work­
shop that can be used to manipulate sound in many ways. A large 
percentage of these "manipulations" fall into the realm of signal 
processing. 

Traditionally, in the analog world, signal processing has been accom­
plished by running a signal through a series of circuits in outboard 
gear. The result of this is an output signal which has been changed in a 
specific way to produce a predictable effect. 

Equalization is a good example of this. In the analog realm, a known 
signal is passed through an equalizer that lets you adjust circuit 
parameters to alter the shape, and hence the spectral content, of that 
signal. Unfortunately, this process generally yields an increase in 
overall noise in proportion to the amount of processing. 

Digital signal processing is based on exactly the same concept, with 
one major exception-DSP functions accomplish their tasks entirely in 
the digital realm. Sound Designer II looks at sounds as a collection of 
data points (samples) indicating the instantaneous amplitudes of a 
sound wave over time. Instead of using a circuit to change the shape of 
a signal, Sound Designer II uses algorithms-mathematical descrip­
tions of the relationship between one signal and another. 
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DSP has its advantages and disadvantages. Unlike most analog 
processing, DSP adds little or no noise to the signal, thereby maintain­
ing the integrity of the sound. However, most digital signal processing 
involves very sophisticated algorithms, which require a long time to 
do their job, and this prevents real-time adjusbnent of parameters. 

Now, with the advent of signal processing chips like the one on a 
Sound Accelerator II card, some of these problems disappear. The 
card's DSP chip takes over most signal processing tasks, and frees up 
your Mac for other tasks. For this reason, you will find that many of 
Sound Designer II' s DSP functions can be both ad justed and used in 
real-time. 

You should, however, be aware that while DSP is a very useful and 
powerful Sound Designer II feature, it can't work miracles. If you try 
to put a Sound Designer II DSP module to use beyond reasonable 
musical limits (time compressing a five minute song down to 2 min­
utes, for example), you may be disappointed. If your soundfile is 
flawed from the start, "fixing it in the mix" may take longer and yield 
poorer results in the end than simply resampling your source material. 

DSP represents a significant step forward in personal digital audio, 
and it is only the beginning of a methodology that will certainly see 
much wider acceptance over the next decade. 

Mixing Up to Four Soundfiles 

Digital mixing and merging are the tools you'll use to mix multiple 
soundfiles into a single soundfile. Using Sound Designer II' s digital 
mixing function, you can take up to four individual mono or stereo 
soundfiles and mix them together with full level, pan, and delay 
control to create a new mono or stereo soundfile. 
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To mix two, three, or four soundfiles to create a new soundfile: 

• Open all of the soundfiles you wish to mix. 

• Choose the Mix command in the DSP menu. The Mix window 
will appear on your screen. 
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The Mix window 

• Oick on either Mono or Stereo. This describes the format of the 
soundfile that will be created as a product of the mix. 

• Oick to place an X in the Scale box if you want the input 
soundfiles to be scaled automatically before the mix is done. 
Scaling makes sure that you don't accidentally clip the output 
waveform by insuring that the mix creates no amplitudes that 
are over 100% of the allowable maximum amplitude. 
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• Select an input soundfile for two or more of the fader channels 
by clicking and holding on the Soundfile pop-ups. 

• If you are using stereo input files, make sure that the channel 
number boxes show both left (1) and right (2) channels. 

• Use the mouse to set the fader levels of each channel of the 
input soundfiles-either by dragging the fader or by clicking 
and dragging anywhere inside the fader area. The fader levels 
describe how much of each input sound will be present in the 
mixed output sound. 

• If you are creating a stereo output file, set the stereo pan of 
each input channel by dragging the triangular stereo image 
markers to the right or left. These markers tell you where each 
channel will be placed in the output stereo image. Remember 
to set stereo input files to the correct full right and full left 
channel pan positions, if you want to maintain the stereo 
image. 

• Enter the delay you want (if any) for each soundfile within the 
mix. The delay setting, specified in milliseconds, lets you set 
the size of the time offset before the soundfile appears in the 
output mix. 

• When all settings are to your liking, dick on the Mix button to 
perform the mix. After some computation, a Save dialog will 
appear. 

• Enter a name for the file that will contain the new mix. (The 
new file cannot be set to replace one of the input soundfiles.) 

• Choose a format, then dick on the New button. 

Your mix will be completed after some number crunching. (The longer 
and greater the number of files, the longer the mix will take to calcu­
late.) When the new mix soundfile appears, you can audition it to see if 
it came out as you intended. If not, try the mix again. All Mix window 
settings are retained until you quit Sound Designer II. 

Sound Designer II 



NOfE: A useful application of the Mix function is creating a mono mix 
of a stereo soundfile. 

Merging Two Soundfiles 

Sound Designer 11' s digital merging functions are advanced 
crossfading tools that allow you to take any two mono or stereo 
soundfiles and create a new soundfile that crossfades from one of the 
original files to the other. 

The merged soundfile fades between marker positions in two files as 
shown in the following diagram: 

"From" Soundfile 

'To" Soundfile 

Merge 
Start 

Merge 
End 

Anatomy of a merge 

The difference between mixing and merging is that mixing can only be 
used to create a new soundfile that is a static mix of all the input 
soundfiles. You can adjust the level (amount) of any soundfile that will 
be mixed, but you can't change or fade any of the input waveforms 
over time. Merging, on the other hand, makes it possible to fade out 
one of the input soundfiles as the other is faded in (commonly called a 
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cro~fade). The amount of time taken to fade between one waveform 
and the other is completely adjustable. 

To merge two soundfiles into a new soundfile: 

• Open the two soundfiles you wish to merge. 

• Place a numbered marker in the soundfile that will begin the 
new merge file. The marker must be placed at the point where 
the crossfade should begin. 

• Place a numbered marker in the soundfile that will end the 
new merge file. The marker must be placed at the point where 
the crossfade between files should end. 

• Choose the Merge command on the DSP menu. The Merge 
window will then appear. 

Merge 

From: Uelcro Shuffle Mork er: Chorus 

To: Micrownue Cats I Morker: test marker I 
Merge length: 

I 141056 I samples, or 13.198551 seconds 

Crossfade Shape: ® Linear O Equal Power 

( Merge ) 

The Merge window 

• Use the From: pop-up menu to choose the soundfile that will 
begin the new merge soundfile. 
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• Use the Marker: pop-up menu next to the "From" soundfile 
name to choose the name of the marker that designates the 
beginning of the crossfade. 

• Use the To: pop-up menu to choose the soundfile that will end 
the new merge soundfile. 

• Use the Marker: pop-up menu next to the ''To" soundfile name 
to choose the name of the marker that designates the end of 
the crossfade. 

• Set the Merge length to dictate how long the crossfade between 
the two markers will be. The merge length will default to the 
longest allowable setting. This will either be the distance 
between the merge "From:" marker and the end of the merge 
"From:" waveform, or the distance between the start of the 
''To:" file and the "To:" marker-whichever is greater. 

• Oick on the box in front of the crossfade shape you desire. 
Linear crossfades use linear fade curves, and generally pro­
duce better results. If you find that the center of your crossfade 
area seems to lose volume, try the equal power crossfade, 
which uses a fade curve that is pushed up by 3 dB at the 
crossfade center. 

• When all merge settings are to your liking, click on the Merge 
button. After calculation, a Save dialog will appear prompting 
you to select the name of a file that will contain the new 
merged waveform. (The new file cannot be set to replace one 
of the input soundfiles.) 

• Choose a file name and format, then click on the New button. 

After an appropriate amount of number crunching, the merged file 
will appear in the Soundfile Window. (Longer files require more 
calculations.) If the merge didn't tum out as planned, try it again. 
Merge window settings are retained until you quit Sound Designer II. 
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NOTE: Take care not to set the merge length to a value greater than the 
time between the "From:" marker and the "To:" marker. This will 
create a gap of silence in the crossfade. 

Sample Rate Conversion 

Sound Designer H's sample rate conversion capability makes it pos­
sible to alter the sample rate of any soundfile without changing that 
sound's pitch. This is a very powerful tool that lets you transmit a 
sound file to another digital device such as a DAT player, CD Re­
corder, etc. 

For example, if you had originally recorded some stereo music on a 
DAT player at 48 kHz but wanted to digitally transfer that file to 
Sound Tools II, edit it, and then master it to a CD Recorder at 44.1 kHz, 
you could easily accomplish this. You would simply transfer the 
music to Sound Tools II at the original 48 kHz, edit it, and then Sample 
Rate Convert the file to the desired 44.1 kHz before mastering it to the 
CD Recorder. 

The sample rate conversion process requires that you create a new file 
to contain the converted sound. This ensures that the original soundfile 
will remain unchanged. 

To convert a soundfile from one sampling rate to another: 

• Open the soundfile you wish to convert. 

• Choose SR Convert in the DSP menu. The Sample Rate Convert 
window will appear. 
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The Sample Rate Convert window 

• If necessary, use the pop-up soundfile menu to select the soundfile 
you wish to convert. 

•Type in the sample rate of the new soundfile, or type in a ratio 
between the new and the original sample rate. 

• When you are ready to create the new file, dick on the Convert 
button. A save dialog will appear. 

• Type in the name for the new soundfile, choose its file format, and 
click on the New button. 

After a moment the newly created soundfile will appear in a Soundfile 
Window. If you want to verify its new sample rate, choose the File 
menu's Get Info ... command to open an info dialog containing pertinent 
soundfile information. 
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Common DSP Functions 

One of the most important aspects of working with Sound Designer 
II' s DSP functions is the ability to apply them destructively or non­
destructively. Non-destructive editing is optimal for hard disk record­
ing where you might want the original data to remain intact. Destruc­
tive application of DSP would be necessary if the soundfile is to be 
downloaded into a digital sampler or if more DSP functions are 
desired than can be accommodated simultaneously. 

Many of Sound Designer 11' s DSP tools-such as Parametric EQ 
Graphic EQ, Compressor /Limiter, Expander, and Noise Gate-share 
common concepts and functions such as the B-ypass, Use for playback, 
Pre:uiew, and Process options. Let's take a moment to become familiar 
with these concepts before working with the remaining DSP functions. 

Applying the DSP Settings Permanently 
The digital EQ and Dynamics settings can be permanently applied to a 
file. This is a destructive process-the soundfile data will be perma­
nently altered. 

To permanently apply a DSP setting to the file or selection: 

• Establish the setting you wish to commit to. 

• Click on the Process button. The setting will be applied to the 
current selection, or to the whole soundfile if there is no 
selection. 

Applying DSP Settings Non-destructively 
Sound Designer II' s realtime non-destructive DSP functions are 
applied for playback only. The soundfile is not altered, making this the 
best processing method for hard disk recording. 
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To engage DSP for playback only: 

• Oick on the Use for playback box in the processor window. The 
DSP function will be applied during playback until it is turned 
off. 

You will always be able to tell when a DSP function is being used for 
playback, because a diamond (u) will appear in front of it in the DSP 
menu. 

To tum off a DSP playback setting : 

• Choose the appropriate processor command from the DSP 
menu to open its control window. 

• Oick on the Use for playback box to remove the X. The DSP 
function will no longer be applied. 

Comparing Processed and Unprocessed Versions 
It is often desirable to compare the results of the current DSP settings 
with the original file. 

To compare processed and unprocessed settings: 

• Oick on the Bypass box to place an X in it. DSP processing will 
be disengaged 

• Oick again on the Bypass box to remove the X. DSP processing 
will be re-engaged. 

Making Fader Adiustments 
Many of Sound Designer's DSP functions incorporate on-screen faders. 
Course adjustments can be made by simply dragging the faders to the 
desired position. Finer adjustments in values can be made by holding 
down the Option key while dragging. 

Destructive Editing and DSP 109 

Ill 



IMPORTANT 

110 

NOTE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 

Parametric EQ 

Sound Designer Il's Parametric EQ functions much like its hardware 
counterparts, allowing you to alter the equalization curve of any 
sampled sound at a specific frequency with pinpoint accuracy. The 
Parametric EQ window offers five equalization filter types, each with 
their own particular parameters. Here are brief explanations of each: 

High-pass filtering. A high-pass filter is essentially a filter that passes 
high frequencies through, but removes (attenuates) low frequencies. It 
is used to remove unwanted low frequencies. When you are using the 
Parametric EQ window to build a high pass filter, only one parameter 
is available: cutoff frequency. Theoretically, all frequencies above the 
cutoff frequency are let through, and all frequencies below it are 
removed. In practice, the cutoff is never perfectly sharp. The actual EQ 
curve is always indicated in the Parametric EQ window's filter graph. 

Low-shelf filtering. A low-shelf filter is one that boosts or cuts the 
level of all frequencies below a certain frequency, but leaves those 
above that frequency untouched. It is generally used to adjust the 
overall low end of a sound. When you are using the Parametric EQ 
window to build a low-shelf filter, two parameters are available: 
corner frequency, and boost/cut amount. Theoretically, only those 
frequencies below the corner frequency are adjusted by the amount (in 
dB) you specify in the boost/cut parameter. In practice, the comer is 
never perfectly sharp. The actual EQ curve is always indicated in the 
Parametric EQ window's filter graph. 

Peak/notch filtering. The characteristics of peak and notch filters are 
very similar. A peak filter is one that boosts only a specific frequency, 
or range of frequencies, while leaving all other frequencies untouched. 
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A notch filter reduces the level of a specific frequency or range of 
frequencies. Both filters are used to adjust only a specific part of a 
sound's harmonic spectrum. When you are using the Parametric EQ 
window to build a peak or notch filter, three parameters are available: 
center frequency, bandwidth, and boost/ cut. The center frequency 
always indicates the actual location of the peak or notch. The band­
width shows the actual number of frequencies that will be adjusted 
(half on either side of the center frequency). Boost/cut determines if 
your filter will be a peak (boost) or a notch (cut) filter. 

High-shelf filtering. A high-shelf filter is one that boosts or cuts the 
level of all frequencies above a certain frequency, but leaves those 
below that frequency untouched. It is generally used to adjust the 
overall high end of a sound. When you are using the Parametric EQ 
window to build a high-shelf filter, two parameters are available: 
comer frequency, and boost/ cut. 

Low-pass filtering. A low-pass filter is one that passes low frequencies 
through, but removes high frequencies. It is generally used to decrease 
the presence of unwanted high frequencies. When you are using the 
Parametric EQ window to build a low-pass filter, only one parameter 
is available: cutoff frequency. 

Adjusting Parametric EQ 
Parametric EQ can be applied to a selection or the entire soundfile. EQ 
may be applied to either channel or both channels of a stereo file. 
Multiple EQ passes may be made on a single soundfile if one filter type 
will not suffice. 

To use the Parametric EQ functions: 

• Make sure that the soundfile you wish to equalize is open, 
then choose the Parametric EQ command. The Parametric EQ 
window will appear. 
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The Parametric EQ window 

• Use the "Soundfile" pop-up menu to select the soundfile (or 
selection) to equalize. 

• Oick on the button corresponding to the channel(s) whose EQ 
parameters you wish to adjust (left, right or both). The right 
and left channels can each have different settings. 

• Oick on the icon for the type of filter you desire. 

• Adjust the volume of the soundfile by dragging the Vol fader 
up or down. This is your actual input volume setting. If you 
are boosting overall power, or leaving power approximately 
the same, you should decrease the input volume so the output 
does not clip. Hold down the Option key before you drag for 
higher resolution on the slider. 
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• Adjust the parameters of the EQ filter to your liking. To do 
this, you can either type values into the text boxes, or drag the 
corresponding mini-faders. 

•Watch the filter response window to see your filter perfor­
mance. This window is actually performing a real time FFf 
analysis that shows you the true performance of your filter. 

•Use Bypass and Preview to audition the EQ. Use Process to 
apply the EQ destructively and select Use for playback to apply 
it non-destructively whenever playback from hard disk occurs. 
These parameters are documented earlier in this chapter under 
"Common DSP Functions." 

Saving the Parametric EQ Settings 
EQ settings can be saved with the Sound Designer II application, or 
with individual soundfiles. This does not apply the EQ settings 
destructively to the file. 

To save the EQ setting with the soundfile: 

• Oick on the Settings button. The Settings dialog will appear. 

Settings In: Sound Designer 11 ... 
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The Settings dialog 
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• Click on the Sound File button. An open dialog will appear, 
allowing you to select a soundfile where the EQ will be saved. 

• Type in a name for the EQ, then dick on the Save As button. 

Settings you might use for a variety of sessions can also be saved with 
the Sound Designer II application. 

To save the EQ settings with the Sound Designer II application: 

•Click on the Settings button. The Settings dialog will appear. 

• Click on the Application button. An open dialog will appear, 
allowing you to choose a name for the current settings. 

• Type in a name for the EQ, then click on the Save As button. 

Restoring Parametric EQ Settings 
Use the same basic procedure to retrieve a previously-saved EQ 
setting. 

To retrieve a saved EQ setting: 

•Click on the Settings button. The Settings dialog will appear. 

• Choose the source of the EQ (Application or Sound File), 

• Select the EQ, by name and click on the Open button. 

NOfE: Previously-saved EQ settings can also be deleted by clicking 
Delete instead of Open. 

NOfE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 
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Graphic EQ 

Like Parametric EQ Sound Designer II's Graphic EQ emulates its 
hardware counterpart. Graphic EQ allows you to alter the overall 
equalization curve of any sampled sound. Graphic EQ can also be used 
destructively or non-destructively. Destructively altering sample data 
would be used for sounds destined for digital samplers. Non-destruc­
tive EQ is used for real-time equalized playback of hard disk record­
ings where permanent changes to the sample data are not desired. 

The Programmable Graphic EQ window offers ten bands of Graphic 
EQ for mono soundfiles, and five bands of Graphic EQ per channel for 
stereo soundfiles. Each band is set to boost or cut a specific frequency 
and bandwidth in the soundfile's harmonic spectrum. Unlike the 
Parametric EQ the Graphic EQ allows you to create several peaks or 
notches at one time. Since the frequency and bandwidth of each band 
can be adjusted, you can think of it as a 5-band Parametric EQ. The 
trade off here is that the Graphic EQ offers no real-time FFf analysis 
tools, and only gain can be adjusted during realtime previewing. 

To use the Graphic equalization functions: 

• Make sure that the soundfile you wish to equalize is open. 

• Choose the Graphic EQ command in the DSP menu. The 
Programmable Graphic EQ window will appear. 
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Soundfile: Radio RemlH 
QLeft 

Channel(s): O Right 
@Both 

·==· 

O.OdB 0 dB -1 dB OdB 2dB 4dB 

Vol 125 250 500 1.0 3.0 

r.81 Use for plnybnck 
( Preuiew J ( Flot ) (Process) [Settings) D Bypass 

The Graphic EQ window 

•Use the Soundfile pop-up to select the soundfile (or selection) to 
equalize. 

• Gick on the button corresponding to the channel(s) whose EQ 
parameters you wish to adjust (left, right, or both). Left and 
right channels can have different EQ curves. 

• Adjust the input volume of the soundfile you're previewing by 
dragging the Vol fader up or down. 

• Adjust the level of each frequency band to your liking by 
dragging each single band fader up or down. Alternately, you 
can drag across the entire fader display to create the EQ curve 
you want. Use Bypass and Preview to audition your changes as 
described earlier in this chapter under "Common DSP Func­
tions". Hold down the Option key before you drag the slider 
for higher resolution. 
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IMPORTANT 

• Oick on the Flat button if you wish to set all boost/ cut values 
to zero. 

• Double-click on the number below any fader to alter the 
frequency or bandwidth. A dialog appears. Simply enter the 
desired value(s) and click on OK. 

• Use Process to apply the EQ destructively or select Use for 
playback to apply it non-destructively whenever playback from 
hard disk occurs. These parameters are documented earlier in 
this chapter under "Common DSP Functions." 

NOTE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 

Dynamics 

Sound Designer II' s Dynamics functions allow you to control the 
dynamic characteristics of soundfiles by manipulating the ratios of 
their overall loudness and softness. Like its digital EQ functions, 
Sound Designer II' s Dynamics functions can operate destructively and 
non-destructively. 

Sound Designer II provides you with three types of dynamic effects: a 
Compressor /Limiter, an Expander, and a Noise Gate. 

Compressor/Limiter. In simple terms, the Compressor /Limiter 
reduces a soundfile's dynamic range by decreasing the volume of loud 
(high level) signals. It is useful in cases where your soundfile has a 
very wide range of dynamics (both very loud and very soft sections) 
and you wish to "average" its overall volume. 
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Expander. The expander's function is the opposite of that of the 
compressor /limiter: It increases the dynamic range of a soundfile by 
making soft sections softer. 

Noise Gate. The Noise Gate's function is to "gate" or cut off audio 
signals that fall below a user-selectable threshold. It is typically used to 
reduce residual noise in a soundfile. 

Common Dynamic Functions 
The Compressor /Limiter, Expander, and Noise Gate all share a 
common window and similar controls. 

Input. As its name suggests, the Input fader allows you to change the 
input value of your soundfile's signal. It has a minimum value of-60 
dB (very little signal input) and a maximum value of 0 dB (full signal 
input). 

Detection. The Detection fader allows you to choose how Sound 
Designer II detects whether or not the soundfile' s signal goes over the 
level set in the threshold parameter. With peak detection, Sound 
Designer II looks at the value of individual samples as they are played 
back; in average detection it looks at the average energy of the signal 
over several milliseconds. The latter method is more similar to the way 
that the human ear measures sound. The fader allows you to use either 
method, or a variable mix of both. 

Threshold. The Threshold fader adjusts the dB level at which the 
Dynamic effect takes place. For instance, if you set the fader to -35 dB, 
any signal below* -35 dB would be affected. It has a minimum value of 
-60 dB (almost all signals will be processed) and a maximum value of 0 
dB (no signals will be processed). 

*NOTE: The Compressor /Limiter will affect all signals above the 
threshold. 

Attack. The Attack fader adjusts the amount of time it takes in millisec­
onds before the Dynamic effect becomes fully active. It basically has a 
smoothing effect on the processing. The fader has a minimum value of 
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0.00 ms and a maximum value of 100.00 ms. Greater values will 
lengthen the reaction time of the detection mechanism and hence 
lessen the overall dynamic effect applied. 

Release. The Release fader adjusts the amount of time it takes in 
milliseconds before the dynamic processing dies away. Again it has the 
effect of smoothing the transition between processed and non-pro­
cessed signals. It has a minimum value of 0.00 seconds and a maxi­
mum value of 20.00 seconds. Greater values will lengthen the amount 
of time it takes for the signal to return to its unprocessed state and 
hence smooth dramatic changes. 

Ratio. The Ratio fader adjusts the overall amount of the Dynamic effect 
applied to a soundfile. In compression, a ratio of 13:1 would mean that 
each 13 dB increase in input would yield only 1 dB increase in output. 
Greater values decrease the overall dynamic range of a soundfile. The 
opposite is true of expansion-an expansion ratio of 1:6 would yield 6 
dB increase in output for every 1 dB increase in input. Greater values 
increase the overall dynamic range of a soundfile. (Ratio is not appli­
cable to the Noise Gate.) 

Output. As its name suggests, the Output fader allows you to adjust 
the output of your soundfile's signal. It has a minimum value of -60 dB 
and a maximum value of 26 dB. 

Using Dynamics Effects 
All of Sound Designer H's Dynamics DSP effects are controlled from a 
common window. 

To use the dynamic effects: 

• Make sure that the soundfile you wish to process is open, then 
choose the Dynamics command from the DSP menu. The 
Dynamics window will appear. 
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D namics 

Soundfile: I Multimedia Fanfare I 
-60-~ -15 -8 -6 -4 -2 0 

Function: ® Compressor/Limiter O EHpander O No.ise 6ete 

Avg Slow Slo'W oo:t Max 

Min PHI< Lo"W hst Fast 1 :I Min 

Input Detect Thresh. Attack Release Rntio Output 
OdB OdB 0.00 ms 1.00 sec 3.00:1 0.00 d8 

(Preuiew) (Process) D Bypass D Use for playback 

The Dynamics window 

• Click on the button corresponding to the desired function: 
Compressor/Limiter, Expander, or Noise Gate. 

• Use the Soundfile pop-up menu to select the soundfile (or 
selection) to process. 

• Adjust the parameters of the effect by dragging the sliders. Use 
the Preview and Bypass options to help audition your changes 
as described earlier in this chapter under "Common DSP 
Functions". Hold down the Option key before dragging the 
slider for higher resolution. 

• Use Process to apply the effect destructively or select Use for 
playback to apply it non-destructively. These parameters are 
documented earlier in this chapter under "Common DSP 
Functions." 
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IMPORTANT 
NOTE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 

FFT Analysis 

FFf analysis is the process of using the Fast Fourier Transform to 
determine the frequency spectrum of a sampled sound. The transform 
is able to look at any sampled sound and figure out what sine waves 
make up that sound, and how the presence of those sine waves 
changes over time. The results of FFf analysis are commonly dis­
played on a 3-D (XYZ) graph with frequency, amplitude, and time 
along the three respective axes. 

The ability to examine the frequency spectrum of a sound can aid in 
many sound design tasks. In particular, knowing the frequency 
content of a soundfile can give you important insight into its EQ 
requirements. 

To use Sound Designer H's FFf analysis tools, you'll need to familiar­
ize yourself with two separate commands. The Setup menu's Frequency 
Plot ... command is used to set all of the characteristics of the FFf 
display, and the DSP menu's Frequency Analysis command actually 
generates the FFf display. Each of these commands is explained 
below. 

Frequency Analysis Setup 
Although the actual FFf analysis is shown in an FFT window, the 
characteristics of the window are adjusted using the Frequency Plot ... 
command in the Setup menu. The FFf setup dialog has a number of 
parameters that each have a number of options. 
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Bands. The Bands: box allows you to choose how many frequency 
bands will be used to display the plot. When you choose a higher 
number of bands, you increase the density of frequency resolution, 
thereby generating more displayed frequencies and smoother lines. 
Remember that more bands require more time to compute and display. 

Frequency Range. Sound Designer II lets you select the range of 
frequencies that will be included in the FFT analysis. With All selected, 
the FFf analysis shows all detected frequencies from under 20 Hz to 
over 20 kHz. This gives you an overall snapshot of the sound, but 
misses much of the intricate information. (Many sounds don't have 
much frequency energy above 3 kHz.) By selecting a specific range of 
bands to view, you can zoom in and view fewer frequencies at a higher 
resolution. 

Amplitude. The amplitudes can be viewed on either linear or logarith­
mic scales. The Linear scale shows you actual linear amplitude values, 
which will usually appear more subtle, and average much lower peak 
levels. The Log setting uses a logarithmic amplitude scale that empha­
sizes the slope of amplitude peaks, and generally produces visual 
results closer to what the ear hears. 

Direction. The frequency plot can be displayed either forward or 
backward with regard to perceived screen depth. The backward 
setting shows you time slices beginning with the starting point in the 
back and projecting forward in time toward the front of the display. 
The forward setting shows you time slices beginning with the starting 
point in the front and projecting forward in time toward the back of 
the display. 

Type. There are four different types of FFf displays you can choose. 
Mesh emphasizes amplitudes in both time and frequency domains. 
Time isolates the envelopes of specific frequencies over time. Frequency 
isolates the frequency envelopes of each time slice. Chart shows you 
simple vertical amplitude lines indicating all time and frequency data 
points. 
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Time interval. The time interval determines how much of the wave­
form will be analyzed and displayed. Shorter time intervals show you 
less of a sound's spectral evolution, but with a higher time slice 
density. Longer time intervals display more of the overall sound, but at 
a lower time slice density. 

To set the parameters for FFr analysis: 

• Select the Frequency Plot ... command from the Setup menu. The 
Frequency Plot dialog opens. 

Frequency Analysis Setup 

Bends: ~ O All ®from LJ to [!O 
Amplitude: l Log I Time lnteruel: ~ msec 

Direction: Backward I 
Type: Mesh 

The Frequency Plot dialog 

• Use the Bands: pop-up menu to choose the number of fre­
quency bands you wish to generate for the FFf window. 

• Oick on the All button to view all frequencies OR click on the 
From button and enter the range of frequency bands you wish 
to display. 

• Use the Amplitude: pop-up menu to choose the type of ampli­
tude scale you wish to see in the FFf window. 

• Use the Direction: pop-up menu to choose whether time will be 
displayed front-to-back, or back-to-front. 

• Use the Type: pop-up menu to choose the type of FFf graph 
that will be displayed in the FFf window. 
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• Type in the time interval from the selected soundfile that will 
be displayed. 

• When you have adjusted the frequency analysis settings to 
your liking, dick on the OK button. 

The settings of the Frequency Plot ... dialog are used each time the DSP 
menu's Frequency Analysis command is selected in the DSP menu. They 
can be altered at any time and the current settings are stored with the 
soundfile the next time it is saved. 

3-D Frequency Analysis Display 
The FFT window is useful whenever you need specific information 
about a sound's harmonic structure. In particular, it is a flexible tool 
for diagnosing corrective EQ settings. 

To generate a 3-D FFf analysis of the current soundfile, choose the 
Frequency Analysis command on the DSP menu. An FFT window will 
appear: 

FFT of Microwaue Cots 

Tirnot 

0.00 1.72 3.44 S.16 6.88 8.60 10.32 12.04 13.76 kHz 

The FFT Analysis display 
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The FFT window shows you how the current soundfile' s frequency 
spectrum evolves over time. The X-axis shows the different frequen­
cies, the Y-axis shows the changing amplitude of those frequencies, 
and the Z-axis is time. The specific characteristics of the display 
depend on the settings you have chosen using the Setup menu's 
Frequency Plot ... command. 

Time Compression and Expansion 

Sound Designer 11' s time compression and expansion tools allow you 
to adjust the duration of any sampled sound without changing its 
pitch. This is a particularly important new function for those working 
in audio post-production environments, because it allows sounds to be 
adjusted to specific time or SMPfE durations for synchronization. 
Time compression/ expansion works best when the range of compres­
sion/ expansion is small (less than 20%). Compression or expansion of 
greater than 20% (for speech) or 5% (for music) may result in poor 
sound quality. 

To time-compress or time-expand a soundfile: 

• Open the soundfile you wish to compress or expand. 

• Select the portion of the sound file that you want to compress 
or expand. If no selection is made, the entire file will be 
compressed or expanded. 

• Choose the Time Comp/Expand command on the DSP menu. 
The Time Compression/Expansion window appears. 

Destructive Editing and DSP 125 

II -



126 

Time Compresslon/EHpanslon 

Soundflle: I Uolce Duer (phrase) 

Current Length: 4.44494 

Desired length: I ~00000 
Time Ratio: j 1.12497 I 

secs 

I secs 

Guide Tract: 
Ci) Left 
QRlght 
O Center 

r- Options:-----------------

High Quality ----•D Hccurate length 4 

High Quality D nccurate Timing 1000 

Unpltched D Pitched 5000 

( Compress/EHpand J 

The Time Compression/Expansion window 

• If necessary, use the Soundfile pop-up menu to select the 
soundfile you wish to time-compress or expand. 

• Type the required duration of the processed soundfile in the 
Desired Length box, or enter a ratio between the new length and 
the current length in the Time Ra.tio box. These two values are 
inter-related-changing one will change the other. 

• Select Left or Right, or Center (left + Right) as the ~uide Track 
if you are processing a stereo file. Sound Designer II will 
optimize the time compression process for this track. If you 
are processing stereo music, try using Center. If you have a 
stereo file with different types of audio on each channel (voice 
right, Sound effects left, for example), try using either Left or 
Right as the Guide Track 
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• Use the High Quality/Accurate Length slider to weight this 
parameter towards which of these qualities you wish to give 
priority to in the time compression/ expansion process. 
Weighting the slider towards "High Quality" generally means 
that there will be fewer audio artifacts and better sonic quality. 
Weighting the slider towards "Accurate Length" puts the 
emphasis on compressing/ expanding the time of the soundfile 
to your desired time specification as closely as possible-at the 
possible expense of fidelity. 

• Use the High Quality/Accurate Timing slider to weight this 
parameter towards which of these qualities you wish to give 
priority to in the time compression/ expansion process. 
Weighting the slider towards "High Quality" generally means 
that there will be fewer audio artifacts and better sonic quality. 
Weighting the slider towards "Accurate Timing" puts the 
emphasis on keeping the tempo consistent in rhythmic 
soundfiles such as music. 

• Use the Unpitched/Pitched slider to indicate which type of audio 
you will be processing, Pitched (music or singing), or 
Unpitched (drums, etc.). For speech, a setting somewhere 
between these two extremes will probably work best, though 
as with the other sliders, you should probably experiment to 
find the optimal settings in each case. 

• When you have finished entering all of the parameters, click 
on the Compress/Exparul button to process the sound file. 

If you do not have enough memory left to Undo the compression/ 
expansion, Sound Designer II will display a dialog indicating this and 
allow you to cancel the operation. You may then either increase 
memory allotment or create a copy of the file before processing. 

NOTE: Time compression and expansion produces its best effects on 
speech and other narrow-band material, such as solo instruments. 
Compression or expansion of broad-band music may reveal undesired 
artifacts. 
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IMPORTANT 
The Time Compr~ion/Expansion module requires that the selected 
audio be no shorter than 256 samples in length and no longer than 3 
minutes in length-before or after proc~ing. The smallest time ratio 
allowed for Time Compression/Expansion is 0.5. The largest time 
ratio allowed is 2.0. 

It is generally better to do several smaller ration passes on a soundfile 
than to try to do one large ratio pass. 

NOTE: Normalizing a selection before Time Compressing/Expanding 
it can sometimes help produce better sounding results. 

Pitch Shift 

Sound Designer 11' s Pitch Shift function allows you to adjust the pitch 
of any sampled sound with or without changing its duration. This is a 
very powerful function which essentially allows sounds to be trans­
posed a full octave up or down in pitch without altering playback 
speed. Like Time Compression/Expansion, this feature yields the best 
results when the range of transposition is relatively small (less than 4 
semitones). Pitch shifts of greater than 4 semitones (speech) or 1 
semitone (music) may result in poor sound quality. 

To use Sound Designer II's Pitch Shift function: 

• Open the soundfile you wish to pitch shift. 

• Select the portion of the sound file that you want to transpose. 
If no selection is made, the entire file's pitch will be shifted. 

• Choose the Pitch Shift command in the DSP menu. This opens 
the Pitch Shift window. 
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•l Pitch Shift 

Soundflle: I I ®Left 
Uocal FIH Gulde Tracie: O Right 

Fundamental Frequency: 55 Hz 0 Center 

Tuning Reference: Pitch Shift: 
181 Time Correction 

~ Coarse Fine 

+ t 
TC Ratio: 1.015 

~~=~·= l 440.00 I 
Note: I R4 I (Process) 

(Master Tune) LI ~ (Preulew) 
Semitones Cents 

The Pitch Shift window 

• If necessary, use the Soundfile pop-up menu to select the 
soundfile you wish to pitch-shift. Sound Designer II will 
automatically display the fundamental frequency of the 
selected soundfile. 

• Select the Guide Track option if you are processing a stereo file. 
Sound Designer II will optimize the pitch shifting for this 
channel. 

• Check the Time Correction box if you do not want the time 
duration to change. This function utilizes the Time Compres­
sion/Expansion module's current settings, so make sure that 
they are set appropriately for the type of audio you are pro­
cessing (pitched/unpitched, etc.). 

• Adjust the pitch by dragging either of the two faders, or by 
typing values in the boxes below them The Coarse slider 
transposes in semitones (half steps); the Fine slider transposes 
in cents. 
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Although you may select time correction in this window, it is not 
available in Preview mode because of the extremely complex DSP 
calculations required for its implementation. 

• If you find a pitch shift setting you wish to make permanently to the 
soundfile, click on the Process button. 

The Pitch Shift window provides a simple tuning reference. Oick on 
the speaker icon to hear the reference tone. To change this tone, enter a 
new value or click on the pop-up Note menu, drag the mouse along the 
miniature keyboard, and let go at the desired note. It is possible to tune 
this reference tone by clicking the master tune button and dragging the 
fader, or by typing values into the box. Finer adjustments can be made 
by holding the option key while dragging the fader. 

By clicking the time correction check box you have the option of 
enabling or disabling time correction. If time correction is disabled, 
playback speed will increase proportionally as the soundfile is trans­
posed up in pitch and decrease proportionally as it is transposed down 
in pitch. 

Summary 

This chapter has covered most of Sound Designer H's destructive 
editing and DSP functions. The next chapter explores using Sound 
Designer II to edit files for use with digital samplers. 
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Working with Samplers 
and Sample Editing 

Introduction 

In addition to hard disk recording, the Sound Designer II software 
provides sample editing for many popular digital samplers. 

Sound Designer II allows you to edit and audition samples before 
sending them to a sampler, however it is generally a good idea to 
transmit the sounds to the sampler and audition them on the sampler 
itself before you sinish your editing session. Sound Designer II re­
quires a standard MIDI interface in order to communicate with an 
external MIDI sampler. 

Connecting the MIDI Interface and Samplers 

Everybody's work environment is unique, and for this reason your 
particular MIDI setup may differ from that of another user. Although 
you may be using a more complex MIDI setup, here is an illustration of 
the bare basics of a working MIDI chain: 
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~~ 

IN 
O OD .....__ _ ____. 

DO 

MIDI Sound Module 

MIDI IN 

OUT OUT 

I MIDI Interface 
IN 

I 

MIDI Controller 

To Modem or 
Printer port 

I 
MIDI OUT 

A basic MIDI chain 

D 
Macintosh 

NOTE: If you have a hardware MIDI patch bay, it should be inserted 
into your MIDI chain between your MIDI interface, and all of your 
sampling devices. Be aware that some MIDI patch bays may cause 
intermittent communication problems with some samplers. 

Configuring Sound Designer II for MIDI 

To configure Sound Designer II for your MIDI setup: 

• Choose the MIDI Interface ... command in the Setup menu. The 
MIDI Interface dialog appears. 
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Select Serial Port(I): Interface 
Clock Rate: 

~ 
Q500KHz 

181 Modem Port @) 1MHz OMIDI Thru 
Q2MHz 

~ 
Q500KHz 

O Printer Port @) 1MHz 0MIDI Thru 
02MHz 

QD 

The stamlard MIDI Interface dialog 

NOTE: If you are using MIDI Manager, the following dialog will 
appear instead: 

Select MIDI Interface Clock Rates: 

rw1 ~ 0 500KHZ ® 1 MHz 0 2MHz 

l~I 0 500KHz ® 1 MHz O 2MHz 

( OK J 

The MIDI Manager interface dialog 

• Check the box in front of each serial port (Modem and/ or 
Printer) that you plan to connect to your MIDI Interface. 

• Oick the radio button in front of the clock rate that corre­
sponds to that of your MIDI interface. This will generally be 1 
MHz, but you should check your interface's manual for 
specific information. 

• Check the MIDI Thru box for each interface if you want it to 
retransmit incoming MIDI data back out of the MIDI output. 

Working with Samlers and Sample Editing 135 

II -



136 

• Oick the OK button when you are done. 

NOfE: If the serial port you wish to use for MIDI is in use by 
Appletalk, you must first "release" it by selecting Chooser from the ti 
menu, and clicking Appletalk's Off button. Similarly, any other pro­
gram or driver using a port intended for MIDI must release the port. 
See the documentation of any applicable programs. 

Defining Your Samplers 

Sound Designer II allows you to have multiple samplers connected to 
your Macintosh simultaneously. Without touching any hardware, you 
can select each sampler as the source or the destination for a sampled 
soundfile. Before you can send and receive sampled sounds, you will 
need to add those samplers to your personal sampler list. 

To configure Sound Designer II for your samplers: 

• Choose the Sampler ... command on the Setup menu. The 
Sampler dialog box appears. 
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Samplers: Port: Format: 

Akal S1000 (SCSI) #I 

~ 
®Modern D~IOI . O Printer osc~• 

Roland S-550 # 1 181 RS-422 

~ Deuice ID: D 
( Rdd ) (Delete J SCSI ID: ~ 

( OK ) 

The Sampler dialog 

• Oick the Add button to show a list of supported samplers. The 
Add Samplers dialog appears. 

Select a Sampler: 

11 111 

AkeiS900/S950 
Akai 51000 (SCSI) 
Casio FZ-1 /FZ-1 OM 
E-mu EmoH 
E-mu EmBH II 
E-mu Emulator 11 
E-mu Emulator 111 

( Open J 

(Cancel J 

The Add Samplers dialog 

• Select the name of the sampler you wish to add to your 
personal communication list. 
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• Oick the Open button. You will be returned to the original 
Sampler ... dialog box. The name of the selected sampler will be 
added to the Samplers list. 

• While the sampler is still selected, click the button in front of 
the correct port (Modem or Printer) and communication format 
(MIDI, SCSI, or RS-122) that describes the new sampler. 

• While the sampler is still selected, type in a Device ID or SCSI 
ID for the new sampler. Generally your device ID will be the 
sampler's send and receive MIDI channel. However, unlike 
MIDI channel settings, system exclusive standards allow more 
than 16 device IDs. SCSI ID is the SCSI device number of a 
SCSI-equipped sampler. Consult your sampler's manual for 
more information. 

• When all of your samplers appear in the Samplers box and are 
configured properly, click OK. 

More than one of the same type of sampler may be connected at the 
same time, but make sure that no two samplers have the same commu­
nications settings and device numbers. Remember, you can change the 
setting of any sampler by selecting it and adjusting the settings as you 
desire. However, some samplers will not allow you to adjust their 
device ID number. 

Sending and Receiving Samples 

Once you have configured Sound Designer II and added your 
sampler(s) to your personal sampler list, you are ready to send and 
receive sounds. 

To receive a sound from a sampler: 

• Select the source sampler from the list displayed when you 
choose the Sampler ... command on the Setup menu. 
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• Choose the Sampler->Mac command on the File menu. 

• Select the sound you wish to retrieve from the sampler. Once 
again, each sampler has different communications abilities, so 
these functions will vary from sampler to sampler. 

• Oick the OK button to retrieve the sound. When the entire 
sound has been received, it will appear in a new Soundfile 
Window. 

To send a sound to a sampler: 

• Open the soundfile using the File menu's Open ... command. 

• Select the destination sampler from the list displayed when 
you choose the Sampler ... command on the Setup menu. 

• Choose the Mac->Sampler command on the File menu, or click 
on the Mac-to-Sampler icon. A dialog box similar to this will 
appear: 

Mac -> Sampler Fiie Transfer 

Send: Mnc File: Uoice Duer Femnle 2 

Length: 3968 

To: [Q]Sound: D 
lQJLength: Juicy Splat 

[ Cancel 

The Mac->Sampler dialog 
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• Set the destination characteristics (sample ID number, channel, 
etc.) for the sound you're sending. Each sampler uses different 
terminology, and has different communications abilities, so 
these functions will vary from sampler to sampler. 

• Oick on the OK button to begin the transfer. 

Looping 

El 
All of the destructive editing techniques and Soundfile Window 
features discussed earlier in this manual can be applied during sample 
editing. 

Sound Designer II employs a number of looping tools and functions 
that greatly simplify the creation of smooth loops. Although most 
sampling devices are capable of one or two loops, some can play back 
up to eight loops in a single soundfile. To facilitate this, Sound De­
signer II allows you to create an unlimited number of loops in any file. 

Because of this multiple-loop capability, you'll need to remember that 
loop number 1 is always the sustain loop, and loop number 2 is always 
the release loop. Your sampler will only receive the number of loops it 
can play back. The same limitations are imposed for the two loop types 
that are available within Sound Designer II' s loop environment. 
Although any loop can be created as a forward or forward/backward 
loop, only certain sampling devices are capable of playing forward/ 
backward loops. You may want to consult your sampler's manual for 
specific information on its looping capabilities. 

Remember these import ruyles when you are creating and playing 
back loops with Sound Designer II: 
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• A loop must fit in memory, therefore loops that are more than 
several seconds in length will not play back on the Mac. 

• The Direct from disk option must be turned off for a loop to play 
back (see the Setup menu's Sound Playback ... command). 

• Loop points will always be the same across all channels of a 
stereo sound file. 

• Original Sound Designer format files (not Sound Designer II) 
will only save loops 1 and 2 regardless of the number of loops 
you have created. 

Creating a New Loop 

To create a loop in Sound Designer II: 

• Oick on the Loop Start Marker icon. The mouse cursor will 
change to a Loop Start cursor whenever it is positioned over 
the waveform that you're editing. 

• Oick the Loop Start cursor at the desired loop start point 
within the waveform. A loop start marker with the number 1 
will appear. 

• Select the Loop End Marker icon. The mouse cursor will 
change to a Loop End cursor whenever it is positioned over 
the waveform that you're editing. 

• Oick the Loop End cursor at the desired loop end point within 
the waveform. A loop end marker with the number 1 will 
appear at the bottom of the waveform display, along the time 
line. 
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You have now created a working sustain loop. To listen to it, switch to 
selection mode (using the Range Select icon), and hold down the 
Speaker icon. Unless you are extremely lucky, you'll probably find that 
your loop is far from perfect. 

If the timbre of your loop changes radically at the loop splice point, 
you'll probably want to try new loop points. The simplest way to edit 
an existing loop is to drag its loop markers to a new position in the 
Soundfile Window. 

Using the Loop Window 

If the loop is basically good, but is marked by clicks, pops, volume 
bumps, or a slight timbral bump across the splice, you can probably fix 
it using Sound Designer's Loop window. The Loop window is de­
signed to fine-tune basic loops that you've already created using the 
Loop Start and Loop End icons. 

NOTE: The Loop window cannot be activated unless both Loop Start 
and Loop End markers have been defined. 

To open the Loop window: 

• Choose Loop from the Tools menu. The Loop window will 
appear. 
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I Loop 1 I I Channel 1 

The Loop window 

The waveform on the left side of the display is the loop end, and the 
waveform on the right is the loop start. The vertical line dividing them 
is the loop splice point, where playback jumps from loop end to loop 
start. 

If you want to create a high-quality loop, you must make sure that the 
slopes and general shapes of the waves on both sides match, and the 
transition at the splice point is smooth. Here are brief explanations of 
the Sound Designer II Loop window tools that can help you to build a 
quality loop: 

Speaker button 
Click and hold the mouse pointer on the Loop window's Speaker 
buttonto hear the loop played back. 

Display Scale Arrows 
These arrows adjust the resolution (zoom) of the Loop window's 
waveform display. They function in exactly the same way as the 
Soundfile Window's View Adjustment Arrows: only the view is 
adjusted, not the sample data. 
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Crossfade button 
The Crossfade button is one of Sound Designer 11' s most important 
looping tools. Click on it to open this dialog box: 

Crossfede Looping 

tro11fade Type: @) Linear 
O Equal Power 

Loop Type: @Forward 
O Backward/Forward 

MaHimum Length: 41122 Samples 

Crossfode Length: 1141122 I Samples 

Cancel (Continue) 

The Crossfade Looping dialog 

The Crossfade Looping dialog allows you to design and execute a 
crossfade loop. Crossfade looping is a sample editing technique that 
uses a sound's own natural waveform evolution to "smooth over" the 
loop splice point. 

Essentially, Sound Designer 11' s crossfade looping takes a copy of the 
loop end waveform and crossfades 50% of it with 50% of the loop start 
waveform. Then it takes the original loop start waveform and 
crossfades 50% of it with 50% of the loop end waveform. By doing this, 
it ensures that the loop end and loop start waveforms match, although 
neither has been radically changed. 

In order to ensure that all transitions play back smoothly, including 
those before the loop start and after the loop end, the crossfades are 
centered right over the loop start and end points. The length of the 
crossfade determines how much waveform on either side of the loop 
points will be involved in the crossfade. For this reason, crossfade 
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length must be shorter than the total length of the loop, shorter than 
the length of waveform between sound beginning and loop start, and 
shorter than the length of waveform between loop end and sound end. 

Linear uses flat (linear) crossfade curves, and is better for most applica­
tions. Equal Power uses a non-linear fade curve which may be of use if 
you find that the center of your crossfade areas drop in volume. 

The Crossfade Loop dialog supports both Forward and Forward/ 
Backward loops. Most samplers employ Forward loops. Consult your 
sampler manual to determine if it can play back Forward/Backward 
loops. 

To execute a crossfade loop: 

• Oick on the Loop window's Crossfade icon. The Crossfade 
Looping dialog will appear. 

• Oick on the button in front of the desired crossfade type. 

• Oick on the button in front of the type of loop you're creating. 

• Type in a value in the Crossfade Length box if you want a 
setting other than the default maximum length. (The maxi­
mum length is indicated in the dialog.) Generally speaking, the 
maximum crossfade length will produce the best results. 

• Oick on the Continue button to execute the crossfade. 

NOTE: It is generally a good idea to create the best possible loop 
before resorting to crossfade looping. For more information on creating 
good loops easily, see the description of the AUTO arrows. 

Information button. Clicking the Info button opens a dialog box that 
tells you all of the pertinent information about the loop you're cur­
rently working on. In the dialog box you'll find the name of the 
soundfile, the current channel number, the loop number, the loop start 

Working with Samlers and Sample Editing 145 

Ill 



146 

and end positions, and the loop type. If you wish, you can use this 
dialog to change loop start and end positions, and loop type. When 
you are done editing or viewing the information, click the OK button 
(to make changes), or the Cancel button to abort. 

Pop-up loop selection menu. The number of the loop you're editing is 
always indicated across from the icons at the top of the Loop window. 
To edit a different loop, click and hold on the loop number box. A pop­
up menu will appear and you can select another loop to edit by 
choosing its number and letting go of the mouse button. Remember, 
only loops that have both a defined start and a defined end point will 
appear. 

Pop-up channel selection menu. The number of the channel you're 
seeing in the Loop window is always indicated to the right of the loop 
number. To see how the same loop affects a different channel, click and 
hold on the channel box. A pop-up menu will appear and you can 
select another channel to view. Remember, loops are always the same 
from channel to channel, so you can't adjust a loop point in one 
channel, without adjusting it in all other channels. 

Left and right scroll arrows. The left and right scroll arrows located 
below the loop end and loop start waveforms are used to move the 
actual loop points from within the Loop window. The left arrows 
move the loop points toward the soundfile beginning, and the right 
arrows move the loop points toward the soundfile end. 

SHORTCUT: To bring any displayed waveform spot to the splice 
point, just click on that waveform spot in the Loop window's wave­
form displays. 

Left and right AUTO arrows. The left and right AUTO arrows are 
particularly useful loop point positioning tools. Rather than just sliding 
the loop points to the right or left in small increments, the AUTO 
arrows automatically move the loop point to the next point that 
preserves both the value and the slope of the splice. If you're adjusting 
the loop end, the AUTO arrow matches the loop start. If you're adjust­
ing the loop start, the AUTO arrow matches the loop end. For this 
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reason, you can almost be assured of the best possible loop transition if 
you adjust your loops with the AUTO arrows. 

NOTE: Some sounds with an extreme amount of harmonic evolution 
will simply not have any acceptable natural looping points. These 
sounds are prime candidates for crossfade looping methods. 

Deleting Loops 
It's easy to remove a loop at any time if necessary. 

To delete a loop: 

•Make sure you're looking at the Soundfile Window. 

• Drag the loop start and loop end markers you wish to delete to 
Sound Designer II' s Trash. This will delete the loop perma­
nently. 

Summary 

This chapter has covered the basic functions associated with sending, 
receiving, and looping files in conjunction with digital samplers. The 
next chapter describes how to synchronize Sound Designer II to 
SMPTE time code. 
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Working with SMPTE 

Introduction 

This chapter covers the basics of using Sound Tools II with SMPTE and 
explains the commands and functions needed to achieve proper and 
accurate synchronization of Sound Tools II to an external source. If 
you are unfamiliar with SMPTE or with the principles of synchroniz­
ation, please refer to the Appendix of this manual. There you will find 
an explanation of SMPTE and SMPTE frame rates as well as instruc­
tions for setting up your Sound Tools II system to properly synchro­
nize with SMPTE. 

Sound Designer II and the Macintosh only understand MIDI time 
code (MTC), which is the MIDI version of SMPTE time code. SMPTE is 
an analog signal, and MTC is a digital signal. Therefore, you cannot 
feed standard SMPTE signals directly into your Mac for synchroniza­
tion. You need a SMPTE to MTC converter (such as Opcode System's 
Studio 3, JL Cooper's PPS-1, etc.) to allow your computer to under­
stand SMPTE. For more information about SMPTE and MTC, see the 
Appendix. 
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Preparing your System 

Before you proceed, your Sound Tools II system should be properly 
connected with your external synchronization devices. If you haven't 
made the appropriate connections, do so now by referring to the 
following illustrations. These show two possible setups for synchro­
nizing Sound Tools II to video tape. The first setup utilizes Sound 
Designer II's Continuous SMPTE Sync feature to achieve synchroniza­
tion. The second setup utilizes Digidesign's Video Slave Driver (avail­
able separately). 

Setup A 

II I CDODOD 

_ Video Tape Recorder 

SMPTE f OR ~ vrrc Video out 

VITC to MIDI Time 
Code Convertor 

Video out Composite I I MID/Tims 
Cods out 

To Printer or 
Modsmport 

D g 
RGB Monitor Macintosh 

(Continuous SMPTE resync on) 

Audio Interface 

Synchronizing with Continuous SMPTE Sync 
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Setup B 

Blackhurst Generator To video sync input 

1

._I ____ I ca::JDD 

.__ ___ _,,,.,...__•_•_• __ I Video Tape Recorder 

vL1ave on- I I 
=rt ;_T JT al):J tsMPTE OR t VITCVidooout 

/_ VITC to MIDI Time 
Audio I nteiiace Code Convertor 

!
MIDI Tims 
Code out 

To PrintBf or 
Modem port 

!c:=:~ 

______ o g 
Macintosh RGB Monitor 

(Continuous SMPTE resync off) 

Synchronizing with the Video Slave Driver 

Choosing a SMPTE Frame Rate 

Your first task in preparing Sound Tools II for synchronization is 
choosing a SMPTE frame rate 

SMPTE Fonnats 
Sound Tools II supports all current SMPTE frame rates. These rates 
are: 24 frames per second (FPS), for film; 25 FPS for P AL/SECAM 
video; 29.97 FPS for NTSC color video; 29.97 drop FPS for wall-clock 
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accurate broadcast NTSC color video; and 30 FPS that is generally used 
only for time stamping synchronization in audio-only applications. 
Make sure that you know without a doubt which of these formats your 
project's tape has been striped with before you begin your session. A 
little extra care up front is always preferable to hours spent redoing 
work later. 

To choose a SMPTE format: 

' 
• Select Set Current Time ... from the Setup menu. This dialog 

appears (if the menu item is disabled, click in the waveform 
display to create an insertion point instead of a selection): 

The Insertion point Is at: 

SMPTE Feet + Frames Bars/Beats 

I 00:00:01.13 I 2 + n 

Q 24 FPS 0 16 mm Time Sig.: 

EJ1 EJ 025 FPS ®35 mm 
030 FPS Drop 
®30 FPS ND Tempo: 
0 29.97 FPS ND I 120.000 

(Capture J OK 

The Set Current Time ... dialog 

• Select the SMPTE frame format appropriate to your session. 

• OickOK. 
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Displaying Time in SMPTE Frames 

The next step in preparing Sound Tools II for synchronization is setting 
the Time Scale to SMPTE. Though Sound Designer II will still syn­
chronize to incoming SMPrE time code if the Time Scale is displayed 
in other formats (such as Hr:Min:SecMsec), it is obviously more useful 
to use SMPTE frames as your reference. 

Setting the Time Scale to SMPTE frames: 

• From the Setup menu, choose Scale Marks ... This dialog ap­
pears: 

• Select SMPTE. 

• OickOK. 

Select Weueform Scales: 

Uertlcel Scales: 

® Percent Full Scale 
O Quantized Sample Uelue 

Horizontal Scales: 

QTime 
0 Hr.Mln:Sec.Msec 
O Dec1111el Semple Number 
0 HeH Semple Number 
®SMPlE 
O Feet+Fremes 
O Bers I Beets 

The Scale Marks .. dialog 

Alternately, you can hold down the Option key and click on the Time 
Scale to bring up this pop-up menu: 
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Time 
Hr:Min:Sec.Msec 
Sample Numbers 
HeH Sample Numbers 

Option-clicking on the Time Scale brings up this pop-up menu. 

Sound Designer II will now display time in the currently selected 
SMPTE frame rate. 

Choosing a Synchronization Mode 

Your next task is to choose a synchronization mode for your session. 
Sound Tools II provides two types of synchronization: SMPTE Trigger 
and Continuous SMPTE Sync. Each of these has its advantages and 
disadvantages. 

SMPTE Trigger 
SMPTE Trigger is Sound Designer II's default synchronization mode. 
In this mode, when Sound Designer II is placed "on line", the system 
waits for incoming SMPTE to "trigger" or begin playback. When it 
receives SMPTE, it begins playback using only its own internal crystal 
oscillator (which is very stable) to control playback speed. 

Unfortunately, if the playback speed of your master sync source is not 
perfectly stable, there is a potential for trouble witb,this method. 
Sound Tools II's audio will be triggered in perfect sync with the master 

Sound Designer II 



source, but it may not remain in sync because the master source's 
playback speed is fluctuating relative to the crystal oscillator in the 
Audio Interface. If the audio regions triggered with Sound Tools II are 
short (30 seconds or less) there probably won't be a noticeable prob­
lem. But if they are lengthy, the master source and Sound Tools II 
could get farther and farther out of sync as playback progresses. 

Continuous SMPTE Sync 
Continuous SMPTE Sync is Sound Tools II's other synchronization 
mode, and can be enabled in the Sound Playback dialog. In this mode, 
playback of Sound Tools II is also triggered by incoming SMPTE. 
However, in this case, Sound Tools II is constantly looking at incoming 
SMPTE frame numbers and adjusting its playback sample rate to 
compensate for any discrepancies in the timing of the master sync 
source. 

However, just as with Trigger, if your master sync source is very 
unstable, there is a potential for poor results. In this case, the real-time 
sample rate conversion that Sound Tools II must perform in order to 
stay locked with your master source may cause the fidelity of your 
digital audio playback to suffer. This audio degradation can range 
from very subtle to very noticeable, depending on how poor your 
master sync source is. The best way to avoid this type of problem is to 
obtain a rock-solid master sync source. 

NOTE: Because of the DSP processing power required to implement 
the Continuous SMPTE Sync feature, you will not be able to implement 
real time DSP functions such as Graphic EQ and Dynamics. 

A third, better synchronization alternative exists. This technique uses 
SMPTE Trigger but maintains long-term synchronization with the 
Video Slave Driver, available separately from Digidesign. If you are 
involved in professional audio production, Digidesign recommends 
that you use this optional peripheral with your Sound Tools II system 
for professional quality synchronization. 
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The Video Slave Driver 
The Video Slave Driver is a peripheral device for Sound Tools II that 
allows you to calibrate Sound Tools H's recording and playback clock 
to an external video black burst or word clock signal. The Video Slave 
Driver accepts either of these signals and then converts it into a master 
clock signal which it sends to the Audio Interface. By sending the 
same master black burst clock signal to Sound Tools II and your video 
deck, all elements of your system will run at exactly the same speed, 
thereby staying in sync. 

In this case, (SMPTE) Trigger is the method used and SMPTE Time 
Code is only used to locate, chase, and trigger. Playback speed of both 
Sound Tools II and the video tape recorder are then controlled by the 
black burst signal. This technique will produce better audio quality 
than Continuous SMPTE Sync with fluctuating sync signals, and will 
ensure that the Sound Tools II system will remain tightly locked to the 
sync source. 

In summary: 
You have three choices when synchronizing Sound Tools n to an 
external source: 

1) Using Trigger with the optional Sound Tools II Video Slave 
Driver to control Sound Tools Il's recording/playback speed 
(and the master SMPTE source's playback speed) with a black 
burst generator. 

2) Using Trigger by itself (which could result in timing errors if 
you have lengthy audio regions and a very unstable sync 
source). 

3) Using Continuous &sync (which could result in audio degra­
dation if you have a very unstable sync source). 
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To choose a synchronization type: 

• Choose Sound Playback ... from the Setup menu. This dialog 
appears: 

.-- Sound Playback Options -

Gil sound Rcceleretor• .. 

181 Direct from disk 
181 Continuous SMPTE Sync 
0 Use Dither 

O Sound Drluer 

O Sound Manager 

Choosing a sync mode 

• If you wish to use Continuous SMPTE Sync, click its box in this 
dialog. An ''X" indicates that it is enabled. 

• Alternately, if you wish to use SMPTE Trigger, turn off Con­
tinuous SMPTE Sync by clicking and removing the ''X" from 
the Continuous SMPTE Sync box. Sound Tools will default back 
to SMPTE Trigger mode. 

• If you are using Digidesign's Video Slave Driver, make sure 
that Continuous SMPTE Sync is off and refer to your Video 
Slave Driver owner's manual for additional instructions. 
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SMPTE Offset 

The SMPTE Offset ... command is used to compensate for short SMPTE 
offsets associated with some hardware connected in the SMPTE path. 
In a normal working environment, this command will probably never 
be used. However, if you feel that you are experiencing SMPTE offsets 
(either delayed triggering or early triggering), use this feature. 

To choose a SMPTE trigger offset for your session: 

• From the Setup menu, choose SMPTE Setup ... This dialog 
appears: 

SMPTE trigger offset: l~I msec 

(cancel) OK 

Entering a SMPTE Offset 

• Type in a value in milliseconds (between -10 and 10 msec 
should be sufficient). 

• OickOK. 

Putting Sound Tools II On Line 

In order to trigger playback of Sound Tools II from an external source, 
you must put the system on line. In this state, it waits for incoming 
SMPTE frame . When Sound Tools II sees SMPTE time moving 
forward, it will begin audio playback or recording. 
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To put Sound Tools II online: 

• From the Setup menu, choose On-line. A check appears in front 
of the command to indicate on line status. At the same time, 
the large Current Position Indicator box at the upper right of the 
Sound Tools II window will display the current SMPTE frame 
location of your incoming Time Code. 

Or: 

• Oick the Tape Deck icon to make the Record dialog appear. 

• Oick the On line box in this dialog. This method is most often 
used if you plan to trigger Sound Tools II's direct to disk 
recording with SMPI'E (covered later in this chapter). 

Sound Tools II is now on line and waiting for SMPTE time code to 
trigger playback. 

To take Sound Tools II off-line, choose On-line from the Setup menu 
again, or open the Record dialog and click to remove the "X" from the 
On line box. 

NOfE: While Sound Designer II is on line, pressing the Spacebar on 
the keyboard will not cause audio to playback. The system must be off 
line to play audio with either of this method. You can play back by 
clicking the speaker icon or holding down the mouse button in the 
overview. 
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Synchronizing Audio Playback to SMPTE Frame 
Locations 

One of the most common and useful applications of audio synchroni­
zation is its use in audio post production to "spot" or assign music and 
sound cues to specific SMPrE frame locations in a film or video. 
Sound Tools II provides a convenient method for doing this and can 
spot: 

1) Playback of an entire audio file, the start point being defined in 
the main Waveform Display with the Set Current Time ... 
command. 

2) Playback of an entire Playlist, by setting a SMPTE start frame 
for the first region occurring in the Playlist. 

3) Playback of specific regions within a Playlist, by assigning 
specific SMPTE times to each region to be triggered within the 
Playlist. 

By simply identifying a location in your audio file and entering an 
appropriate SMPTE frame number in a dialog box, Sound Designer II 
will then trigger the audio upon receipt of SMPTE time code. 

Though SMPTE frame numbers can be typed into dialog boxes, the 
process is much faster (and less error-prone) if you are using Vertical 
Interval Time Code (VITC). In this case you can immediately "capture" 
a frame location by pushing the Capture button in the dialog. 

NOTE: Be aware that although the Capture button will work with 
Longitudinal Time Code (LTC), frame numbers of a paused frame can 
only be accurately captured with VITC. This is because LTC, being on 
the audio track, is NOT refreshed when a tape is paused or played at 
very slow speeds-such as those used when "crawling" through a 
video to isolate "hit" points. 
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NOTE: When spotting a region, the time entered in the Spot Region ... 
dialog must not be less than or 12 hours greater than the SMPTE start 
time of the playlist itself. 

To spot an entire audio file with SMYfE: 

• Identify the SMPTE frame location where you wish to trigger 
playback of your audio by pausing your video deck on that 
frame. 

• In the Soundfile window, locate the exact spot in the audio file 
that should correspond with the video frame you are paused 
at. 

• Oick the Selector at this spot. 

• From the Setup menu, choose Set Current Time. This dialog 
appears: 

The Insertion point Is at: 

SMPTE Feet • Frames 

1100:00:11.1 o I n • oo 

0 24 FPS 0 16 mm 
0 25 FPS ® 35 mm 
030 FPS Drop 
®30 FPS NO 
0 29.97 FPS ND 

(Capture) OK 

Bars/Beats 

Time Sig.: 

(!]I (!] 
Tempo: 

1120.000 

The Set Current Time dialog 

• Type in the desired SMPTE frame location or Click Capture. 
The current frame's SMPTE number appears in the boxes. 

• OickOK. 
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The audio file is now spotted to the chosen SMPTE frame location. 
When the system is On line, SMPTE will trigger playback of the audio 
file. 

To spot an entire Playlist to a specific SMPTE frame : 

• Identify the SMPTE frame location where you wish to trigger 
playback of your audio by pausing your video deck on that 
frame. 

• In the Playlist window, double click the Start Time box of the 
FIRST region to appear in the Playlist (or choose SMPTE Start 
Time ... from the Playlist menu). 

The Start Time Box 

This dialog appears: 

Set SMPTE Time: 

100:00:10.011. [] 

hr:mn:sc:fr 1 /4 Frm 

OK J (Capture) ( Cancel ) 

The Start Time dialog 
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• Type in the desired SMPTE frame location or Click Capture. 
The current frame's SMPTE number appears in the box. 

• OickOK. 

The Playlist is now spotted to the chosen SMPTE frame location. 
When the system is On line SMPTE will trigger playback of the Playlist. 

NOTE: When the system is on line, the Playlist window's Stop button 
says Play, and incoming SMPTE is indicated in the upper right corner 
of the window. The Playlist will remain this way until SMPTE start 
time code triggers playback of the playlist. 

To spot a single region to a specific SMPTE frame: 

• Identify the SMPTE frame location where you wish to trigger 
playback of your audio by pausing your video deck on that 
frame. 

•In the Playlist window, double click the Start Time box of the 
region you wish to spot. 

• Type in the desired SMPTE frame location or click Capture. The 
current frame's SMPTE number appears in the box. 

• OickOK. 

The region is now spotted to the chosen SMPTE frame location. When 
the system is On line SMPTE time code will trigger playback of the 
region. 

Repeat as necessary for other regions in the Playlist. 
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Unlocking Time Locked Regions 

After you have spotted a region, it automatically becomes "time 
locked" to the specified SMPTE frame and cannot be moved even if 
other regions are added to the Playlist. This is to prevent you from 
inadvertently moving its position in a Playlist. Regions which are time 
locked appear in bold face type in the Playlist to be easily recognized. 

A locked region cannot be moved from its location in the Playlist 
unless you "unlock" it with the Un-Timelock Regions command in the 
Playlist menu. 

Start Ti me ~Region 

.Q.Q.:.9..1:.Q.9. ... 9..Q. ~I~.P. ........................................ . 
00:04:01 .03 Chuctle .................................................................................... 
00:04:01.07 Car Horn .................................................................................... 

A time locked region appears in bold face type 

To unlock a timelocked a region: 

• In the Playlist, click on the region you wish to un-timelock (or 
Shift-click and select multiple regions). 

• From the Playlist menu, choose Un-Timelock Regions. The 
regions are now unlocked and can be moved from their 
current positions. 

NOTE: Simply selecting a region and pressing the Delete key will NOT 
remove the time-lock; it will simply remove the region from the 
Playlist and cause the region following the deleted region to be moved 
down into the locked region's position. 

Sound Designer II 



Triggering Direct to Disk Recording with SMPTE 

Another useful application of SMPTE synchronization is triggering 
direct to disk recording from Sound Tools II. By doing this, music and 
sound cues can be recorded digitally by Sound Tools II in sync with 
the playback of additional material on multi track tape or video. 

To trigger direct to disk recording at a specific SMPTE frame: 

• Identify the SMPTE frame location where you wish to trigger 
Sound Tools H's direct to disk recording. 

• Oick the Tape Deck icon to open Sound Designer's Record 
dialog. This dialog appears: 

Fiie Name: Digital Uocal Ouerdub 

Semple Rete:I 44100 I ~ ~:~:o 
Rec. Source: Rudio Interface Rnalog Input 

Record start: I oo:oo:ll!l!Jll 
Record Stop: I 00:03:24.00 1181 On Line 

Length: 

Current: 

Ruallable: 

Time 

00:00:00.00 

OO:OO:OO.OO D Pre-Rllocnte 

Buffer Size: lel 00:00:28.00 ~ 

••••••• RTZ REW PLAY STOP FF CiiTE REC 

The Record dialog 
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• Make sure that the On Line box is checked. 

• Enter the desired SMPTE start frame location in the Record 
Start box. 

• Enter the desired SMPTE end frame location in the Record Stop 
box. 

•Gick OK. 

When Sound Tools II receives the SMPTE Record Start frame number it 
will begin recording. It will stop recording when it receives the SMPTE 
Record Stop frame number. If no number is entered in the Record Stop 
box, Sound Designer II will only stop recording if you stop it manu­
ally. 

WARNING: If you are using SMPTE to trigger recording in a file that 
already contains audio, be aware that Sound Tools II will begin 
recording at the current playback location in the file. To avoid record­
ing over valuable material, use the Tape Deck dialog's Go to End button 
to navigate to the end of the current audio file before putting your 
system on line. 

Troubleshooting SMPTE 

Making SMPTE synchronization work properly can seem difficult at 
times. Here are some things to look out for when things don't seem to 
be going right. 

(1) Striping SMPTE after music has been recorded 
All tape machines in your setup (both audio and video) absolutely must 
have been striped with SMPTE Time Code before any audio is re­
corded onto them or to the Sound Tools II system. Not doing so is like 
trying to write data on a hard disk without formatting it first. The 
system may seem to work, but synchronization will never properly 
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occur. The machines and Sound Tools II will drift farther and farther 
apart the longer they run. 

The same problem occurs when audio is recorded onto Sound Tools II 
without any SMPTE sync (if, for example, it was recorded before the 
current session). The audio cannot be accurately synchronized with an 
analog tape recorder or video tape deck, since the original audio on the 
Mac was not recorded based on the SMPTE Time Code from the 
analog tape deck or video tape deck. 

(2) Not knowing the actual frame rate on your tape 
You may think this unlikely, but if you get your video tapes from a 
production company instead of recording them yourself, you are at 
their m~rcy as to what SMPfE frame rate is actually used on that tape. 
It may have been incorrectly labeled. Worse, it may be different than 
the frame rate of the SMPTE you have already striped on your audio 
tape! Be absolutely sure you know what SMPTE frame rate is used on 
any material you work. with. 

(3) 29.97 FPS Non-Drop can be difficult 
29.97 FPS Non-Drop is achieved by sending the 30 FPS non-drop time 
code slightly slower. When used with color video, each video frame 
now matches up with each SMPTE frame without having to use a 
drop-frame coding. This makes any frame number mathematics much 
simpler, since no frame numbers are dropped. 

The problem is, many hardware and software devices do not recognize 
this frame rate. The Apple MIDI Manager, for example, still does not 
explicitly recognize it. The user must tell the MIDI Manager to expect 
30 FPS non-drop instead. In fact, most devices that read SMPTE work 
acceptably reading 29.97 non-drop if they are set to expect 30 FPS non­
drop. That is why this format has achieved such popularity. 

Unfortunately, any SMPTE reader that uses the time code numbers to 
make real-time calculations (as Sound Tools II does when it tries to 
trigger and sync to SMPTE) also needs to know that the frame format is 
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29.97 and not 30 FPS. Since Sound Tools Il allows this choice of frame 
rate this does not really pose a problem. The problem exists because 
the user cannot readily distinguish 29.97 from 30 FPS. More impor­
tantly, many production companies will distribute video work prints 
striped with 29.97 FPS but mark them as "30 FPS NTSC", by which they 
actually mean 29.97 FPS. By the time the tape gets to you, you may 
have no idea what's on it. Feeding 29.97 non-drop to Sound Tools II 
when it's set for 30 FPS non-drop will result in timing errors of about 
1.8 frames per minute. 

(4) Appletalk, networks and screen savers cause problems 
These types of software can cause the Macintosh to ignore MIDI data 
(such as MIDI Time Code) coming into its serial ports. The net effect of 
this is that an application (such as Sound Tools II) will appear to lose 
SMPTE lock and sync, and drop in and out of lock repeatedly, every 5 
or 10 seconds. Make sure Appletalk is inactive in the Chooser, discon­
nect Appletalk cables, and remove any INIT-based network software 
from your System folder (QuickMail, Microsoft Mail, AppleShare, TOPS, 
etc.). 

(5) Resolve all components of your system, if possible 
When striping time code, make sure that the time code generator and 
the record deck are resolved to the same crystal reference. For ex­
ample, when striping 29.97 Drop Frame time code onto a VTR, both 
the SMPTE generator and the VTR should be resolved to the same 
''black burst" or house sync generator. During playback, the master 
deck should be resolved to ''black burst" or house sync. This conven­
tion provides compatibility for your tape between the record and 
playback passes, and when it's played back in other facilities on 
different equipment. This also means that when playing back a tape 
striped with time code, the playback deck should be resolved to the 
same sync rate as the record deck was resolved to at the time of the 
striping. 
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(6) Be careful when changing frame rates 
If you change time code rates in the middle of a session, many SMPTE­
to-MIDI Time Code converters need to be turned off and turned on 
again to be able to read the new frame rate correctly. 

(7) Consistent use of clock sources in Sound Tools II 
A soundfile should be played back using the same peripheral and 
sample rate it was recorded with, if at all possible. This assures the 
closest match between record and playback sample rates. For ex­
ample, if an audio file was recorded at 44.1 kHz with the Sound Tools 
II Audio Interface then the Sample Rate should be set to 44.1 kHz 
during playback with the Audio Interface as well. 
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The Fila Menu 

Sound Designer 11' s File menu contains all of the commands you'll use 
to create and maintain your soundfiles. Here are brief explanations of 
each command. 

New... XN 
Open... •o 
Open Resource ... 
Close •w 
Mee -> sampler 
Sampler -> Mee 

Sill'0 :•:S 
Seue e Copy ••• 
Reuer t to Sat•ed 
Delete ••• 

Page Setup ••• 
Print .•• 

&et Info... XI 
lransfel" ... 
Quit acq 

New ... [311] 
The New ... command is used to create a new soundfile from scratch. A 
new (and therefore empty) soundfile is used to record a new hard disk 
recording or as a paste destination for sample data currently on the 
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Clipboard. Choose one of the soundfile formats, mono/ stereo format, 
name the soundfile, and click the New button. Here are brief explana­
tions of the available file formats: 

Sound Designer. The Sound Designer file format is the standard 16-bit 
mono format used by the original Sound Designer program. It is useful 
for file exchange with programs that support only the Sound Designer 
files. 

Sound Designer II Mono. The Sound Designer II file format is a 16-bit 
mono format recommended for use with DECK digital multitrack 
recording software or mono files that require more than 10 markers. A 
mono soundfile not saved in this format will lose all markers above the 
10 supported in the original Sound Designer file format. 

Sound Designer II Stereo. The Sound Designer II file format is the 
default 16-bit stereo format employed by this program. It is the recom­
mended stereo recording file format. 

AIFF. The AIFF file format is Apple's Audio Interchange File Format, 
and is a variable-resolution, multi-channel soundfile format. Use it to 
exchange soundfiles between programs, but do not use it for hard disk 
recording. The AIFF format can be used to create and store mono files. 

NOTE: Compressed and Resource formats must be created using Save 
As. Some options are not available with certain file formats. 

Open ... 
The Open ... command lets you open any compatible soundfile for 
editing and playback in Sound Designer II. When the Open ... dialog is 
on your screen, check the box in front of every file format you wish to 
look for. (See the New ... command for information about the different 
formats.) Use the dialog to navigate to the folder that contains your 
soundfile and click on Open. 
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Open Resource .. . 
The Open Resource ... command is used to open Macinotsh SND 
Resource files. Resources are embedded within documents and appli­
cations, so the Open ... dialog will show documents and applications, 
instead of showing only soundfiles. 

Close 
The Close command performs the same function as the Oose Box in the 
active window's title bar. It closes the active file or window, thereby 
removing it from the screen. If you attempt to close any soundfile 
which contains changes that have not been saved, a warning dialog 
will appear, allowing you to save your changes. If you click No, your 
changes will not be saved. 

NOTE: Files that have "No Backup" in their title bar will retain all 
waveform edits, regardless of whether you choose to save before a 
closing or not. However, you must still save the file to retain Playlist 
edits, EQ settings, loop and marker changes, and similar edits. 

Mac -> Sampler 
The Mac -> Sampler command performs two functions. If a soundfile is 
open, it does the same thing as the Mac-to-Sampler icon present at the 
top of its soundfile window. If no soundfile window is open, it brings 
up an Open ... dialog. Use the Open ... dialog to select the file you wish 
to send directly to the currently selected sampler and access it transfer 
options. (See the Setup menu's Sampler ... command for more informa­
tion about selecting a destination sampler.) 

Sampler-> Mac 
Use the Sampler -> Mac command to retrieve a sound from the sampler 
that has been selected with the Setup menu's Sampler ... command. 
When you choose the Sampler-> Mac command, the standard transfer 
dialog appears. Use the transfer dialog to choose the sound you wish 
to retrieve from the selected sampler. The retrieved sound will appear 
in a new soundfile window. 

Reference 177 

Cl -



178 

Save 
The Save function operates differently depending upon the Use Backup 
Files setting in the Setup menu. With Use Backup Files engaged, the 
changes you have made since your last save are stored over the old 
version. Once you have saved, you cannot use the Revert to Saved 
command to return to the soundfile's original form. With Use Backup 
Files disengaged, all non-destructive edits are saved. Destructive edits 
have been made directly to the soundfile, so they do not need to be 
saved. 

Save a Copy ... 
The Save a Copy ... command saves a copy of the currently selected 
soundfile under a different name or in a different format. To save a 
copy of the soundfile, choose the destination disk and folder, type in 
the name of the new file, and select the desired format options, then 
click on Save. 

NaJ'E: Not all options are available in all formats. 

The Compressed file format utilizes a technique called adaptive differen­
tial pulse code modulation to compress Sound Designer II files at the ratio 
of 2:1 or 4:1. When compression is selected, a dialog appears in which 
the compression may be selected and previewed. This format is useful 
for saving files when hard disk space is limited. Please be aware that 
by compressing a soundfile you are actually reducing the amount of 
sample data contained in the file, thus comprt>mising its audio fidelity 
to some degree. 

Clicking on the Resource button saves the file as a Macintosh SND 
Resource-a standard 8-bit Macintosh System and application format. 
It is used to create soundfiles that can be played back by the Mac 
System (the alert sound, for example) and by certain applications such 
as HypetCard. A dialog will appear with additional options. Use 
Normal to create standard mono 8-bit SNDs for playback on any Mac. 
Use Chunky to create mono or stereo 8 or 16-bit SNDs that can be 
played back both as 8-bit sounds on normal Macs and 16-bit sounds on 
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Macs with a Sound Accelerator II card. Use Interleaved to create mono 
or stereo 8- or 16-bit SNDs that can be played back only on Macs with a 
Sound Accelerator II card. 

Revert to Saved 
If Use Backup Files is engaged, the Revert to Saved command ignores the 
changes you have made since your last save and returns to the old 
version. Remember, once you have reverted to your previously saved 
version, the changes you have made will be lost .. This command is 
disabled if the Use Backup File option is turned off, since all wave data 
edits are made directly to the disk file. 

Delete ... 
The Delete ... command is used to permanently remove a file from a 
disk. Click cancel to exit this dialog. 

Page Setup ... 
The Page Setup ... command brings up the standard Macintosh printer 
Page Setup dialog. The actual dialog depends on the printer that you 
have selected with the ti menu's Chooser. To learn more about these 
settings, click the dialog box's Help button, or refer to your printer 
manual. 

Print .. 
The Print ... command brings up the standard Macintosh Print dialog. 
As with the Page Setup dialog, the actual dialog that appears depends 
on the printer you have selected with the ti menu's Chooser. To learn 
more about these settings, click the dialog box's Help button, or refer 
to your printer manual. 

Sound Designer II allows you to print the active soundfile window, 
FFT window, or Playlist window. Only the currently active window 
will be sent to the printer. 

Reference 179 

Cl -



180 

Get Info ... 
The Get Info ... command perfonns a function within Sound Designer II 
that is similar to the Finder's Get Info ... command. It displays the vital 
information about the currently selected soundfile., including file size, 
data format, sample rate, and creation and modification dates .Space is 
provided to add general comments about the soundfile. Only the 
sample rate and comments can be edited. 

To change the playback sample rate, click the box next to Sample Rate, 
and type in a new rate. Remember, changing the sample rate simply 
changes the playback rate. If you wish to change a sound's sample rate 
without changing its pitch, use the SR Convert ... command on the DSP 
menu. 

Transfer ... 
The Transfer ... command allows you to quit Sound Designer II and run 
another program without returning to the Finder. This function is not 
available if you are running under MultiFinder. 

Quit 
The Quit command ends your Sound Designer II session, and returns 
you to the Finder or MultiFinder. Although Sound Designer II will 
warn you before allowing you to quit without saving changes, it is still 
a good idea to save your work using the Save or Save As ... command 
before quitting. 

The Edit Menu 

Sound Designer II' s Edit menu contains all of the standard Apple Edit 
commands, as well as a host of specific sound-oriented processing 
commands. Here are brief explanations of each command: 

Sound Designer II 



c 1m't Undo :•:z 

Cul aH 
Copy ac 
Paste :•:L• 
CIHr •e 
Ret>lnce :•:Y 
Reuene 
Siience ICE 
Tlim ICY 
lnuert 
Fede In 
Fede Out 
Normalize 
Change 6eln ... 

Smoothing 
Select RH ICR 
Show Clipboard 

Undo 
The Undo command is a very useful editing tool. It keeps track of your 
last action and allows you to reverse that action if you don't like the 
outcome. After you undo something, you can ''Redo" it by choosing 
the Undo command again. This is a gocxl way to compare before and 
after tests of any process. The Undo command only tracks the last 
action, so use it with caution. 

NOfE: Some disk-based edits cannot be undone, due to the huge 
amount of data involved. Sound Designer II will always warn you that 
a process can't be undone before allowing you to do it. 

Cut 
The Cut command cuts the selected waveform range out of its current 
position and holds it on the Macintosh Oipboard. The wave data 
previously to the right of the excerpted range is shifted to the right to 
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close the gap. After a waveform range has been cut, it remains on the 
Clipboard until another cut or copy is made, or until the Mac is shut 
down. 

Copy 
The Copy command places a copy of the selected range on the Macin­
tosh Clipboard. After a waveform range has been copied, it remains on 
the Clipboard until another cut or copy is made, or until the Mac is 
shutdown. 

Paste 
The Paste command is only active after sample data has been placed on 
the Clipboard by using the Cut or Copy command. The Paste command 
inserts the Clipboard contents into the current soundfile, beginning 
immediately after the blinking insertion point. If a range is selected, 
the range is deleted prior to insertion of the Paste data. All wave data 
to the right of the paste point is pushed farther to the right to accom­
modate the newly pasted range. Pasting may increase the size of a 
soundfile, and will only be allowed if there is enough disk space to 
accommodate storage of the resulting file. 

If your paste destination has two (or more) channels, and your paste 
source does not have the identical number of channels, a dialog 
prompts you to set the destination channel for each channel you are 
pasting. 

Clear 
The Clear command deletes the selected waveform range from the 
soundfile without placing it on the Oipboard. When a waveform range 
is cleared, the entire waveform area to the right of the range slides over 
so that no gap remains. 
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Replace 
Like the Paste command, the "Replace command is only active after 
sample data has been placed on the Oipboard by using the Cut or Copy 
command. It pastes the Oipboard contents over sample data in the 
current soundfile. If a blinking insertion point is present, the replace­
ment begins at that point and covers all of the wave data required to 
place the entire Oipboard range. If a range is selected, the replacement 
begins at range start and proceeds only to range end. Replacing is 
destructive, in that it overwrites the waveform range covered by the 
new data, but it always preserves the soundfile's overall duration. 

Reverse 
The Reverse command reverses the order of the samples in the range 
and causes it to play backward. Reversing the same range a second 
time will return it to its original form. This command is sometimes 
useful in creating special sound effects. 

Silence 
The Silence command sets the value of all samples in the selected 
waveform range to zero, muting the passage. Unlike the Cut or Clear 
commands, the Silence command does not close up the space it creates. 
Instead, it maintains the space, and therefore the overall duration of 
the soundfile. 

Trim 
The Trim command all waveform data except the currently selected 
range. 

Invert 
The Invert command takes the selected waveform range and turns it 
upside down. This is accomplished by making all positive sample 
amplitude values negative, and all negative ones positive. Inverting a 
waveform range will not change its sound in any noticeable way, but it 
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may simplify the creation of certain loops and mixes. Inverting the 
same range a second time will return it to its original form. 

Fade In 
The Fade In command fades in the selected waveform range using a 
linear fade curve. Starting at the beginning of the range, it fades from 
zero amplitude to 100% of the original amplitude at range end. 

Fade Out 
The Fade Out command fades out the selected waveform range using a 
linear fade curve. Starting at the beginning of the range, it fades from 
100% of the original amplitude to z.ero amplitude at range end. 

Normalize 
The Normalize command scales the amplitude of a selected waveform 
range so that its peak value is set to Sound Designer II' s maximum 
peak value. This is particularly useful for sounds that were sampled at 
a low amplitude. 

Change Gain ... 
The Change Gain ... command proportionally increases or decreases the 
amplitudes of all samples in a selected waveform range by a user­
defined amount. The Peak Value button displays the percentage value 
of the highest selected amplitude. The Change Gain ... function has a -
75% to +200% limit in its gain parameter. After the gain change is 
executed, you will be returned to the soundfile window to see the new 
amplitude of your selected waveform range. 

Smoothing 
Smoothing is an editing option that can be toggled on and off by simply 
selecting it. When the smoothing function is turned on, extreme 
instantaneous amplitude changes at the edit points are automatically 
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"smoothed over," alleviating click and pop problems. Smoothing is a 
destructive option. 

Select All 
Select All selects the entire soundfile for editing. 

Show Clipboard 
The Show Clipboard command opens a small window that displays the 
contents of the Macintosh Clipboard. In most cases this will consist of 
wave data when you are using Sound Designer II. The Show Clipboard 
command is useful for checking to see what you have on the Oipboard 
for pasting or replacing. The contents cannot be edited or played back 
until placed in a soundfile again. 

The Tools Menu 

The Tools menu offers you access to functions specifically designed for 
sample editing. Here are short explanations of the Tools menu com­
mands: 

XK 
XL 

MIDI Keyboard 
The MIDI Keyboard command presents a musical keyboard-a remote 
MIDI triggering tool that lets you send MIDI note-on and note-off 
messages to the currently selected sampler. This window lets you play 
any MIDI device directly from your Macintosh, and will be of particu­
lar use to owners of rack-mount sampling modules. The keyboard 
currently selected on the Sampler ... menu will always be the destina-
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tion. The Pattern button plays each note sequentially. Record lets you 
enter a specific sequence of notes. Play plays back the recorded pattern. 

Loop Window 
The Loop Window command brings up the window you'll use to fine­
tune loops you have defined with the loop start and loop end markers. 
When the window appears, you will see two waveform ranges divided 
by a vertical black line. The range on the left represents the wave data 
immediately before loop end, and the range on the right is the wave 
data immediately after loop start. The black line is the actual loop 
splice point where loop playback jumps from loop end to loop start. 

For specific directions for using Sound Designer II's loop window, see 
the looping information in Chapter F. 

The DSPMenu 

The DSP menu is your gateway to Sound Designer Il's digital signal 
processing tools The use of each of these DSP commands is detailed in 
depth in Chapter E of this manual. Here you will find short explana­
tions of each. 

MIH 
Merge 
SR Conuert 
Peremetr1c EQ 
Graphic EQ 
Dynamics 

Frequency Analysis 
Time Comp/ENP 
Pitch Shift 
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Mix 
The Mix window allows you to digitally mix up to four mono and/ or 
stereo soundfiles, and save the result as a new soundfile. All aspects of 
the mix can be controlled, including level, stereo pan, input scaling, 
and delay before mix start. To learn more about this function, see 
ChapterE. 

Merge 
The Merge window is Sound Designer II' s crossfade workshop. It 
allows you to open two soundfiles that contain Numbered Markers, 
define the crossfade between them in terms of the markers, and 
execute the crossfade. The product of a merge is a new soundfile that 
begins with one of the original files and ends with the other. All 
aspects of the crossfade between them, including crossfade curve and 
length, can be adjusted. Refer to Chapter E for more specific merge 
directions. 

SR Convert 
The SR Convert command is used to alter the sample rate of a soundfile 
without changing the sound's pitch. Sample rate conversion allows 
you to adjust any sound in your library to any sample rate, so that 
those sounds can be sent to any Sound Designer II-compatible MIDI 
sampler, or made compatible with other devices such as DAT record­
ers. See Chapter E'for more specific information. 

Parametric EQ 
The Parametric EQ command opens the parametric equalization 
window. Use the Parametric EQ window to select, adjust, preview, 
and perform parametric equalization on one or two channels. Five 
different types of parametric filters are available: High pass, low shelf, 
notch/ peak, high shelf, and low pass. Any number of specific para­
metric EQs can be designed and saved either with your Sound De­
signer II program or with specific soundfiles. See Chapter E for more 
specific information. 
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Graphic EQ 
The Graphic EQ command opens the Graphic equali7.ation window. 
Use the Programmable Graphic EQ window to adjust, preview, and 
perform separate 5-band Graphic EQs on each channel of a stereo file, 
or a 10-band Graphic EQ on a mono file. The bandwidth and center 
frequency of each graphic band can be adjusted to provide a virtually 
limitless number of equa1iqtion options. And any number of specific 
Graphic EQs can be designed and saved either with your Sound 
Designer II program, or with specific soundfiles. See Chapter E for 
more specific information. 

Dynamics . 
The Dynamics command gives you control over the overall dynamic 
characteristics (loudness and softness) of your soundfile with three 
different DSP tools: a Compressor /Limiter, an Expander, and a Noise 
Gate. All parameters, inclqding input, output, threshold, attack, 
release, detection, and ratio can be fully adjusted. See Chapter E for 
more specific information. 

Frequency Analysis 
The Frequency Analysis command generates a 3-D Fourier analysis 
display that shows the spectral evolution of the waveform in the 
soundfile window over time. The characteristics of the 3-D display are 
set using the Setup menu's Frequency Plot ... command. See Chapter E 
for more specific information. 

Time Comp/Expand 
The Time Comp/Expand command is used to adjust the duration of a 
soundfile without changing its pitch. This function is particularly 
useful for sound design in audio post-production environments, 
because it allows you to match sounds to time or SMPTE frame 
durations. See Chapter E for more specific information. 
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Pitch Shift 
Pitch Shift is use to adjust the pitch of a soundfile by a user-selectable 
amount. With the Time Correction option selected, it's possible to do so 
without changing the soundfile' s duration. This function is particularly 
useful for audio production applications where pitch correction of 
vocals or instruments is necessary. See Chapter E for more specific 
information. 

The Playlist Menu 

The Playlist menu, along with the Playlist icon, is your door into 
Sound Designer II' s non-destructive editing mode. Play list menu 
commands are only available after the Playlist window has been 
opened by clicking on the Playlist button. The fine points of Playlist 
creation and editing are explained in Chapter D. 

-~ . 
New Pl11yL11t ... 
Open Playllst ••• 
Delete Playlist 
Rename Pleyllst ... 
Seue Pleyllst Rs Soundflle ... _______________________ ___, 
Rename Region ••• 
Edit Regions ... 
Un-Tlmeloclc Regions _______________________ __, 
SMPTE Start Time ••• 
Capture Region aBR 
Preulew Edit 8£P 
Fades... aBF 

New Playlist ... 
The New Playlist ... command is used to create and name a new empty 
Playlist. This command is most useful if you have already defined one 
or more soundfile regions using the Capture Region command. See 
Chapter D for more information. 
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Open Playlist .. 
The Open Playlist ... command is used to open any existing Playlists 
attached to the current soundfile. See Chapter D for more information. 

Delete Playlist .. 
The Delete Playlist ... command is used to delete the Playlist that is 
currently open in the Playlist window. See Chapter F for more infor­
mation. 

Rename Playlist ... 
The Rename Playlist ... command is used to rename the Playlist that is 
currently open in the Playlist window. See Chapter D for more infor­
mation. 

Save Playlist as Soundfile .. . 
The Save Playlist as Sound.file ... command is used to save the currently 
open Playlist as a new soundfile. All non-destructive edits in the 
Playlist-region playback order, fade ins/ outs, crossfades, and so on­
are applied to create a completely new soundfile with these attributes. 
The new soundfile is the equivalent of digitally recording the output of 
a Play list into a new file. This new file will be as long as the Playlist' s 
play time so you may require quite a bit of additional disk space. See 
Chapter for more information. 

Rename Region .. . 
The Rename Region ... command is used to rename the currently selected 
region in the Play list window's region list. See Chapter D for more 
information. 
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Edit Regions ... 
The Edit Regions ... command is used to edit the currently selected 
region in the Playlist area of the Playlist. It brings up a window in 
which all region parameters, including length, volume, crossfade 
duration and crossfade type can be fully adjusted and auditioned. See 
Chapter D for more information. 

Un-Timelock Regions 
The Un-Timelock Regions command allows you to unlock a frame­
locked region that has been selected in the Playlist' s regions list. The 

, region will be placed at the end of the previous region. 

NOTE: A region cannot be un-timelocked by merely deleting it from 
the regions list; doing so will merely cause the region following it to 
take its place, thus becoming time-locked. 

SMPTE Start Time 
The SMPTE Start Time command is used to set the SMPTE start time of 
the first Playlist region. All other regions' SMPTE start and stop times, 
including locked regions, will be adjusted accordingly. See Chapter G 
for more information. 

Capture Region 
The Capture Region command is used to specify a selected range of 
wave data in the soundfile window as a Playlist region. A waveform 
range must be selected in order for this command to be active. See 
Chapter D for more specific information. 
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Preview Edit 
The Preview Edit command serves two purposes: 

If you select a region in the region list at the top of the Playlist win­
dow, the Preview Edit command plays only that region, while display­
ing the waveform range in the soundfile to show what is being played. 

If you select a region in the Playlist area, the Preview Edit command 
auditions the transitions between the region and its neighbors. The 
specified pre-roll and post-roll times are used. This allows you to 
audition the crossfade or transition between regions without having to 
play the entire Playlist. See Chapter D for more specific information. 

Fades ... (3€ - F J 
The Fades command brings up the Playlist Fade Editor window in 
which user-programmable envelopes can be created for fading in and 
out a Playlist. Users can draw their own envelopes from scratch or 
start from two preset types. The duration of fade ins and outs is fully 
adjustable. See Chapter D for more specific information. 

The Display Menu 

Sound Designer II' s Display menu contains the commands you'll use 
to organize your windows, add channels to a file, select windows for 
viewing or editing, search for markers, and display the screen cursor. 
Here are short explanations of the commands on the Display menu. 
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Rdd New Channel 

Find Marter... •F 
Screen Cunor 

Tiie Windows 
Steck Windows 

•Untitled 

Add New Channel 
The Add New Channel command adds a channel to a mono Sound 
Designer II or AIFF file. When you are editing a file with one of these 
fonnats, the Add New Channel command adds a new empty channel 
below the existing channel. Once a new channel has been added, you 
can paste any desired waveform into it. This function is limited to a 
maximum of two channels. 

Find Marker ... [3e-F] 
The Find Marker ... command allows users to quickly locate text or loop 
Markers in a soundfile. All text and loop markers placed in a soundfile 
automatically appear in pop-up menus within the Find Markers 
dialog. To find a marker, click on the button in front of the type of 
marker that you wish to find and select it from the pop-up menu 
containing the names of all placed markers of that type. With text 
markers, you have the option of typing in any part of the marker's 
name and Sound Designer II will match the rest of the marker's name 
for you. After you have selected the marker you wish to locate, click 
Find and Sound Designer II will scroll to that location in the soundfile. 

Screen Cursor 
The Screen Curscr command toggles Sound Designer H's large screen 
cursor on and off. Unlike the flashing insertion point, the screen cursor 
is attached to the window, not the waveform. It can be moved within 
the soundfile by dragging its triangular base to the left or right. The 
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screen cursor is a gauging tool that can be used to determine the exact 
time and amplitude values for any single point in the current wave­
form. 

When the screen cursor is moved, the upper and lower right data 
indicator boxes show the time and amplitude values of the current 
point. If a multi-channel file is being edited, the uppermost channel's 
values will be displayed. 

Tile Windows 
The Tile Windows command is very useful for cleaning up your screen 
when you have multiple windows open. All open Sound Designer II 
windows (excluding Mix, Merge, SR Convert, Time Comp/Expand, 
and EQ windows) will be resized automatically to fit on your screen, 
so you can see them all at one time. 

After you have tiled the open windows, you can grow any window to 
full screen size by dicking on the window's Grow Box in the right 
comer of its title bar. Oicking on the Grow Box a second time will 
shrink the window back to its tiled size. 

Stack Windows 
The Stack Windows command is another window clean-up command. 
Each open Sound Designer II window (excluding Mix, Merge, SR 
Convert, Time Comp/Expand, and EQ windows) will be resized 
automatically to fill your screen, and all will be placed in a pile, with 
the active window on top. 

Window List 
Any time Sound Designer II is running, you will see a list of all open 
windows (excluding Mix, Merge, SR Convert, Time Comp/Expand, 
and EQ windows) at the bottom of the Display menu. A diamond 
always appears in front of the active window. To bring any listed 
window to the front and make it the active window, just choose the 
name of that window at the bottom of the Display menu. 
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The Setup Menu 

You will use the various commands on the Setup menu to configure 
the various settings for your Sound Designer II environment. Here are 
short explanations of each command: 

Frequency Plot ••• 
MIDI Interface ••• 
Scale Marts ••• 
Sound Playback ••• 
Hardware Setup... XO 

On-Line 
use Backup Flies 

,,.Scroll Rfter Play 
HDPley Buffer Size... XH 
RRM Buffer Size ••• 
Preferences ••• 
SMPTE Offset ••• 

Set Current Time ••• 
Set lnteruel ••• 
Set Colors ••• 
Sampler ••• 

frequency Plot .. . 
The Frequency Plot ... command is used to set the characteristics of the 3-
D FFf display that is created when you choose the DSP menu's 
Frequency Analysis command. For parameters details, please see 
ChapterE. 

MIDI Interface ... 
The MIDI Interface command lets you set the clock rate of the particular 
MIDI interface(s) connected to your Mac's modem and/or printer 
ports. Most MIDI interfaces use a 1 mHz clock rate, but you will need 
to check your MIDI interface manual to make sure. An incorrect clock 
setting will prevent your MIDI interface from functioning. Check the 
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MIDI Thru box for each interface if you want it to retransmit incoming 
MIDI data back out of the MIDI output. See Chapter G for more 
information. 

Scale Marks ... 
The Scale Marks ... command lets you select the units that you'll see 
displayed on the vertical (Y) and horizontal (X) axes in the active 
soundfile window. Here are short explanations of the different vertical 
and horiz.ontal scale units: 

Percent Full Scale: This unit indicates all amplitudes in percent of 
maximum allowable amplitude values. Values above 100% will be 
clipped. This is generally the most useful amplitude scale for sound 
design and hard disk recording. 

Quantized Sample Value: This unit indicates all amplitudes in the closest 
quantized sample value (between -32768 and 32768). Because this is 
machine-oriented, it is generally of less use. 

Time: This unit indicates waveform duration in minutes, seconds, or 
milliseconds. 

Hr:Min:Sec:Msec: This unit indicates duration in 
hours:minutes:seconds:milliseconds. 

Dedmal Sample Number: This unit indicates duration in decimal sample 
number. Although this unit gives a clearer picture of the memory 
required to contain a sound, it is not useful for normal time duration 
judgements. 

Hex Sample Number: This unit indicates duration in hexadecimal (base 
16) sample number. 

SMPTE: This unit indicates duration in SMPTE time code, according to 
the SMPTE format chosen with the Set Current Time ... command. This 
setting is most useful for video applications. 

Feet and Frames: This unit indicates duration in feet and frames, accord-
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ing to the film format chosen with the Set Current Time ... command. 
This setting is useful for film applications. 

Bars and Beats: This unit indicates duration in bars and beats, according 
to the base unit defined using the Set Current Interval... command. This 
duration unit offers a more "musical" option, but is only useful on 
sequenced or steady meter music. 

SHORTCUT: Hold down the Option key to access a pop-up that allows 
the time scale to be changed quickly. See Chapter C for details. 

Sound Playback .. . 
The Sound Playback ... command is used to set Sound Designer II' s 
soundfile playback to match your system. Here are brief explanations 
of the different playback options: 

Sound Accelerator. This will insure that all mono and stereo 
soundfiles are played through the card at 16-bit resolution. If you click 
on the Direct from disk box, you will set the speaker icon to play back 
directly from the hard disk. When the Direct from disk box contains no 
''X," the speaker icon only plays back the contents of memory. 

NOfE: Direct from disk playback may cause a slight hesitation before 
playback begins, (unless Pre-allocate HD buffers is selected in Prefer­
ences ... under the Setup menu) whereas memory playback is immedi­
ate. Loops cannot be played direct from disk. 

If you plan to trigger playback of soundfiles with SMPTE, check 
Continuous SMPTE Sync. This ensures that Sound Designer II playback 
remains perfectly synchronized to SMPTE throughout playback. 
However, because of the DSP processing power required to implement 
this feature, you will not be able to implement other DSP functions 
such as Graphic EQ and Dynamics in real time. 

Dithering randomizes the effect of quantization error in digital audio 
signals. Select Use Dither when you are editing and manipulating 
soundfiles with DSP functions, such as EQ or when using fade in or 
fade out functions in the Playlist. 
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NOTE: Sound Designer always uses dither in Parametric EQ Graphic 
EQ, and destructive fades. It is never used in Dynamics. Selectable 
dither is only used when DSP is not implemented during playback. 

Check the button appropriate to your interface device. This ensures 
that both the interface's recording electronics and the Sound Accelera­
tor 11' s playback electronics use the same clock. 

Sound Manager. If you are running a Mac II System that uses Apple's 
Sound Manager click on the radio button in front of this option to 
route playback to the Mac speaker. To determine whether you have 
the Sound Manager or the Sound Driver, open the Control Panel on 
the ti menu. Scroll down if necessary and select the Sound icon. If the 
panel that appears offers a choice of alert sounds, you have the Sound 
Manager. If not, you have the Sound Driver. Direct for disk playback is 
not supported. 

Sound Driver. If you are running a Mac System that uses Apple's 
Sound Driver, click on the radio button in front of this option to route 
playback to the speaker. To determine whether you have the Sound 
Driver or the Sound Manager, see the previous paragraph. Direct for 
disk playback is not supported. 

If you are playing back sounds with the Sound Driver, you can choose 
between a fixed playback rate of 22.254 kHz and playback the 
soundfile' s sample rate. There is a trade off attached to this decision. 
The Mac has a fixed playback rate of 22.254 kHz, so it gives up some 
fidelity in order to play back sounds with a different sample rate. If 
you want to hear your sounds at highest 8-bit fidelity, choose Internal. 
The sounds will not, however, be played back at their true pitch. If you 
want to hear your sounds at their true pitch, choose Soundfile Sample 
Rate. In this case, the sounds will not be played back at their highest 
fidelity. 
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Hardware Setup 
The Hardware Setup command brings up a dialog that configures 
Sound Designer II for your hardware system. Select Card Type 
determines which interface card is in the NuBus slot. Current options 
are the Sound Accelerator or Pro Tools Audiocard. For more 
information on Hardware Setup, refer to Chapter B. 

On-Lina 
The On-Line command puts your system into external sync mode. 
Sound Designer II will remain in a play /wait state until the correct 
SMPTE start frame is received. Choose the command again to take 
your system off line. See Chapter G for more information. 

Use Backup Files 
When the Use Backup Files command is checked ( 4 ), Sound Designer II 
will attempt to create a backup copy of any file that is opened. In this 
mode, all edits are made to the copy of the original soundfile, and are 
not saved to the original until the File menu's Save command is chosen. 
This is the safest way to edit soundfiles, because it allows you to close 
a file without saving any changes you have made. To tum this option 
off, just choose the command again. 

NOTE: The Use Backup Files option will only function if there is enough 
disk space to create and edit a backup file. If the required space is not 
available, a warning dialog and allow you to open the soundfile as a 
No Backup soundfile. 

Scroll After Play 
When the Scroll After Play command is checked, the waveform editing 
area of the soundfile window will automatically scroll to the playback 
stopping point when you let go of the mouse button in Scrub mode. 
This is a very helpful function for pinpointing specific spots in long 
soundfiles. This command is a simple toggle. 
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HDPlay Buffer Size ... 
The HDPlay Buffer Size ... command is used to tell Sound Designer II 
what size playback memory buffer you wish to use when playing back 
directly from the hard disk. 

Generally speaking, a setting of 8 will function with the best results. 
However, if you are running Sound Designer II under MultiFinder, 
you may receive a warning that it is impossible to allocate a buffer that 
is large enough. If this happens, increase Sound Designer 11' s memory 
size by selecting the program's icon on the desktop, and using the 
Finder's Get Info ... command. 

NITTE: If you are playing back from a slow or very fragmented hard 
disk, or you experience hesitations during hard disk playback, increase 
the HDPlay buffer size until the problems desist. Optical drives 
usually require a setting of 32. 

RAM Buffer 
The RAM Buffer command allocates the amount of memory Sound 
Designer II can access instantaneously for playback and record opera­
tions. 

Preferences .. . 
The Preferences ... command allows you to assign the default setting for 
various Sound Designer II parameters. These settings are saved with 
the Sound Designer II application upon quitting and are restored the 
next time the application is opened. When you choose this command, 
the following dialog box appears: 
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User Default Options 

D Ruto-name regions Uertical Scales: I ~ Sc11le 
D Ruto-n11me pl11ylists ..--Ti-im_e _____ ___,, 

Horiz. Scales: _I --------

0 Pre-allocate HD buffers: Multiple • Li 
Default Cross fade: [D IO I msec 

Preulew edit pre-roll: 13 I sec 

Preulew edit post-roll: 13 I sec 

( OK 

The Preferences dialog 

Clicking on Auto-name regions automatically names regions "Region 1 ", 
" Region 2", and so on when created. (Regions can be renamed later by 
using the Rename Region ... command in the Playlist menu). 

Clicking on Auto-name Playlists automatically names Playlists ''Playlist 
1", "Playlist 2", and so on when captured. (Playlists can be renamed 
later by using the Rename Playlist ... command in the Playlist menu). 

Clicking on Pre-allocate hard disk buffers makes hard disk playback more 
instantaneous by setting aside areas of available RAM for this function. 
This option is especially useful for reducing the lag that sometimes 
precedes hard disk playback when multiple files are open. However, 
you must restart Sound Designer II after selecting this for it to take 
effect. 

Clicking on Preview edit pre-roll allows you to set the default pre-roll 
time for the Edit Regions and Preview Edit commands in the Playlist 
menu. 
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Clicking on Preview edit post-roll allows you to set the default post-roll 
time for the Edit Regions and Preview Edit commands in the Playlist 
menu. These defaults will also affect playback from the overview if the 
Option or Command keys are pressed while clicking the speaker icon. 

Default crossfade sets the default crossfade type for new Playlist regions 
that are dragged into the Playlist. 

Vertical Scales sets the default units displayed in the vertical axis of 
new soundfiles. 

Horizontal Scales sets the default units displayed in the horizontal axis 
of new soundfiles. 

SMPTE Offset ... 
The SMPTE Offset ... command is used to set an-offset relative to 
incoming SMPTE time code. See Chapter G for details. 

Set Current Time ... 
The Set Current Time ... command is used to select your SMPTE, Feet 
and Frames, or Bars and Beats format. The format you choose here 
dictates the form of each of these units when they are displayed as axis 
marks, or used for duration or synchronization units. This command is 
only active when the insertion point is blinking in your soundfile. 

The Capture button provides a convenient way to enter a specific 
SMPTE value from an incoming time code signal with a mouse click. 
For specific information about SMPTE format, see the Appendix of this 
manual. Before you can really use Bar and Beat information, you 
should define your time units using the Set Interval... command. 

You will also use the Set Current Time ... command to set the absolute 
position of the current insertion point in your format of choice. All 
other time positions will then be displayed relative to that absolute 
position. 
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Set Interval ... 
The Set Interval ... command is used to tell Sound Designer II what type 
of musical interval is represented by the selected range. It is only active 
when the insertion point is blinking in your soundfile. To view your 
soundfile in bars and beats, select a waveform range which 
corresponds to a sixteenth note, eighth note, quarter note, half note, or 
whole number of bars, and choose the Set Interval ... command on the 
Setup menu. Oick on the button in front of the unit that is represented 
by the currently selected waveform range, then click on the OK button. 

NOTE: Bar and beat information will only be of use on sequenced and 
other time-locked material. Any soundfile that does not maintain near­
perfect timing throughout its duration will fall out of sync with the bar 
and beats mark. 

Set Colors ... 
The Set Colors ... command to assign different colors or gray levels to 
the major components of Sound Designer II' s soundfile windows. (This 
command remains dimmed unless you have a Macintosh that is 
capable of color or gray scale display, and which has the Color docu­
ment in the System folder.) Oick on a display component (overview, 
waveform, sound cursor, scale marks, etc.). This opens the Color 
Picker, which you can use to select a color or gray level for the selected 
Sound Designer II component. The color settings dialog will reappear 
with the newly colored component. Repeat this procedure until all 
colors are to your liking. 

NOfE: The color settings are used for all soundfiles, and cannot be set 
differently for different files. 

Sampler ... 
The Sampler ... command is used to configure Sound Designer II so that 
it can communicate with your samplers. See Chapter F for more 
information about working with samplers. 
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Appendix 

Basic Sampling Concepts 

Sound Designer II accomplishes its direct-to-disk recording tasks using 
a method called sampling. Unlike normal magnetic tape recording, 
which records an audio signal as a continuous charge on magnetic 
tape, a sampler converts an audio signal to discrete numbers which are 
then stored on a digital storage medium (a hard disk, for example). 

Digital sampling of audio tracks is generally superior to standard 
analog recording methodS-not only because it offers extremely high 
fidelity, but because it avoids the standard tape generation and "play­
back degradation" problems. Because sampled audio is stored as a set 
of numbers, there is no loss of fidelity when you copy those numbers, 
regardless of how many 1copies of copies' you make. Also, because the 
disk medium is not physically strained by playback (as is a reel of 
analog tape when it is pulled across the playback heads), repeated 
playback of a digital track will not alter or degrade that track in any 
way. For these reasons (among others), digital recording of audio 
tracks has become the method of preference for many contemporary 
producers. 

The process of digital recording (or sampling) is really quite simple: 
An audio signal is fed into a computer (or dedicated sampling device) . 
That signal is run through an analog-to-digital converter (ADC), which 
measures the amplitude (volume) of the signal at regular intervals and 
passes these measurements or 1samples' on to a storage medium. 
When the recorded track or tracks need to be played back, the samples 
are retrieved from the storage medium and run through a digital-to-
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analog converter (DAC), which converts those samples back into a 
continuous wave. The signal that comes out of the DAC is the output 
signal, and it is a nearly exact image of the signal that was fed into the 
ADC. Here is a diagram illustrating the way in which samples of an 
incoming audio signal are taken: 

Taking Samples of a Sound Wave 

Time_____. 

Sampling a sound wave 

As you can see, the incoming audio waveform is approximated by a 
series of discrete points that describe that waveform. This illustrates 
one of central questions of digital :recording: How accurate is the 
digital representation of the original analog signal? To determine this 
you will need to understand the concept of sample rate. 

Sample rate is the number of samples of a waveform that you take in a 
single second, and it has a very strong influence upon the quality of 
the recording you make. At best, a collection of samples is an ex­
tremely good approximation of the original input signal. By taking 
many samples of an audio signal, you end up with a more accurate 
depiction of the wave -fewer samples yield a less accurate, 'grainy' 
depiction. Here's an illustration: 
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Why Sample Rate Affects Fidelity 

I 
Time---+ Tune--+ 

Higher Sample Rate Lower Sample Rate 

How different sample rates affect fidelity 

Notice how a higher sample rate yields a more accurate, and therefore 
higher-fidelity recording. Unfortunately each sample requires storage 
space. Since a higher sample rate is taking more samples per second, it 
will require more disk storage space for each second of audio than a 
lower rate. Sound Designer II uses base sample rates of sample rate of 
44,100 Hz and 48,000 Hz, which means it takes 44,100 (or 48,000) 
samples every second and puts them on your hard disk. 44, 100 Hz is 
the same rate used on audio compact discs, and it allows you to record 
frequencies up to 22,050 Hz. 48,000 Hz is available on most digital 
audio tape (DAT) recorders, and it allows you to record frequencies up 
to 24000 Hz. Since normal human hearing ranges approximately from 
20 Hz to 20,000 Hz (or less), the fixed sample rate of 44.1 kHz generally 
offers more than enough fidelity. 
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About Time Code and Synchronization 

SMPTE (Society of Motion Picture and Television Engineers) time code 
is a running "clock" in the form of a digital data stream that can be 
recorded on magnetic tape as an audio signal. SMPTE time code can 
be used to synchronize the playback and recording of your Sound 
Tools II system with another audio system, such as an analog multi­
track tape machine or a video tape recorder (VTR). 

SMPTE time is based on hours, minutes, seconds and frames. Depend­
ing on the SMPTE format (covered in the next section), one frame is 
equal to 1/24th, 1/25th, or 1/30th of a second. The frame unit is used 
as a unit of time measurement due to SMPTE time code's origin in film 
and video applications. 

Because SMPTE stores 24-30 exact time stamps per second on the tape, 
any location on that tape can be precisely located by devices that read 
time code. Once the time code has been recorded or "striped" on a 
tape, it provides a permanent time reference that allows Sound De­
signer II to link the playback of an event to an exact tape location. 
Thanks to SMPTE synchronization, a gunshot sound effect can be 
played at the precise instant that the gun's flash appears on-screen, and 
soon. 

There are two basic techniques used to record SMPTE time code on 
magnetic tape: Longitudinal Time Code (LTC) and Vertical Time 
code (VITC). 

LTC is recorded as an audio signal on one of the audio tracks on the 
audio or video tape. VITC is recorded within the video signal-each 
SMPTE "message" is recorded between the video frames. VITC cannot 
be recorded on audio tracks, so it's not useful for recording audio-only 
tape machines, but it does offer powerful features for video professionals. 
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Each type of SMPTE has its own set of pro and cons: 

LTC can be read at high tape shuttle speeds, allowing professional 
time code readers to stay "in sync" at rewind or fast forward speeds 
exceeding 50 times playback speed (provided the tape recorder is able 
to reproduce the time code at this speed). Unfortunately, LTC cannot 
be read at very slow shuttle speeds (such as when you are "crawling" 
the tape frame by frame) or in pause. Sound effects editors often 
shuttle the tape frame by frame to locate the exact point at which the 
sound effect should occur. With LTC, the VTR must be running 
(usually at a minimum speed of about 1/lOth normal playback speed) 
in order to capture a SMPTE time. 

When VITC is used, Sound Designer II can capture the current SMPTE 
time from the VTR when it's paused or in "crawl" mode. However, 
most synchronizers cannot read VITC at speeds exceeding about 10 
times playback speed, preventing slaved machines from maintaining 
synchronization during rewind and fast forward. 

Because VITC cannot be recorded on audio tracks, it's never used to 
synchronize audio-only recorders. As a result, LTC is more commonly 
used in audio-only applications. VITC's strength at slow speeds makes 
it much more useful in audio-for-video environments. 

SMPTE Formats 

Five different formats of SMPTE time code exist: 30 frame nondrop, 
29.97 frame nondrop, 30 drop-frame, 25 frame nondrop (EBU) and 24 
frame nondrop. 

The 30 frame nondrop format is based on a frame rate of 30 frames per 
second. This is the original SMPTE format developed for monochrome 
(black and white) video. 
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The 30 drop-frame format was developed for use with color video, 
which has an actual frame rate of 29.97 frames per second. This slight 
deviation from the standard 30 frames/ second rate causes synchroni­
zation inaccuracies to accumulate, resulting in ever-increasing time 
offset the longer a source plays. To compensate for this discrepancy in 
frame rates, the first two frames of each minute are "dropped" (omit­
ted) with the exception of every 10th minute. This results in 108 
frames being dropped every each hour, exactly the number required to 
avoid accumulation error (and reflect true 'wall dock' in the time code 
clock values). 

The 29.97 frame nondrop format is also used with color video to 
achieve the proper frame rate by slowing the overall frame rate instead 
of dropping frames. It's important to note that "one hour" of 29.97 
frame nondrop time code is actually one hour and 3.6 seconds of "real 
time" due to the fact that the slower frame rate does not match 'wall dock.' 

The 25 frame nondrop (EBU) format is very similar to the 30 frame 
nondrop format, but is based on a frame rate of 25 frames/ second. 
This format is also called the EBU (European Broadcast Union) format 
because it's used by broadcasters throughout Europe (where alternat­
ing current rates are 50 cycles/second instead of 60 cycles/second). 

The 24 frame nondrop format is used exclusively for film applications. 
Film is often photographed and projected at a rate of 24 frames per 
second, so this SMPTE format is useful when one time code frame 
should equal one film frame. 
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The Need for Synchronization 

Synchronization is necessary for two reasons. First, it allows con­
nected systems to start and stop their transports together, without 
requiring an operator to run all the transports individually. Secondly, 
it keeps the systems in lock-step while their transports are running, so 
that no individual system gets ahead of, or behind any other system. 

Without synchronization, the operator would have to start and stop 
each individual transport manually at precisely the same time. Even if 
this were possible, once the transports began running, they would all 
run at slightly different rates. Analog tape transports, being mechani­
cal, have small fluctuations in tape speed called "wow and flutter". 
The capstans on tape machines can slip over time as well, also generat­
ing changes in tape speed. 

With disk-based systems such as Sound Tools II, there is no mechani­
cal transport and no tape. Instead, the playback and record speeds are 
controlled by quartz crystal oscillators. However, no two oscillators 
are exactly the same, and an oscillator's frequency can vary with time 
and temperature. What all this means is that any two transports, even 
when started at exactly the same time, will begin to drift apart over time 
and the audio on the different systems will eventually drift out of sync. 

Synchronization is achieved in these systems by constantly checking to 
see the current SMPTE frame, and adjusting the playback speed to 
keep all devices locked. In analog systems, this is achieved by auto­
mated motor speed control. In digital systems it is achieved by 
adjusting the playback sample rate. 
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Sound Tools II and SMPTE 

Sound Tools II supports two types of SMPfE synchronization to deal 
with the above problems. The first type is called SMPTE Trigger, and 
it allows Sound Designer II to chase and start (or stop) playback and 
recording while slaved to other systems. However, in a trigger envi­
ronment, once playback or recording starts there is no further synchro­
nization, and Sound Designer II will play back at a rate determined by 
the Audio Interface's crystal oscillator. 

The second type of synchronization is called Continuous SMPTE 
Resynchronization. It is virtually the same as SMPTE Trigger, how­
ever, once playback or recording commences, the playback or record­
ing speed of the Sound Tools II system is continuously adjusted to 
match and lock to the incoming SMPTE time code. 

NOTE: Remember, as you see in the analog world, constant variation 
of playback and record speeds can degrade overall audio fidelity. It is 
always wise to use a time code source that is as solid and accurate as 
possible. 

Choosing a Synchronization Method 

Each type of synchronization has its own important advantages and 
disadvantages. The one you choose will depend on your unique 
situation. For short audio pieces (30 seconds or less), SMPTE trigger is 
sometimes preferable, especially if the sync master has a fairly stable 
transport. In this case, the two transports will probably not drift very 
far apart in such a short period of time, so Continuous SMPTE Resync 
is unnecessary. On the other hand, if the audio piece is several min­
utes long, or if the sync master has an unstable transport (as in the 
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case of a cassette player sbiped with SMPTE, for example), Continuous 
SMPTE Resynchronization will be necessary in order to prevent the 
two systems from drifting apart noticeably over the duration of the 
piece. 

There is another important difference between the two types of syn­
chronization: When you use continuous SMPTE resync, the audio 
quality of the Sound Tools II system can be affected by variations in 
the incoming SMPTE Time Code. In order for the Sound Tools II 
system to stay synchronized to the incoming SMPTE, it must slow 
down and speed up the digital audio to match the changes in speed 
the SMPTE Time Code makes. This is accomplished by varying the 
sample rate of the Sound Tools II system in real time using the Sound 
Tools II Digital Signal Processors (DSPs). The net result is that any 
"wow and flutter" in the original SMPTE source is "copied" into the 
digital audio. 

Depending on the stability of the original source of the SMPTE Time 
Code, this variation in sample rate can cause results that range from 
unnoticeable to unacceptable. The same problem would exist if you 
substituted an analog tape machine for the Sound Tools II system;: its 
synchronizer would cause it to slow down and speed up (warble) to 
match the fluctuations in the incoming SMPTE Time Code as well. 

A third, better alternative exists. This technique uses SMPTE Trigger, 
but maintains long-term synchronization by using the Video Slave 
Driver™, available separately from Digidesign. 

The Video Slave Driver is a peripheral device for Sound Tools II that 
allows you to calibrate Sound Tools II's recording and playback clock 
to an external video black burst or word clock signal. The Video slave 
Driver accepts either of these signals and then converts it into a master 
clock signal which it sends to the Sound Tools II Audio Interface. By 
sending the same master black burst clock signal to Sound Tools II and 
your video deck, all elements of your system will run at exactly the 
same speed, thereby staying in sync. 
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In this case, SMPTE Time Code is only used to locate, chase, and 
trigger; as explained above, playback speed of both Sound Tools II and 
the video tape recorder are then controlled by the blackburst or word 
clock signal. This technique will produce better audio quality than 
continuous SMPTE resync (on fluctuating sync signals), and it guaran­
tees that the Sound Tools II system will remain tightly locked to the 
sync source. 

Using SMPTE 

The basic idea behind a SMPTE-synchronized network of devices is 
that each device (analog tape machine, video tape machine, Sound 
Tools II system, etc.) is initially "striped" with SMPTE before anything 
else is recorded. One of the devices is assigned to be the "master" and 
all other devices read and follow the SMPTE time code read from the 
master. They follow (or synchronize to) the master device by compar­
ing their own SMPTE time code "stripes" to the incoming code from 
the master device, and continually adjust their own transport speed so 
that all devices are registering the exact same SMPTE time code value 
at the same time. 

In such a system, if the master device begins to slow down, all other 
devices will slow down right along with it, matching the master's 
speed variations so that all devices are playing back at the same speed. 
Even after many minutes, they will still be locked to each other, 
because the current master SMPTE time is mirrored by all slave 
devices. 

To set up such a system, you must first stripe each medium (video 
tape, audio tape, etc.) with SMPTE time code. On analog tape ma­
chines, this means recording longitudinal SMPTE time code (L TC) on 
one of the tracks of the audio tape. On video tape machines, you can 
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either record LTC on one of the audio tracks on the video tape, or you 
can record Vertical Interval SMPTE time code (VITC) in the vertical 
retrace interval of the video signal itself. 

If you expect to send any of your SMPTE-striped material to someone 
else, or especially if you intend to provide it to professional broadcast­
ing, you must make sure that the SMPTE time code that your generator 
is producing is very accurate. This is accomplished by resolving (or 
synchronizing) the actual SMPTE time code generator itself to a very 
accurate clock signal, such as house sync or black burst. The tape 
machine you are striping should also have its transport resolved to the 
same clock signal. This is the only way to guarantee that the SMPTE 
time code on tape is within the tight timing tolerances that professional 
broadcasting requires. 

If you do not resolve your generator, or if your generator is incapable 
of being resolved (most low-cost SMPTE generators cannot be re­
solved), then you should not expect a professional broadcaster to 
obtain accurate results from the tapes you produce. If you only use 
SMPTE within your own work environment, and especially if you do 
not use it in context with video, then an unresolved generator provides 
less of a problem. However, the most flexible choice is to buy the best 
resolvable generator (and black burst source, if needed) that you can 
afford, since this generator really provides the heartbeat of your entire 
SMPTE system. 

Because Sound Tools II is a completely digital system, you do not need 
to stripe any track with SMPTE. Sound Designer II use the Sound 
Tools II digital sample clock to generate and read very accurate time 
code. You only need to specify the SMPTE time at which you want the 
any region to start, and Sound Designer II can translate SMPTE times 
to digital sample numbers "on the fly". 

Any slave devices in the system other than Sound Tools II will require 
their own synchronizer in order to follow the master SMPTE time 
code. The master device itself does not need a synchronizer, since it is 
generating rather than reading. 
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Sound Designer II synchronizes to SMPI'E time code by reading the 
MIDI Time Code (MTC) that is generated from the master's SMPTE. 
MIDI time code is the computer's version of SMPTE time code. MTC is 
created by a SMPTE-to-MIDI time code converter, such as Opcode 
Systems' Studio 3, or Mark of the Unicorn's MIDI TimePiece. These 
converters take 1I4 inch analog SMPTE signal and convert it to the 
digital version of that code that is fed into your computer's serial 
(modem or printer) port. 

Note that the SMPTE time code formats striped on all devices must 
match. Different devices should not have different frame rates. For 
exact instructions concerning SMPTE setup and spotting audio, see 
Chapter G of the Sound Designer II manual . 

Recommended Hard Disks 

Because of the great variety of hard disks currently available, it is not 
possible here to give a comprehensive list of drives that are recom­
mended or not recommended. Your best bet is to obtain a hard drive 
that meets the following specifications: an average access time of 27 
ms or faster, and a throughput of 400 Kbytes per second or higher. 

NOfE: Individual manufacturers are not always the best source for 
speed information about their drives. Digidesign has encountered 
many instances where actual hard drive access and throughput varied 
considerably from the manufacturer's specification sheet. To be sure 
that you are getting a capable hard drive, consult your dealer or 
consider Digidesign's Pro Store series of hard drives which meet the 
above requirements. 
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Backup and Archiving Suggestions 

Recording audio to your hard disk will use a considerable amount of 
disk space-approximately 20 megabytes per minute of linear four 
track audio. For this reason it is a good idea to have some type of 
archiving medium for keeping master and backup copies of your 
recordings. Here are some devices that are very useful for archiving 
purposes: 

Erasable Optical Drives. These drives store 600 megabytes (or more) 
on a single removable cartridge (300 megabytes per side). Since the 
medium is magneto-optical (a combination of magnetics and laser 
technology), the cartridges have few moving parts and a relatively 
long storage life. Unfortunately they are not yet fast enough for four 
track recording, and are only useful as an archiving medium. 
Digidesign's Pro Store™ Magneto Optical hard drive provides a 
reliable option for recording stereo audio files or archiving multitrack 
audio files on removable·optical media. 

Removable Platter Drives. These drives store 44 or 88 megabytes on a 
removable magnetic platter cartridge. Although most implementations 
of the mechanism are fast enough for four track recording and play­
back, some are not. Generally speaking, 44 and 88 megabyte removable 
drives are of limited use as a recording or archiving medium, because 
they hold only about 2 or 4 minutes (respectively) of total source audio 
at full fidelity. 

WORM Drives. WORM drives can record data once. They are ex­
tremely high-capacity (900 megabytes or more), but they cannot be 
erased or rewritten. They have a very long storage life, and are useful 
as a long-lasting master archive. They are not fast enough for four 
track recording or playback. 

Streaming Tape Drives. Streaming tape drives are generally the least 
expensive data backup devices, and because they use verification 
schemes, they guarantee file integrity. They store data on magnetic 
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cassettes (DAT or otherwise) in sequential fashion, so they tend to be 
very slow, but the media costs are minimal. Because the storage 
medium is magnetic, the storage life may be limited - but no more so 
than traditional magnetic audio tape. In many ways, the combination 
of a large, fast hard disk for recording and mastering, and a DAT 
backup drive (a WangDAT drive, for example) for archiving may be 
the best price-for-performance combination. 

DAT Recording Decks. While digital audio recording decks are a 
reasonable and cost- effective archiving alternative for your Session 
audio files, they do have some drawbacks. One favorable fact is that 
any audio backed up digitally to a DAT recorder can be played back 
two tracks at a time and auditioned as normal audio. 

However, remember that they use error-correction schemes, so you 
may encounter generation loss in your digital audio. Generally speak­
ing, digital mixing/transfer to standard DAT recorders is best reserved 
for use as a client (or mastering) delivery medium. 

Digidesign's DATa™ software. If you are cost-conscious, you will 
find our DATa™ software a good option. This allows you to back up 
your audio files and edit information onto a standard audio DAT 
cassette, using your DAT recorder. 

Because you are using an audio DAT recorder, the transfer will take 
place in real-time, and the DAT recorder will not alert you to any 
errors in transmission. You will need to listen to the entire tape to 
ensure that the files were transferred properly. However, it is still a 
convenient and affordable way to back up files. DATa is sent free of 
charge to all regi.stered Sound Tools users. (That's just one more good 
reason to send in your Sound Tools registration card. Don't delay!) 

The backup method you choose should be weighed on how much you 
are willing to spend, versus how much time you want to devote to 
saving and restoring files. If you have more questions about Mac-compat­
ible storage systems, we recommend that you check back issues of 
Mac User and Mac World magazines for in-depth reviews and comparisons. 
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Calibrating Your Audio Interface 

After you have become familiar with your Sound Tools II package, you 
will want to calibrate it to the rest of your system. 

Calibrating or "aligning" digital audio systems is somewhat different 
from aligning analog tape recorders. Unlike analog tape recorders, 
most digital audio recorders do not have a .standard "O VU" level 
setting that corresponds to nominal input and output levels. Instead, 
the Audio Interface's meters are calibrated in decibels below peak 
(clipping) level. Whereas analog tape recorders clip fairly gracefully, 
allowing for a certain amount of headroom above the 0 VU level, 
digital recorders sound terrible as soon as they reach clipping. As a 
result, it is important to calibrate the Audio Interface so that nominal 
(or "O VU") level in your system corresponds to a level well below 
peak or "O" level on the Audio Interface's meters. 

There is no industry standard setting for nominal level in a digital 
audio system. We recommend that you allow 10 to 20 dB of headroom 
above nominal level-the exact value you use will be determined by 
the amount of headroom available in the rest of your system. (If your 
mixing console has 15 dB of headroom above nominal level, for 
example, then you should calibrate the Audio Interface to have 15 dB 
of headroom). 

In the following alignment procedure, we will use 15 dB as our se­
lected headroom amount. 

Before proceeding, the Audio Interface must be connected to a Sound 
Accelerator II installed in a Macintosh running Sound Designer II. 

• Connect a 1 kHz sine wave (from a sine wave generator) at 
nominal level ("O VU") to the Audio Interface's inputs. 

• Adjust the Audio Interface's front-panel channel 1 input level 
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trim pot by inserting an 1 /8-inch screwdriver into the Input 
Level Trim pot and turning to the right until the correspond­
ing segment of the Sound Designer II record meter is lit. 

• Repeat this process for channel 2. 

• Next, record about 30 seconds of the sine wave (see the Chap­
ter E for more information on recording). Oick on the Return to 
Zero button when you are done recording. 

• Be sure that the Audio Interface's outputs are properly con­
nected to the mixing console' s "tape return" or line inputs, and 
the console is set to meter the incoming tape return or line 
level. 

• Click on Sound Designer II' s Play button to play the test signal 
you just recorded. 

•Adjust the Audio Interface's front panel channel 1 Output 
Level trim pot by inserting the screwdriver into the Output 
Level trim pot and turning to the right until the console' s tape 
return (or line in) meter reads "O VU". 

• Repeat this process for channel 2. 

You may want to check the calibration of the Audio Interface at 
different frequencies (i.e. 100 Hz and 10 kHz) following the same 
procedure as above. However, this should not be necessary since the 
Audio Interface is a digital device with very flat frequency response. 
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CS-1 Implementation for Sound Designer II 

The CS-1 and CS-10 control surfaces from JL Cooper Electronics offer an alternative to 
controlling Sound Designer II with a Mouse. By providing faders, a jog wheel and 
function keys, JL Cooper offers you familiar and responsive control for your Sound 
Tools system with exceptional speed and flexibility. 

Here, briefly, are descriptions of how the CS-1 controls are implemented in Sound 
Designer II: 

Left Diamond: 
Same as left zoom arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

SHIFT-Left Diamond: 
Same as left horizontal scroll arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

Right Diamond: 
Same as right zoom arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

SHIFT-Right Diamond: 
Same as right horizontal scroll arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

Up Diamond: 
Same as up zoom arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 

SHIFf-Up Diamond: 
Same as up vertical scroll arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 
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Down Diamond: 
Same as down zoom arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

SHIFT-Down Diamond: 

Play: 

Same as down vertical scroll arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

If the transport is currently in Stop mode, SDII will enter Play 
mode. 

Equivalent to hitting the SPACE BAR. Works in both Waveform 
Window and Play list Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

SHIFT-Play: 
Equivalent to hitting the SPEAKER icon in the Waveform 

Window. 
Equivalent to Preview Edit in the Playlist Window. 
Equivalent to hitting the SPEAKER icon in the Edit Fades dialog. 
Equivalent to hitting a SPEAKER icon in the Edit Regions dialog. 

Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor backwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist backwards in time. 

SHIFT-Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the window to the start of the soundfile. 
In the Play list Window, stops any current playback and scrolls 

the playlist to the first region in the playlist. 
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Fast Forward: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor forwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist forwards in time. 

SHIFT-Fast Forward: 

Stop: 

In the Waveform Window, stops any current playback and 
scrolls the window to the end of the soundfile. 

In the Playlist Window, stops any current playback and scrolls 
the playlist to the last region in the playlist. 

If the transport is currently in Play mode, SDII will enter Stop 
mode. 

Equivalent to hitting the SPACE BAR. Works in both Waveform 
Window and Playlist Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

Record: 
In the Record Dialog, if On-Line, it puts the transport into 

Record-Ready mode. If not On-Line, it puts the transport into 
Record-Play mode and immediately begins recording. 

Equivalent to hitting the RECORD button. 

F1 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection start, or insertion point if there is no selection, is 
placed at the current play position. 

In the Waveform Window, if transport is in Stop Mode, the 
selection start, or insertion point if there is no selection, is 
placed at the point last scrubbed to, and then the window is 
scrolled to that point. 

Appendix 225 

Ill 



226 

SHIFT-F1 Button: 
In the Waveform Window, it drops a marker at the current 

playback position. 
Equivalent to hitting the ENTER key. 

F2 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection end is placed at the current play position. 
In the Waveform Window, if transport is in Stop Mode, the 

selection end is placed at the point last scrubbed to, and then 
the window is scrolled to that point. 

SHIFT-F2 Button: 
In the Waveform Window, it puts the wheel in Scroll Mode. 

F3 Button: 
In the Waveform Window, it will execute the Capture Region 

menu command if a selection exists in the waveform. 

SHIFT-F3 Button: 
In the Waveform Window, it puts the wheel in Jog Mode. 

F4 Button: 
If in the Waveform Window, switches to the Playlist Window. 
If in the Playlist Window, switches to the Record dialog. 
If in the Record dialog, switches to the Waveform Window. 
If in the Edit Fades dialog, switches to the Playlist Window. 
If in the Edit Regions dialog, switches to the Playlist Window. 

SHIFT-F4 Button~ 
In the Waveform Window, it puts the wheel in Shuttle Mode. 

On-Line Button: 
The on-line mode is inverted, from ON to OFF, or from OFF to ON. 
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Wheel: 
Begins scrubbing in Waveform Window if in scrub mode. 
Begins jogging in Waveform Window if in jog mode. 
Scrolls thru the soundfile in Waveform Window if in scroll 

mode. 
Scrolls thru the list of regions if in the Playlist Window. 

CS-10 Implementation for Sound Designer II 

Here, briefly, are descriptions of how JL Cooper's CS-10 controls are implemented in 
Sound Designer II: 

Left Diamond: 
Same as left zoom arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

SHIFT-Left Diamond: 
Same as left horizontal scroll arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

Right Diamond: 
Same as right zoom arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

SHIFT-Right Diamond: 
Same as right horizontal scroll arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

Up Diamond: 
Same as up zoom arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 
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SHIFT-Up Diamond: 
Same as up vertical scroll arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 

Down Diamond: 
Same as down zoom arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

SHIFT-Down Diamond: 

Play: 

Same as down vertical scroll arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

If the transport is currently in Stop mode, SDII will enter Play 
mode. 

Equivalent to hitting the SP ACE BAR. Works in both Waveform 
Window and Play list Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

SHIFT-Play: 
Equivalent to hitting the SPEAKER icon in the Waveform 

Window. 
Equivalent to Preview Edit in the Playlist Window. 
Equivalent to hitting the SPEAKER icon in the Edit Fades dialog. 
Equivalent to hitting a SPEAKER icon in the Edit Regions dialog. 

Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor backwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist backwards in time. 

SHIFT-Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the window to the start of the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the playlist to the first region in the playlist. 
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Fast Forward: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor forwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist forwards in time. 

SHIFT-Fast Forward: 

Stop: 

In the Waveform Window, stops any current playback and 
scrolls the window to the end of the soundfile. 

In the Playlist Window, stops any current playback and scrolls 
the playlist to the last region in the playlist. 

If the transport is currently in Play mode, SDII will enter Stop 
mode. 

Equivalent to hitting the SPACE BAR. Works in both Waveform 
Window and Play list Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

Record: 
In the Record Dialog, if On-Line, it puts the transport into 

Record-Ready mode. If not On-Line, it puts the transport into 
Record-Play mode and immediately begins recording. Equiva­
lent to hitting the RECORD button. 

F1 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection start, or insertion point if there is no selection, is 
placed at the current play position. 

In the Waveform Window, if transport is in Stop Mode, the 
selection start, or insertion point if there is no selection, is 
placed at the point last scrubbed to, and then the window is 
scrolled to that point. 
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SHIFT-F1 Button: 
In the Waveform Window, it drops a marker at the current 

playback position. 
Equivalent to hitting the ENTER key. 

F2 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection end is placed at the current play position. 
In the Waveform Window, if transport is in Stop Mode, the 

selection end is placed at the point last scrubbed to, and then 
the window is scrolled to that point. 

SHIFT-F2 Button: 
In the Waveform Window, it puts the wheel in Scroll Mode. 

F3 Button: 
In the Waveform Window, it will execute the Capture Region 

menu command if a selection exists in the waveform. 

SHIFT-F3 Button: 
In the Waveform Window, it puts the wheel in Jog Mode. 

F4 Button: 
If in the Waveform Window, switches to the Playlist Window. 
If in the Playlist Window, switches to the Record dialog. 
If in the Record dialog, switches to the Waveform Window. 
If in the Edit Fades dialog, switches to the Playlist Window. 
If in the Edit Regions dialog, switches to the Playlist Window. 

SHIFT-F4 Button: 
In the Waveform Window, it puts the wheel in Shuttle Mode. 

F9 Button: 
The on-line mode is inverted, from ON to OFF, or from OFF to ON. 
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Wheel: 
In the Waveform Window, it puts the wheel in Shuttle Mode. 
Begins scrubbing in Waveform Window if in scrub mode. 
Begins jogging in Waveform Window if in jog mode. 
Scrolls thru the soundfile in Waveform Window if in scroll mode. 
Scrolls thru the list of regions if in the Playlist Window. 

Digital Sampler Personalities 

The digital samplers offered by various manufacturers each have their 
own personality traits. This section provides information that will be 
helpful in communicating with the samplers supported by Sound 
Designer II. 

Akai S900/S950 
The Akai 5900 and 5950 are twelve bit samplers with maximum 
sampling times from 11.75 seconds to 63.3 seconds depending on the 
sample rate used. They have a variable sample rate ranging from 7.5 
kHz to 40 kHz. 

The 5900 and 5950 require the loop end point to be placed at the end of 
a sample. If you transfer a sound file to the 5900/950 that contains 
sound data after the loop end point, the sound file be automatically 
truncated at the loop end point. 

Akai S700 and X7000 
The Akai 5700 and X7000 are very similar. In fact, the MIDI messages 
used to transfer samples to and from these samplers are identical. In 
the remainder of this description, "S700" will refer to both 5700 and 
X7000 samplers. 
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The S700 is a 12-bit sampler with 6 sample locations. With a memory 
expansion board the S700 can store up to 16 samples. Each sample 
location can hold 32752 samples of data. 

The S700 has a variable sample rate. 26400 is the most commonly used 
sample rate. 

The S700 does not support sound names, only numbers are used to 
differentiate one sound from another. 

When a sound transfer replaces a sound in the S700 with a larger 
Macintosh sound file, the sound file may not need to be truncated. This 
due to the 32752 samples of memory that are always allocated for a 
sample location. 

Truncation is only based upon whether the sound file is larger than 
32752 samples or not. 

The S700 only supports release loops (i.e. loops that continue after a 
key has been released). Therefore, sound files with sustain loops will 
be transferred to the S700 with release loops. 

Akai 81000 
The Akai S1000 is a 16-bit stereo sampler with a maximum sample rate 
of 44.1 kHz. Sound Designer can transfer sound data to the S1000 via 
both SCSI (optional SlOOO SCSI kit required) and MIDI. SCSI transfers 
are much faster than MIDI transfers. 

To send and receive samples via MIDI, connect both MIDI IN and 
OUT directly to your Mac MIDI interface and select the Sample Dump 
Standard (16-bit) setting in the Sampler dialog. Be sure to configure the 
SlOOO to send and receive on MIDI channel 1 or enable Omni mode. 

To send and receive samples via SCSI, the following conditions 
must be met 
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• With the Macintosh, external hard disk, all connected SCSI 
devices and the S1000 powered OFF, connect the S1000 to the 
Macintosh or any of the external SCSI devices with a certified 
SCSI cable. 

• Power on the S1000 and boot it with SCSI System software v 
1.3 or higher. 

•The S1000 SCSI Interface must be initialized each time the 
S1000 is powered on. If any files are loaded into the S1000 
from a hard disk, initialization is done automatically. Other­
wise, initialization must be completed manually. To manually 
initialize the S1000, press the S1000 function key DISK. At the 
LOAD FROM DISK prompt, tum the data knob until the value 
underneath the cursor changes to HARD. If the S1000 displays 
a message warning you that the hard disk is not ready, hit the 
softkey SKW. 

• Like all of the SCSI devices connected to the Macintosh, the 
S1000 must have a unique SCSI ID. On power up, the S1000 
defaults to an ID of 6. If you have any other device connected 
to the Macintosh with a SCSI ID of 6, you will need to change 
the SlOOO's SCSI ID. To change the ID, press the S1000 function 
key DISK. Press the softkey HDSK. Select an SCSI ID number 
that is not being used by any other device. Don't choose an ID 
of 7, which is reserved for the Macintosh. 

• Power on all the external SCSI devices first. Finally, tum on the 
Macintosh. Launch Sound Designer II and select Sampler from 
the Setup menu. 

• Select Add and choose 'Akai S1000 (SCSI)' from the sampler 
list. All further communications between the S1000 and 
Macintosh will occur via SCSI. 

NOTE: The S1000 cannot receive sound transfers when it is displaying 
waveforms. Be sure that the S1000 is NOT in the Edit Sample/Ed.1/Trim 
or Edit Sample/Ed.1/Loop pages when transferring sounds. 
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If the 51000 ever displays a SCSI error, a complete reboot of the system 
may be required to restore reliable communication. When powering 
down the system, reverse the above order. 

Casio FZ-1 and FZ-10M 
The FZ-1 and FZ-lOM are 16-bit samplers with 64 sound locations. 
With a memory expansion board they can store over 1,000,000 16 bit 
samples. 

The FZ-1 has three sample rates, 36 kHz, 18 kHz, and 9 kHz. 36 kHz is 
the most commonly used sample rate. 

In order to transfer sound data between the Macintosh and the FZ-1, 
the following conditions must be satisfied. 

Set MIDI basic channel to '01' 
Set MIDI receive to 'BASIC' 
Set select device to 'MIDI' 
Set the arrow mark to [REMOTE MODE] 

The FZ-1 does not send voice parameters such as sound names or 
lengths independently of sample data. Hence the transfer dialog is 
unable to display voice names or voice sizes while you are scrolling 
through sample locations. The user must determine which voice to get 
or replace from the front panel of the FZ-1. 

NOTE: If a MIDI communication problem occurs, the FZ-1 may 
display an error message. If the FZ-1 displays a message, you must 
press the Up cursor button. This action will clear the message and 
remove the FZ-1 from its error state. Until the error message is cleared, 
the FZ-1 will not communicate via MIDI. 
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E-mu Emax 
An RS-422 cable is required to use the Emax with Sound Designer II. 
Use the enclosed order form to order the RS-422 cable, or contact your 
local Digidesign dealer for cable price and availability. For reliable 
communications between the Emax and Mac, be sure to disconnect any 
MIDI devices from the Emax MIDI input. 

E-mu Emax II 
An RS-422 cable is required to use the Emax II 16 bit sampler with 
Sound Designer II. Always boot the Emax II with system software 
version 2.1.0 or higher. 

E-mu Emulator II 
Like the Emax, an RS-422 cable is required to use the Emulator II with 
Sound Designer II. Use the enclosed order form to order the RS-422 
cable, or contact your local Digidesign dealer for cable price and 
availability 

E-mu SP-1200 
The SP-1200 is a 12 bit sampler with 32 sound locations. It can store 
256K words of data. Memory is divided into 4 segments, each 64K in 
size. If you try to send a sound file large than 64K it will be truncated. 
When sending a sound to the SP-1200, you must replace an existing 
sound. You can not send a sound to a location that's 11Not Sampled." 
The SP-1200 has a single fixed sample rate of 26 kHz. The SP-1200 is 
not listed by name in the sampler menu - use the 12 bit MMA driver. 

Emulator Ill 
To use Sound Designer II with the SCSI interface on the EIII, you must 
have a Macintosh with an SCSI interface. Additionally, if your Mac 
does not include an SCSI hard disk, you must own an SCSI terminator. 
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NOTE: You must use a certified SCSI cable. The use of 'generic' ribbon 
cables is not recommended and can cause intermittent problems in 
communication between the EIII and the Mac. For best results, use EIII 
system software version 2.0 or higher. 

With the Eill, Macintos~ and all other connected SCSI peripherals 
turned off, daisy-chain the Elll to your Macintosh: 

•If your Mac setup does not include an internal SCSI hard drive 
nor any external peripherals, connect a SCSI terminator to the 
EIII, then use a SCSI cable to connect the terminator to the Mac 
SCSI port. 

•If your Mac setup includes an internal SCSI hard drive and no 
other SCSI peripherals, use a SCSI cable to connect the EIII to 
the Mac directly. 

• If you have an external SCSI hard drive or other SCSI peripher­
als, daisy-chain your SCSI drive and peripherals to the Mac. 
Without using a SCSI terminator, connect the EIII to the last 
SCSI peripheral. 

Once the connections have been finalized, you should use the 
following power-up sequence: 

• Tum on the EIII first and verify that its hard disk SCSI ID 
number is set to a value other than that of any other SCSI 
devices in the system, such as the Mac's hard disk. 

• Tum on any other SCSI peripherals. 

• Tum on the Macintosh. Once Sound Designer II has been 
launched, select Emulator III from the Sampler dialog. 

Sounds can now be transferred to and from the EIII by using the File 
menu transfer commands or the Mac -> Sampler icon. A dialog will 
indicate the status of the EIII's voices. If the EIII has no memory left for 
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the sample you wish to send it, the EIII Sample Deficit field (in the 
Mac->Sampler dialog) will indicate how much memory is required by 
the EIII. Samples cannot be truncated at or during the transfer, so EIII 
memory management by the user is important. When powering down 
the system be sure to reverse the above order. 

Ensoniq Miraga/Multisamplar 
For reliable communication between the Mirage and Macintosh, the 
Mirage must be booted with MASOS version 2.0 or higher (Ensoniq 
part #8500 0010 01). 

NOTE: When sending looped sounds to the Mirage, loop starts must 
be on a page boundary (starting on sample #0, pages are 256 samples 
long). 

Ensoniq EPSJEPS•m 
The Ensoniq EPS is a 13-bit sampler that can hold up to 8 instruments of 
up to 127 wavesamples each. The standard amount of memory is 512K 
bytes, or 1024 system blocks. The EPS has a wide range of sampling 
rates-from 6.25 kHz up to 52.1 kHz. Sound Designer II can transfer 
sounds to the EPS via SCSI or MIDI. 

In order to transfer sound data between the Mac and the EPS (using 
SCSI or MIDI), the following conditions must be satisfied: 

• You must use a startup disk with EPS OS 2.35 or higher. 

• MIDI Sys-Ex must be enabled on the EPS. From the EPS front 
panel, use the Edit-MIDI button sequence to tum MIDI SYS-EX 
on. Use Command-System to SAVE GLOBAL PARAMETERS if 
you want to make this a permanent change on your startup 
disk. 

• A system disk should be left in the EPS' s disk drive the first 
time a sound transfer is done so the EPS can read system 
information. 
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If you plan to use SCSI to transfer sounds between your Mac and EPS, 
please read the following instructions carefully. 

First, connect the EPS to the Macintosh using conventional MIDI 
connections: two MIDI cables-one for each direction-between the 
EPS and a Macintosh MIDI interface. 

Next, making sure the EPS, Macintosh, and all other SCSI peripherals 
in your setup are powered off, daisy-chain the EPS to your Macintosh 
setup using a standard Macintosh SCSI cable. 

If your Macintosh setup does not include an internal SCSI hard drive 
nor any external SCSI peripherals, connect an SCSI terminator to the 
EPS, then use an SCSI cable to connect the terminator to the Macintosh 
SCSI port. 

If your Macintosh setup includes an internal SCSI hard drive and no 
other SCSI peripherals, use a SCSI cable to connect the EPS to the 
Macintosh directly. 

If you have an external SCSI hard drive or other SCSI peripherals, 
daisy-chain your SCSI drive and peripherals to the Macintosh. Without 
using a SCSI terminator, connect the EPS to the last SCSI peripheral. 

Once the connections have been finalized, you should use the 
following power-up sequence: 

• Turn on the EPS first. From the System page, choose an SCSI 
ID that is unique within your SCSI network. The Macintosh is 
ID 7 and the standard Macintosh SE internal hard disk is ID 0. 
The EPS defaults to ID 3. 

• Turn on any other SCSI peripherals. 

• Turn on the Macintosh. 
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When powering down the system, simply reverse the above order. 

When you start your Sound Designer II session, don't forget to choose 
Ensoniq EPS (SCSI) within the Sampler menu. Also, within the Sam­
pler .dialog, make sure the SCSI ID number matches the EPS SCSI ID. 

If the EPS ever displays an error condition, it is recommended that you 
power down the system and reboot all SCSI devices. 

Roland S-10, S-220, and MKS-100 
The Roland 5-10, 5-220 and MKS-100 are very similar. In fact, the MIDI 
messages used to transfer samples to and from these samplers are 
identical. In the remainder of this description, "S-10" will refer to both 
the 5-10, 5-220 and MKS-100 samplers. 

The 5-10 is a 12-bit sampler with 4 sample locations. Each sample 
location can hold 32768 samples of data. Sample locations can also be 
combined to support longer sounds. 

The 5-10 uses two sample rates -15 kHz and 30 kHz. 30 kHz is the 
most commonly used. 

The 5-10 does not provide sound names and lengths separately via 
MIDI. Hence the sample structure (e.g. 'A', 'CD' etc.) is used as the 
default name for sounds in the 5-10, and sample lengths are displayed 
as total available memory as opposed to actual sound length. 

The 5-10 only supports release loops (i.e. loops that continue after a 
key has been released). Therefore, sound file with sustain loops will be 
transferred to the 5-10 with release loops. 

NOTE: The selected sample structure must already contain sound data 
- it must not be "empty'' (unsampled). The 5-10 must also have the 
following conditions met to communicate properly with Sound 
Designer II: 
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MIDI system exclusive = 'ON' 
MIDI Channel set to 'l' 
MIDI Active Sensing= "OFF'' (S-10 only) 

If a transfer is cancelled, the S-10 will remain in "SAMPLE DATA 
XMT" or "SAMPLE DATA RCV" mode. To restore communication 
between the Mac and S-10, you must reset the S-10 by pressing a bank 
switch. 

Roland S-550 and S-330 
The Roland S-550 and S330 are twelve bit samplers with 30 kHz and 15 
kHz sample rates. 

Sound Designer II is not able to allocate memory in the S-550 or S-330. 
As a result, you may find that the destination in the sampler is either 
too small or too large for a Sound Designer II sound you wish to send. 
If the sound is too large you will be given the option to truncate the 
sound. Another option is to create a new sample within the S-550 /S-
330 of a more suitable size. 

To use Sound Designer II with the S-550/5-330 you will need to turn 
the S-550/S-330's MIDI System Exclusive parameter to 'On'. You must 
have S-550/5-330 software version 1.0 or higher. 

Roland S-50 
The S-50 is a 12-bit sampler with 32 sample locations. Each sample is 
referred to as a "tone". The S-50 can store over 400,000 12-bit samples 

The S-50 uses two sample rates-15 kHz and 30 kHz. 30 kHz is the 
most commonly used sample rate. 

The S-50 only supports release loops (i.e. loops that continue after a 
key has been released). Therefore, sound files with sustain loops will 
be transferred to the S-50 with release loops. 

Sound Designer II 



Sound Designer II can only replace sounds in the S-50. Hence for a 
sound file to transfer untruncated to the S-50 there must be a tone 
(sample) of equal or greater size available in the S-50. You might want 
to create a "template" disk for the S-50 consisting of commonly used 
sound sizes. 

If you preview a sound and later adjust the loop points within the 
waveform display you can send the new loop points to the S-50 by 
holding down the option key while clicking on the preview icon. 

NOfE: The S-50 must meet the following conditions in order to 
communicate properly with Sound Designer II: 

Use system software 2.0 or higher. 
MIDI system exclusive = 'ON' 
Set the device ID to '1' 

Oberheim DPX-1 
The Oberheim DPX-1 is a 12-bit sample player with 100 sound loca­
tions. It can store 512K words of data. The DPX-1 can load disks from 
the E-mu Emulator II, Sequential Prophet 2000, Ensoniq Mirage and 
Akai S900. 

The DPX-1 uses the MMA sample dump standard to transfer sounds. 

NOfE: The DPX-1 needs to have system ROM 1.5 or higher to operate 
properly with Sound Designer II. 

Sample Dump Standard (12 bit and 16-bit) 
The Sample Dump Standard (SOS) was developed and proposed to the 
MIDI Manufacturers Association (MMA) in order to free sampled 
sounds from the confines of any one sampler. SOS facilitates sound 
transfers between samplers made by different manufacturers. Without 
SDS (or a computer program such as Sound Designer II), you would 
have to resample a sound to transfer it from one sampler to another, 
adding noise and distortion in the process. 
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The 16-bit setting should be used only with samplers that support a 
full 16-bit data dump, such as the Akai 51000 and the Simmons SDX. If 
you attempt to send a file to a 12-bit sampler, the Sample Dump 
Standard (12-bit) setting should be used as the receiving device may 
not be able to accept a 16-bit data dump. 

Although the SDS was meant to be a standard, there are a couple "grey 
areas" left undefined. The following two "grey areas" should help 
explain some of the quirks of working with an SDS sampler. 

First, there is no way of knowing (via MIDI) whether a sound is 'not 
sampled' or 'non-existent'. A 'not sampled' sound is a sound location 
that is available but as yet not sampled. A 'non-existent' sound is one 
that cannot be created on the sampler (e.g. "sound 33" in a sampler 
that only holds 32 sounds). 

Second, there is no way to determine from the Macintosh whether or 
not a sampler will accept a sound. Some samplers will allow you to 
replace a sound, but not transfer to an unoccupied location. Other 
samplers allow both the replacement of a sound as well as the alloca­
tion of a new sound location. If Sound Designer II attempts to transfer 
to a less cooperative sampler, a "transfer unsuccessful" message will 
appear. 

In general, sound transfers with an MMA SDS sampler will go 
smoothly if you are aware of the limitations of your sampler. You 
should know how many sample locations are available in your sam­
pler, and whether your sampler will accept transfers to unoccupied 
sample locations. 

Karg DSS-1 
The Korg DSS-1 is a twelve bit sampler with a maximum sampling 
time ranging from 5.5 seconds to 16 seconds, depending on the sample 
rate used. The DSS-1 has four sample rates available: 15625 Hz, 23810 
Hz, 31250 Hz and 47620 Hz. 
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If you sample sounds using the 47620 Hz sample rate, you must do 
the following before transferring those sounds to the Macintosh: 

• Enter the Multi Sound mode on the DSS-1. 

• Select Function #3. 

• Exit the Multi Sound mode. 

Korg DSM-1 
The Korg DSM-1 is a twelve bit sampler with a total sampling time 
ranging from 22 seconds to 64 seconds, depending on the sample rate 
used. The DSM-1 has four sample rates available: 15625 Hz, 23810 Hz, 
31250 Hz and 47620 Hz. 

Any MIDI cables connected to the DSM-1 MIDI Thru must be termi­
nated (plugged in to a MIDI input). Non-terminated MIDI cables may 
cause communications problems. 

Yamaha TX-16W 
The Yamaha TX-16W is a 12-bit sampler with 64 sound locations. The 
maximum sampling time for a single sample ranges from 5.2 seconds 
to 16.3 seconds, depending on the sample rate used. The TX-16W can 
accommodate several such samples. The TX-16W has 3 sample rates: 
16,667 Hz, 33,333 Hz, and 50,000 Hz. 

TX-16W transfers are performed using a slightly modified version of 
the 12-bit Sample Dump Standard (SOS) driver. Refer to the SOS driver 
description for more information. 
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Recommended Reading 

Audio in Media, Stanely R. Alten, Wadsworth Publishing Company, 
Belmont, California, 1986 

Principles of Digi.tal Audio, Ken C. Pohlman, Howard W. Sams and 
Company, Indianapolis, Indiana, 1985 

The Ultimate Home Studio, Michael Goldberg, Digidesign, 
Menlo Park, California, 1991 

Random Access Audio, David Miles Huber, Digidesign, Menlo Park, 
California, 1989 

Mix Magazine, 6400 Hollis St. #12, Emeryville, CA 94608 

Electronic Musican Magazine, 6400 Hollis St. #12, Emeryville, CA 94608 

Keyboard Magazine, 20085 Stevens Creek, Cupertino, California, 95014 
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Technical Specifications 

Audio Interface 

Sample Rates: 44.1 kHz, 48 kHz, user selectable 

Analog to Digital Convertor: 1 Bit, Delta-Sigma, 64x Oversampling, 16-bit output. 

Digital to Analog Convertor: 18-Bit, 8x Oversampling 

Frequency Response: 20 Hz - 20 kHz 

Signal to Noise Ratio: > 93 dB A/D, > 108 dB DI A ("A" weighted) 

THD + N: 0.005% AID, 0.003% DI A 

Nominal Input Level: +4 dBu plus 14 dB headroom, adjustable± 6 dB 

Maximum Input Level: +26 dBu 

Nominal Output Level: + 4 dBu plus 14 dBu headroom, adjustable± 6 dB 

Maximum Output Level: +24 dBu 

Analog I/O Types: Balanced, +4 dBu male/female transformerless XLR 

Digital I/O: AESIEBU and SIPDIF, user selectable 

Digital I/0 Types: AES /EBU -XLR connectors 
Input: Active transfonnerless balanced 
Output: Transfonner-coupled 

S/PDIF - RCA connectors 
l~t: Active transfonnerless unbalanced 
Output: Transformer coupled 

Power Requirements: 100, 120, 220, 240 V AC automatic voltage switching 50 - 60 Hz, 16 
w 
Dimensions: lU External Rackmount device, 19"x 1.75" x 10.5", 6.5 lbs (3 kg). 
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Sound Accelerator II 

Card Specifications: Macintosh II NuBus card, installable in any Macintosh II, Ilx, Ilcx, 
Ilci, Ilfx CPU NuBus slot. (Macintosh Ilsi requires Apple NuBus adapter) Each card 
produces four channels of phase synchronous 16-Bit audio 

Digi.tal Signal Processor: Motorola 56001 processor 

Slot Requirements: Slot independent, can be installed in any full-size Macintosh II 
NuBus slot; multiple cards may be used simultaneously 

Connector: Digidesign proprietary 50 conductor to Audio Interface 

NuBus Power Consumption: 6.5 watts 
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